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1
Safety
This chapter contains:
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Your printer and the recommended supplies have been designed and tested to meet strict safety
requirements. Attention to the following information ensures the continued safe operation of your
Xerox printer.



Notices and Safety
Read the following instructions carefully before operating your printer. Refer to these instructions to
ensure the continued safe operation of your printer.

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These
include safety agency evaluation and certification, and compliance with electromagnetic regulations
and established environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox®
materials only.

Note: Unauthorized alterations, which can include the addition of new functions or connection
of external devices, can affect the product certification. For more information, contact your
Xerox representative.
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Electrical Safety

GGeenneerraall GGuuiiddeelliinneess
WARNING:

• Do not push objects into slots or openings on the printer. Touching a voltage point or
shorting out a part could result in fire or electric shock.

• Do not remove the covers or guards that are fastened with screws unless you are installing
optional equipment and are instructed to do so. Power off the printer when performing
these installations. Disconnect the power cord when removing covers and guards for
installing optional equipment. Except for user-installable options, there are no parts that
you can maintain or service behind these covers.

The following are hazards to your safety:

• The power cord is damaged or frayed.

• Liquid is spilled into the printer.

• The printer is exposed to water.

• The printer emits smoke, or the surface is unusually hot.

• The printer emits unusual noise or odors.

• The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1. Power off the printer immediately.

2. Disconnect the power cord from the electrical outlet.

3. Call an authorized service representative.

PPoowweerr CCoorrdd SSaaffeettyy IInnffoorrmmaattiioonn
Before operating your printer, read the following instructions carefully. For details, contact your Xerox
representative.

WARNING:

• The electrical supply for the device must meet the requirements stated on the data plate on
the rear of the device. If you are not sure that your electrical supply meets the requirements,
consult your local electricity provider or a licensed electrician.

• Do not use an extension cord.

• Do not remove or modify the power cord.

Refer to these instructions to ensure the continued and safe operation of your printer.

• Use the power cord that is supplied with your printer.

• Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the
cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to verify
that the outlet is grounded.
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• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have
a ground connection terminal.

WARNING: To avoid the potential of an electrical shock, ensure that the printer is
grounded properly. Electrical products can be hazardous if misused.

• Verify that the printer is plugged into an outlet that provides the correct voltage and power.
Review the electrical specification of the printer with an electrician, if necessary.

• Do not place the printer in an area where people can step on the power cord.

• Do not place objects on the power cord.

• If the power cord becomes frayed or worn, replace the power cord.

• Do not unplug or plug in the power cord while the printer is powered on.

• To avoid an electrical shock and damage to the cord, grasp the plug when you unplug the power
cord.

• The electrical outlet must be near the printer and must be easily accessible.

The power cord is attached to the printer as a plug-in device on the back cover of the printer. If it is
necessary to disconnect all electrical power from the printer, disconnect the power cord from the
electrical outlet. For details, refer to the User Guide.

BBaatttteerryy SSaaffeettyy IInnffoorrmmaattiioonn
• The Printed Wire Board Assembly Electronic Switching System (PWBA ESS) in this printer uses a

lithium battery.

• Do not attempt to repair or replace the lithium battery. If there is a problem with the battery,
contact an authorized service representative to correct the problem.

WARNING:

• If the battery for the PWBA ESS is installed incorrectly, there is a risk of explosion.

• The lithium battery in this printer contains Perchlorate Material. For information about the
special handling procedures associated with Perchlorate Material, refer to www.dtsc.ca.gov/
hazardouswaste/perchlorate.

EEmmeerrggeennccyy PPoowweerr OOffff
If any of the following conditions occur, power off the printer immediately and disconnect the power
cord from the electrical outlet. Contact an authorized Xerox service representative to correct the
problem if:

• The equipment emits unusual odors or makes unusual noises.

• The power cable is damaged or frayed.

• A wall panel circuit breaker, fuse, or other safety device has been tripped.

• Liquid is spilled into the printer.

• The printer is exposed to water.

• Any part of the printer is damaged.
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TTeelleepphhoonnee LLiinnee CCoorrdd
WARNING: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger
telecommunication line cord.
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Operational Safety
Your printer and supplies were designed and tested to meet strict safety requirements. These include
safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your
printer.

OOppeerraattiioonnaall GGuuiiddeelliinneess
• Do not remove any paper trays while the printer is printing.

• Do not open the doors when the printer is printing.

• Do not move the printer when it is printing.

• Keep hands, hair, neckties, and so on, away from the exit and feed rollers.

• Protective covers, which require tools for the removal, protect the hazard areas within the printer.
Do not remove the protective covers.

• Do not override any electrical or mechanical interlock devices.

• Do not attempt to remove paper that is jammed deeply inside the printer. Power off the printer
promptly, then contact your local Xerox representative.

• Ensure that the rear right cover is attached. To connect an interface cable, open the rear right
cover.

OOzzoonnee RReelleeaassee
This printer produces ozone during normal operation. The amount of ozone produced is dependent on
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone.
Install the printer in a well-ventilated room.

For more information in the United States and Canada, go to www.xerox.com/environment. In other
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe.

PPrriinntteerr LLooccaattiioonn
• Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight.

To find the weight for your printer configuration, refer to the Specifications chapter of the User
Guide.

• Do not block or cover the slots or openings on the printer. These openings are provided for
ventilation and to prevent overheating of the printer.

• Place the printer in an area where there is an adequate space for operation and servicing.

• Place the printer in a dust-free area.

• Do not store or operate the printer in hot, cold, or humid environments.

• Do not place the printer near a heat source.

• To avoid exposure of light-sensitive components, do not place the printer in the direct sunlight.

• Do not place the printer where it is exposed to the cold air flow from an air-conditioning system.

• Do not place the printer in locations that are susceptible to vibrations.
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• For optimum performance, use the printer at the elevations that are specified in the User Guide.

PPrriinntteerr SSuupppplliieess
• Use the supplies designed for your printer. The use of unsuitable materials can cause poor

performance and a possible safety hazard.

• Follow all warnings and instructions marked on, or supplied with, the product, options, and
supplies.

• Store all consumables in accordance with the instructions given on the package or container.

• Keep all consumables away from the reach of children.

• Never throw toner, toner cartridges, drum cartridges, or waste cartridges into an open flame.

• When handling cartridges, for example toner cartridges, avoid skin and eye contact. Eye contact
with toner can cause irritation and inflammation. Do not attempt to disassemble the cartridge,
which can increase the risk of skin or eye contact.

Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty or Service
Agreement do not cover damage, malfunction, or degradation of performance caused by use
of non-Xerox supplies, or the use of Xerox supplies not specified for this printer.
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Maintenance Safety
Do not attempt any maintenance procedure that is not specifically described in the documentation
supplied with your printer.

• Clean the device with a dry lint-free cloth only.

• Do not burn any consumables or routine maintenance items. For information on Xerox® supplies
recycling programs, go to www.xerox.com/gwa

WARNING: Do not use aerosol cleaners. Aerosol cleaners can be explosive or flammable when
used on electromechanical equipment.

When installing the device in a hallway or similar restricted area, additional space requirements can
apply. Ensure that you comply with all workspace safety regulations, building codes, and fire codes for
your area.
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Environmental, Health, and Safety Contact
Information
For more information on Environment, Health, and Safety in relation to this Xerox product and
supplies, contact:

• United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)

• Europe: EHS-Europe@xerox.com

For product safety information in the United States and Canada, go to www.xerox.com/environment.

For product safety information in Europe, go to www.xerox.com/msds.
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Getting Started
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Parts of the Printer
FFrroonntt VViieeww

1. Document Cover

2. Document Glass

3. Power/Wake Button

4. Near Field Communication (NFC) Area

5. Center Output Tray

6. Center Bottom Tray

7. Main Power Switch behind the front door

8. Trays 1–4

9. Locking Casters

10. Leveler Foot

11. Tray 5: Bypass Tray

12. Smart Proximity Sensor

13. Left Tray
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DDuupplleexx AAuuttoommaattiicc DDooccuummeenntt FFeeeeddeerr

1. Confirmation Indicator

2. Left Cover

3. Top Cover

4. Document Guides

5. Document Feeder Tray

6. Document Output Tray

7. Lint Free Cloth Compartment

8. Second-Side Scanning Lens Assembly

9. Constant Velocity Transport (CVT) Glass
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Duplex Automatic Document Feeder Guidelines
The duplex automatic document feeder accommodates the following paper sizes and weights:

• C8130 / C8135 / C8145:

– Original document weights: 38–128 g/m².

– Original document sizes: 85 x 125–297 x 432 mm (3.3 x 4.9–11.7 x 17 in.).

– Original document quantity: 130 sheets of 80-g/m² paper.

• C8155 / C8170:

– Original document weights: 38–200 g/m².

– Original document sizes: 84 x 140–297 x 432 mm (3.3 x 5–11.7 x 17 in.).

– Original document quantity: 250 sheets of 80-g/m² paper.

Follow these guidelines when you load original documents into the duplex automatic document
feeder:

• Load original documents face up so that the top of the document enters the feeder first.

• Place only loose sheets of undamaged paper in the duplex automatic document feeder.

• Adjust the paper guides so that they fit against the original documents.

• Insert paper in the duplex automatic document feeder only when ink on the paper is dry.

• Do not load original documents above the MAX fill line.

Document Glass Guidelines
Lift the document feeder cover and place the first page face down in the upper-left corner of the
document glass. Align the original documents to the matching paper size printed on the edge of the
glass.

• The document glass accepts paper sizes up to 297 x 432mm (11.7 x 17in.).

• The document glass automatically detects standard paper sizes.

Use the document glass rather than the duplex automatic document feeder to copy or scan the
following types of original documents:

• Paper with paper clips or staples attached

• Paper with wrinkles, curls, folds, tears, or notches

• Coated or carbonless paper or items other than paper, such as cloth or metal

• Envelopes

• Books
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IInntteerrnnaall PPaarrttss

1. Toner Cartridges

2. Main Power Switch

3. Waste Container

4. Waste Toner Transport Assembly

5. Waste Toner Transport Release Switch

6. 2nd Bias Transfer Roll

7. Fuser Assembly

8. Transfer Belt Cleaner

9. Drum Cartridges
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RReeaarr VViieeww

1. Tray 5 - Bypass Tray

2. Door B

3. Leveler Foot

4. Circuit Breaker

5. Rear Right Cover

6. USB Port, Type B

7. USB Port, Type A

8. Ethernet Port
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CCoonnttrrooll PPaanneell
The control panel consists of a touch screen and buttons that you press to control the functions that
are available on the printer. The control panel has the following functions:

• Displays the current operating status of the printer.

• Provides access to print, copy, and scan features.

• Provides access to reference materials.

• Provides access to the Tools and Setup menus.

• Prompts you to load paper, replace supplies, and clear paper jams.

• Displays errors and warnings.

• Provides the Power/Wake button that is used to power on or off the printer. This button supports
the power-saver modes, and the button indicator pulses to indicate the power status of the
printer.

Item Name Description

1 NFC Area Near Field Communication (NFC) is a technology that enables
devices to communicate when they are within 10 cm (4 in.) of
each other. Use the NFC area to obtain a network interface or to
establish a TCP/IP connection between your device and the
printer.

2 Touch Screen Display The screen displays information and provides access to printer
functions.

3 Home Button This button provides access to the Home menu for access to
printer features, such as copy, scan, and fax.

4 Power/Wake Button This button serves several power-related functions:
• When the printer is powered off, pressing this button powers

on the printer.
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Item Name Description

• When the printer is powered on, pressing this button displays a
menu on the control panel. From this menu, you can choose to
enter Sleep Mode, restart the printer, or power off the printer.

• When the printer is powered on, but in Sleep Mode, pressing
this button wakes the printer.

The button indicator pulses to indicate the power status of the
printer:

• When the light pulses slowly, the printer is in Sleep Mode.
• When the light pulses rapidly, the printer is powering off or

waking up.

5 Status Indicator This light pulses blue or amber or blinks amber to indicate the
printer status.

Blue:

• Pulses blue once for access-card authentication when there is a
delay in response from a remote server.

Note: Some card readers are not compatible with
this feature.

• Pulses blue twice slowly to indicate that a job has completed.
• Pulses blue rapidly while the printer is powering on, or to signal

detection of a Wi-Fi Direct connection request.

Amber:

• Pulses amber to indicate an error condition or warning that
requires your attention or the attention of your system
administrator. For example, this color can indicate an out-of-
toner condition, a paper jam, or that the printer is out of paper
for the current job.

• Blinks amber to indicate a more serious system or hardware
error. For most errors, an error message appears on the control
panel. Some errors can require support from your local Xerox®
service representative.

6 Notification Area Notifications appear above the Apps area. To view the full
notification, touch the notification area. After you review the
information, touch X.

7 Interrupt Button Pressing the Interrupt button pauses the current job to run a more
urgent job.

Note: Sometimes this option is hidden from view. To
enable the Interrupt function, refer to the System
Administrator Guide at www.xerox.com/office/
ALC81XXdocs.

8 Pause Button Use this button to pause the current job. The job pauses with the
option to resume printing or to delete the job.
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Item Name Description

9 Language Button Pressing the Language button allows you to set the language that
appears on the control panel touch screen.

Note: Sometimes this option is hidden from view. For
details, see the System Administrator Guide at www.xerox.
com/office/ALC81XXdocs.

10 Reset Use the Reset button to reset all the apps to the default settings.

CCoonnffiigguurraattiioonnss aanndd OOppttiioonnss

1. Tray 6: High-Capacity Feeder

2. Work Surface

3. Convenience Stapler

4. RFID (Radio Frequency Identification)
Card Reader Kit

5. Trays 1 and 2, and Trays 3 and 4 of the 2-
Tray Module

6. Trays 3 and 4 of the High-Capacity
Tandem Tray Module
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Finishing Options

IInntteeggrraatteedd OOffffiiccee FFiinniisshheerr

1. Finisher Tray

2. Finisher Tray Extension

3. Integrated Office Finisher

4. Staple Cartridge

5. Finisher Front Cover

6. Finisher Top Cover
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OOffffiiccee FFiinniisshheerr wwiitthh OOppttiioonnaall BBooookklleett MMaakkeerr

1. Booklet Maker (optional)

2. Booklet Maker Side Cover (optional)

3. Right Tray

4. Booklet Maker Staple Cartridge (optional)

5. Finisher Top Cover

6. Creaser Unit (optional)

7. Staple Cartridge

8. Finisher Front Cover

9. Office Finisher

10. Hole Punch Waste Container (optional)

11. Hole Punch Unit (optional)

12. Center Tray
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BBuussiinneessss RReeaaddyy FFiinniisshheerr wwiitthh OOppttiioonnaall BBooookklleett MMaakkeerr

1. Horizontal Transport Unit

2. Center Tray

3. Right Top Tray

4. Right Middle Tray

5. Staple Cartridge

6. Booklet Staple Unit

7. Booklet Maker Tray

8. Booklet Maker Unit

9. Finisher Front Cover
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BBuussiinneessss RReeaaddyy FFiinniisshheerr wwiitthh OOppttiioonnaall TTrrii--FFoolldd
MMoodduullee

1. Folder Front Cover

2. Folder Bin Release Button

3. Folder Bin
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Paper Tray Options

CCoonnffiigguurriinngg DDeeddiiccaatteedd PPaappeerr TTrraayyss
The system administrator can set trays to Fully Adjustable mode or Dedicated mode. When a paper
tray is set to Fully Adjustable mode, you can change paper settings each time that you load the tray.
When a paper tray is set to Dedicated mode, the control panel prompts you to load a specific paper
size, type, and color.

Your printer can have three high-capacity paper trays installed, depending on the configuration.

• High-capacity trays are configured as Fully Adjustable trays.

• Trays 3 and 4 in the Tandem Module, and High-Capacity Tray 6 hold A4-size (210 x 297 mm),
Letter-size (8.5 x 11 in.), JIS B5-size (182 x 257 mm), or Executive-size (7.25 x 10.5 in.) paper.

• High-capacity trays are designed to hold larger amounts of paper for fewer printing interruptions.

Note: To configure tray settings, refer to the System Administrator Guide at www.xerox.com/
office/ALC81XXdocs.

CCoonnffiigguurriinngg PPaappeerr SSiizzee CCoonnffiirrmmaattiioonn
The system administrator can configure the paper size confirmation prompt that appears at the
control panel. For adjustable paper trays, when you load paper of the same size as the paper that was
loaded previously in the tray, a confirmation prompt appears at the device control panel:

• Always Show: This option shows the paper confirmation prompt at the control panel until the
user dismisses it.

• Delayed Confirmation: This option shows the paper confirmation prompt for a specified time. At
the end of the specified time, the prompt closes, which confirms the paper that is loaded. While
the prompt appears on the control panel touch screen, you can confirm any change to the paper
type, color, and size.

• Auto Confirmation: This option confirms automatically the paper type, color, and size without
showing a prompt.

Note: To configure the paper size confirmation prompt, refer to the System Administrator
Guide at www.xerox.com/office/ALC81XXdocs.
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CCoonnffiigguurriinngg TTrraayyss 33 aanndd 44 ooff tthhee TTaannddeemm TTrraayy
MMoodduullee
Trays 3 and 4 in the Tandem Tray Module are high-capacity paper trays. Configure Trays 3 and 4 to
support the paper in use. For details on supported paper sizes, refer to Supported Paper.

To configure Trays 3 and 4 in the Tandem Tray Module:

Note: Before you make any tray adjustments, compare the paper size to the current Tray 3 and
4 configurations. If the paper size matches the tray configuration, no tray adjustment is
needed.

1. Remove any paper from the tray.

2. Pinch the guide lock on the front paper guide, then slide the paper guide to the required paper
size.

3. To lock the paper guides into place, release the guide lock.

Note: The paper guides lock into place only at the designated standard paper sizes.
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CCoonnffiigguurriinngg TTrraayy 66
Tray 6 is a high-capacity tray. You can configure Tray 6 to support the paper size that you need. For
details on supported paper sizes, refer to Supported Paper.

To configure Tray 6:

Note: Before you make any tray adjustments, compare the paper size to the current Tray 6
configuration. If the paper size matches the tray configuration, no tray adjustment is needed.

1. At the high capacity feeder, squeeze the handle, and pull out Tray 6 until it stops.

2. Open the side gate. Remove the screw that holds the spacer plate at the back of the tray, then lift
the spacer plate out of the tray. Repeat the procedure for the spacer plate at the front of the
tray.

36 Xerox® AltaLink® C81XX Series Color Multifunction Printer
User Guide

Getting Started



3. For the rear spacer plate, place the tabs at the bottom of the plate into the slots that correspond
with the correct paper size. Slide down the spacer plate, then engage the peg on the top of the
tray with the matching hole in the spacer plate. To secure the spacer plate, install the screw.
Repeat the procedure for the spacer plate at the front of the tray.

4. On the top of the side gate, lift the pin, then guide it into the required paper size in the slot. To
lock the side gate into place, release the pin.

5. Load paper, close the side gate, then close the tray.

6. At the control panel, select the correct type and color.

7. To confirm the settings, touch Confirm.

For information about loading paper in Tray 6, refer to Loading Paper in Tray 6.
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Wireless Network Adapter
The wireless network adapter is a USB device that transfers data between the printer and a wireless
local area network (LAN). The wireless network adapter supports common wireless security protocols,
such as WEP, WPA, WPA2, and 802.1X standard port-based network access control.

The wireless network adapter allows multiple users on a wireless LAN to print to and scan from Xerox®
printers. The wireless network adapter also supports printers that include network scan and fax
features.
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Power Options

PPoowweerr SSaavveerr
To reduce standby power consumption, you can use Sleep Timeout to set the time that the printer
spends idle in Ready mode before the printer transitions to Sleep mode.

SSmmaarrtt PPrrooxxiimmiittyy SSeennssoorr
The Smart Proximity Sensor detects when a user approaches or leaves the device, using a reflective
sensor. This feature provides convenience for users, and can reduce power consumption. You can
enable the device to wake up and sleep based on the detection of a user. To configure the Smart
Proximity Sensor, refer to the System Administrator Guide at www.xerox.com/office/ALC81XXdocs.

PPoowweerriinngg OOnn tthhee PPrriinntteerr,, oorr EExxiittiinngg SSlleeeepp MMooddee
The printer has two power switches. The main power switch, located behind the front door, controls
the main power to the printer. The secondary power switch is the Power/Wake button on the control
panel. The Power/Wake button controls power to the printer electronic components, and when
powered off, initiates a software-controlled shutdown procedure. The preferred method to power on
and off the printer is to use the Power/Wake button.

• To power on the printer, open the front door, then power on the main power switch. On the
control panel, press the Power/Wake button.

• To enter or exit Sleep mode, press the Power/Wake button.

Note:

• When the printer receives data from a connected device, the printer exits Sleep mode
automatically.

• When the printer receives data from a network print job, to reduce power consumption, only
necessary electronic components exit Sleep mode automatically. The control panel and the
document scanner do not exit Sleep Mode.

• When the printer is in Sleep mode, the touch screen is powered off and unresponsive. To
wake the printer manually, press the Power/Wake button, or move into the Smart Proximity
Sensor detection zone.
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• If Auto Power Off is enabled, the printer powers off automatically after the specified
conditions are met. To enable Auto Power Off mode, contact your System Administrator. For
details, refer to the System Administrator Guide at www.xerox.com/office/ALC81XXdocs.

Caution: Do not plug or unplug the power cord while the printer is powered on.

RReessttaarrttiinngg,, PPllaacciinngg iinn SSlleeeepp MMooddee,, oorr PPoowweerriinngg OOffff
tthhee PPrriinntteerr
To restart the printer, place the printer in Sleep Mode, or power off the printer:

1. At the printer control panel, press the Power/Wake button.

2. Select an option:
• To restart the printer, touch Restart.
• To place the printer in Sleep Mode, touch Sleep.

In Sleep Mode, the touch screen goes dark and the Power/Wake button pulses.

• To power off the printer, touch Power Off. A Please Waitmessage appears as the printer
powers off.

3. If you want to power off the printer for an extended period, open the printer front door, then
power off the main power switch.

Caution: Do not unplug the power cord while the printer powers down.
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Accessing the Printer

AAuutthheennttiiccaattiioonn
Authentication is the process of confirming your identity. When the system administrator enables
authentication, the printer compares the information that you provide to another source of
information, such as an LDAP directory. The information can be a user name and password, or the
information stored on a magnetic, proximity, RFID, or smart card. If the information is valid, you are
considered an authenticated user.

There are several ways to authenticate a user:

• User Name/Password - Validate on the Device: This option enables local authentication. Users
prove their identity by typing a user name and password at the control panel or in the Embedded
Web Server. The printer compares the user credentials to the information stored in the user
database. If there are a limited number of users, or you do not have access to an authentication
server, use this authentication method.

• User Name/Password - Validate on the Network: This option enables network authentication.
Users prove their identity by typing a user name and password at the control panel or in the
Embedded Web Server. The printer compares the user credentials to the information stored on an
authentication server.

• Convenience Authentication: If this option is enabled, a card with a magnetic strip or a Radio
Frequency Identification (RFID) card is used. A convenience authentication card is different from
a Smart Card, which uses an embedded chip and typically requires a login and password. If the
optional integrated RFID reader is installed, for authentication, users place a pre-programmed
card over the RFID reader at the control panel.

• Xerox Secure Access - Unified ID System: This option enables authentication for the Xerox
Secure Access Unified ID System. Users present a pre-programmed identification card to a card
reader at the control panel. The printer compares the user credentials to the information stored
on the Xerox® Secure Access server.

• Smart Cards: This option enables authentication for a Smart Card Reader. Users insert a pre-
programmed identification card in a card reader at the control panel.

Note: The system administrator can allow you to type your user name and password when
Convenience Authentication or Smart Card is the primary authentication method. If the
administrator configures an alternative authentication method, and you misplace your card,
you can still access the printer.

For information about configuring Authentication settings, refer to the System Administrator Guide at
www.xerox.com/office/ALC81XXdocs.

AAuutthhoorriizzaattiioonn
Authorization is the function of specifying the features that users are allowed to access, and the
process of approving or disapproving access. You can configure the printer to allow users to access the
printer, but restrict access to certain features, tools, and apps. For example, you can allow users to
access copying but restrict access to scanning. You can also control access to features at specific
times of the day. For example, you can restrict a group of users from printing during peak business
hours.

There are two types of authorization:
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• Local Authorization verifies user information on the printer to approve access.

• Network Authorization verifies user information stored externally in a network database, such as
an LDAP directory, to approve access.

For information about configuring Authorization settings, refer to the System Administrator Guide at
www.xerox.com/office/ALC81XXdocs.

PPeerrssoonnaalliizzaattiioonn
Personalization is the process of customizing and configuring the device information and settings for
a specific user. When a user logs in to the device and personalized information is required, the device
searches for the required configuration information from an LDAP directory. Examples of personalized
information are the Home destination and an email address. For information about configuring
personalized information settings, refer to the System Administrator Guide at www.xerox.com/office/
ALC81XXdocs.

To personalize the local user interface experience, logged-in users can change the appearance and
layout of their home screen, set job programming defaults, and create personalized, one-touch
applications. For details, see Personalize.

Note: To allow the logged-in user to personalize their local user interface experience, the
System Administrator is required to configure the device personalization policy. For information
on configuring the device policy to enable user personalization, refer to the System
Administrator Guide at www.xerox.com/office/ALC81XXdocs.

AAccccoouunnttiinngg
Accounting is used to track and record the numbers of Copy, Print, Scanning, Server Fax, and Fax jobs
that the device produces for each user. The system administrator is required to create user accounts
and enable the accounting feature. After Accounting is enabled, provide Accounting IDs at the printer
to access restricted apps. If Authentication is enabled, you are required to log in first. Before you print
documents from a computer, provide your account details in the print driver.

The system administrator can set limits to restrict the total number of jobs by type that a user can
send to the printer. The administrator can generate reports that list usage data for individual users
and groups.

For details, refer to the System Administrator Guide at www.xerox.com/office/ALC81XXdocs.

LLooggggiinngg IInn
Logging in is the process by which you identify yourself to the printer for authentication. If
authentication is set, to access printer features, you log in with your user credentials.
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LLooggggiinngg IInn aatt tthhee CCoonnttrrooll PPaanneell
Note:

• Before logging in for the first time at the Xerox device control panel, log in to the Embedded
Web Server, then update your password. For details, refer to Logging In Using the
Embedded Web Server.

• If you do not know your user name or password, contact your system administrator.

1. At the printer control panel, press the Home button.

2. Touch Log In.

3. For User Name, use the keypad and enter your name, then touch Next.

4. If prompted, enter the password, then touch Done.

Note: To access each app that is password-protected, repeat steps 3 and 4.
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Introduction to Apps
Xerox Apps are a gateway to the features and functions of your device. Standard Apps are installed
already on the device and appear on the Home screen. Some Apps are installed as standard, but are
hidden the first time you use the device.

When you log in, the Apps configured for your personal account appear on the control panel.

You can download more Apps for your device from the Xerox® App Gallery. For more information,
refer to Xerox® App Gallery.
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Information Pages
Your printer has a set of information pages that you can print. These pages include configuration and
font information, getting started pages, and more.

The following Information Pages are available:

Name Description

Configuration Report The Configuration Report provides printer
information, including the serial number, installed
options, network settings, port setup, tray
information, and more.

Billing Summary The Billing Summary Report provides information
about the device and a detailed listing of the billing
meters and sheet counts.

Getting Started The Getting Started guide provides an overview of
the key features of the printer.

Troubleshooting Print Quality Page The Troubleshooting Print Quality Page provides a list
of common print-quality problems and tips to help
solve them.

Supplies Usage Page The Supplies Usage Page provides coverage
information and part numbers for reordering
supplies.

Graphics Demo Page Print this page to check the quality of graphics.

PCL Font List The PCL Font List provides a printout of all PCL fonts
that are available on the printer.

PostScript Font List The PostScript Font List provides a printout of all
PostScript fonts that are available on the printer.

PPrriinnttiinngg IInnffoorrmmaattiioonn PPaaggeess
1. At the printer control panel, press the Home button.

2. Touch Device→Information Pages.

3. To print an information page, touch the needed page, then touch Print.

The printer prints the selected information page.

4. To return to the Home screen, press the Home button.

CCoonnffiigguurraattiioonn RReeppoorrtt
The Configuration Report provides product information, including installed options, network settings,
port setup, tray information, and more.
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PPrriinnttiinngg tthhee CCoonnffiigguurraattiioonn RReeppoorrtt
1. At the printer control panel, press the Home button.

2. Touch Device→Information Pages.

3. Touch Configuration Report, then touch Print.

The printer prints the Configuration Report.

4. To return to the Home screen, press the Home button.
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The Embedded Web Server
The Embedded Web Server is the administration and configuration software that is installed in the
printer. It allows System Administrators to modify network and system settings on the printer
remotely using a Web browser.

You can check the status of the printer, monitor paper and supply levels, and submit and track print
jobs. All these functions can be accessed from the convenience of your computer.

The Embedded Web Server requires:

• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux
environments.

• TCP/IP and HTTP enabled in the printer.

• A network-connected computer with a Web browser that supports JavaScript.

FFiinnddiinngg tthhee IIPP AAddddrreessss ooff YYoouurr PPrriinntteerr
To install the print driver for a network-connected printer, it is often necessary to know the IP address
of your printer. Also, the IP address is used to access the settings of your printer through the
Embedded Web Server. You can view the IP address of your printer on the control panel or on the
Configuration Report.

Note: To view the TCP/IP address on the control panel, wait until the printer has been on for 2
minutes. If the TCP/IP address is 0.0.0.0, or begins with 169, it indicates a network connectivity
issue.

VViieewwiinngg tthhee IIPP PPrriinntteerr AAddddrreessss oonn tthhee CCoonnttrrooll PPaanneell
To view the IP address of the printer on the control panel:

1. At the printer control panel, press the Home button.

2. Touch Device→About.

The IP address appears in the Network section of the About screen for Wired IPv4 Address or
Wired IPv6 Address.

3. Record the IP address from the display.

4. To return to the Home screen, press the Home button.

OObbttaaiinniinngg tthhee PPrriinntteerr IIPP AAddddrreessss ffrroomm tthhee CCoonnffiigguurraattiioonn RReeppoorrtt
To obtain the printer IP address from the Configuration Report:

1. At the printer control panel, press the Home button.

2. Touch Device→Information Pages.

3. Touch Configuration Report, then touch Print.

The printer prints the Configuration report. The IP address appears in the Connectivity section of
the Configuration Report for IPv4 or IPv6.

4. To return to the Home screen, press the Home button.
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AAcccceessssiinngg tthhee EEmmbbeeddddeedd WWeebb SSeerrvveerr
At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

To use the Embedded Web Server, click the page required:

• Home: This page provides a description of the printer and current notifications, the status of the
paper trays, and supplies and billing information. There is a Quick Links area at the bottom of the
page that provides direct access to key functions and pages.

• Jobs: The Jobs page enables you to manage active jobs on the printer, view, print, and delete
saved jobs, and create and manage saved job folders.

• Print: This page enables you to submit print-ready files to the printer for printing. You can select
options for print jobs using this page. Only print-ready files can be submitted, for example PDF, PS,
PCL, and XPS file formats.

• Scan: The Scan page enables you to create distribution workflows and mailboxes for scanned
documents.

• Address Book: Use the Address Book page to create a Device Address Book containing contacts
for use with the fax, email, and scanning apps. You can configure the printer to use a Network
Address book that looks up addresses from an LDAP directory. The printer can also be configured
to use a Network Address Book, which looks up addresses from an LDAP directory. If both the
Address Book and Device Address Book are configured, users are presented with a choice when
they use a compatible app.

• Properties: You can use the Properties tab to access and configure settings for your device. System
administrator login credentials are required to change most settings.

• Support: This page provides access to general support information and telephone numbers. You
can use the Support page to access the Remote Control Panel and send diagnostic information to
Xerox.

The Embedded Web Server has a Help option that provides information about all available device
features and functions. To access Help, click the Help link displayed at the bottom of each page.
Navigate to the topic required, or use the Search function to find specific information.

For detailed instructions on how to use the Embedded Web Server to configure printer settings, refer
to the System Administrator Guide at www.xerox.com/office/ALC81XXdocs.

LLooggggiinngg IInn UUssiinngg tthhee EEmmbbeeddddeedd WWeebb SSeerrvveerr
To access certain features, tools, and apps, log in to the Embedded Web Server for your device.

Note: Access to some restricted functions requires administrator rights. For more information,
refer to the System Administrator Guide atwww.xerox.com/office/ALC81XXdocs.

To log in to the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

2. In the top right area of the page, click Login.

3. Enter your User ID and password, then click Login.

4. If you are logging in for the first time, set up a password.

a. Type the old password.
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b. Type a new password. To verify the password, retype it.

Note: The new password must adhere to all minimum password requirements. For
details, contact your system administrator, or refer to the System Administrator Guide
atwww.xerox.com/office/ALC81XXdocs.

c. Click Save. The new password is stored.

CCeerrttiiffiiccaatteess ffoorr tthhee EEmmbbeeddddeedd WWeebb SSeerrvveerr
Your device includes an HTTPS certificate. The device generates the certificate automatically during
device installation. The HTTPS certificate is used to encrypt communications between your computer
and the Xerox device.

Note:

• The Embedded Web Server page for your Xerox device can display an error message that
the security certificate is not trusted. This configuration does not lessen the security of the
communications between your computer and the Xerox device.

• To eliminate the connection warning in your Web browser, you can replace the certificate
with a signed certificate from a Certificate Authority. For information on obtaining a
certificate from a Certificate Authority, contact your Internet Service Provider.

• To eliminate the connection warning in your Web browser, you can download the Xerox
Root CA certificate from the device Embedded Web Server, then install the certificate on
your client.

For information on obtaining, installing, and enabling certificates, refer to the System Administrator
Guide at www.xerox.com/office/ALC81XXdocs.

DDoowwnnllooaaddiinngg tthhee CCoonnffiigguurraattiioonn RReeppoorrtt ffrroomm tthhee
EEmmbbeeddddeedd WWeebb SSeerrvveerr
From the Embedded Web Server, you can download and save a copy of the Configuration Report to
your computer hard drive. Use Configuration Reports from multiple devices to compare software
versions, configurations, and compliance information.

To download a copy of the Configuration Report from the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

Note: For details about obtaining the IP address of your printer, refer to Finding the IP
Address of Your Printer.

2. To download the Configuration Report, scroll to the bottom of the page. In the Quick Links
section, click Download Configuration Report.

Note: If the Download Configuration Report feature does not appear, log in as a system
administrator.

The document is saved automatically as an XML file in the default download location on your
computer hard drive. To open the Configuration Report, use an XML viewer.
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UUssiinngg tthhee RReemmoottee CCoonnttrrooll PPaanneell FFeeaattuurree
The Remote Control Panel feature in the Embedded Web Server allows you to access the printer
control panel remotely from a Web browser.

Note: To access the Remote Control Panel, first enable the feature. For details, contact your
system administrator or refer to the System Administrator Guide at www.xerox.com/office/
ALC81XXdocs.

To access the Remote Control Panel feature:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

Note: For details about obtaining the IP address of your printer, refer to Finding the IP
Address of Your Printer.

2. In the Quick Links area, click Remote Control Panel.

Note: If the Remote Control Panel option is not displayed or fails to load, contact your
system administrator.

3. To restrict other users from accessing the device control panel when you are connected remotely
to the device, click Block device control panel (local user can only observe).

Note: If a local user attempts to access the control panel while the device control panel is
locked, the control panel does not respond. A message appears on the control panel,
confirming that the control panel is locked and the device is being controlled remotely.

4. To enable remote access to the device control panel, click Start Remote Session. The remote
control panel sends a request to the local control panel.
• If the local control panel is inactive, the remote control panel session is activated

automatically.
• If a local user is active on the device, a Remote Session Request message appears on the

local control panel. The local user chooses to accept or deny the request. If the request is
accepted, the remote control panel session is activated. If the request is denied, a Request
Denied message appears in the Embedded Web Server.

Note: If the system administrator requests a remote session, if the request is denied, an
option to override the local session is displayed.
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Installation and Setup
For reference:

• Installation Guide packaged with your printer

• Online Support Assistant at www.xerox.com/office/ALC81XXdocs

IInnssttaallllaattiioonn aanndd SSeettuupp OOvveerrvviieeww
Before you print, ensure that your computer and the printer are plugged in, powered on, and
connected. Configure the initial settings of the printer, then install the print driver software and
utilities on your computer.

You can connect to your printer directly from your computer using USB, or connect to a network using
an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different
connection methods. Routers, network hubs and switches, modems, Ethernet cables, and USB cables
are not included with your printer and must be purchased separately. Xerox recommends an Ethernet
connection because it is typically faster than a USB connection, and it provides access to the
Embedded Web Server.

For more information, refer to the System Administrator Guide at www.xerox.com/office/
ALC81XXdocs.

SSeelleeccttiinngg aa LLooccaattiioonn ffoorr tthhee PPrriinntteerr

WARNING: To avoid personal injury and damage to the printer, professional installation of the
printer is required.

1. Select a dust-free area with temperatures from 10°–32° C (50°–90° F), and relative humidity of
15–85 percent.

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold
room can cause condensation inside the printer, which directly interferes with image
transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight
of the printer. Ensure that the printer is horizontal and that all four feet are in solid contact with
the surface.
To find the weight for your printer configuration, refer to Physical Specifications.

3. Select a location with adequate clearance to access supplies and to provide proper ventilation.
To find the clearance requirements for your printer, refer to Physical Specifications.

4. After you position the printer, you are ready to connect it to the power source and computer or
network.

UUppddaattiinngg tthhee PPrriinntteerr SSyysstteemm SSooffttwwaarree
Before installing print driver software, verify that the printer has the latest version of system software
loaded. You can update your device when Xerox releases a new version of printer system software or
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firmware. To ensure a successful software update, follow the steps provided with the software files.
Printer system software is downloaded from www.xerox.com/office/ALC81XXsupport.

Before you download and install new software, determine the current software version installed on
your device. Print the Configuration Report to compare the system software version with the version
available for download. For instructions about printing a Configuration Report, refer to Printing the
Configuration Report.

Follow the instructions provided with the software to download the files and upgrade your device. You
can configure the device to connect routinely to an FTP directory on your network to update device
software automatically. You can also update the device software manually. For more information
about updating system operating software, refer to the System Administrator Guide at www.xerox.
com/office/ALC81XXdocs.
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Connecting the Printer

SSeelleeccttiinngg aa CCoonnnneeccttiioonn MMeetthhoodd
You can connect the printer to your computer using a USB cable, Ethernet cable, or wireless
connection. The method that you select depends on how your computer is connected to the network.
A USB connection is a direct connection and is the easiest to set up. An Ethernet connection is used
to connect to a network. If you are using a network connection, it is important to understand how
your computer is connected to the network.

Note: Hardware and cabling requirements vary for the different connection methods. Routers,
network hubs, network switches, modems, Ethernet cables, and USB cables are not included
with your printer and require a separate purchase.

USB
If you connect the printer to one computer and do not have a network, use a USB connection. A
USB connection offers fast data speeds, but typically is not as fast as a network connection.

Note: To access the Embedded Web Server, a network connection is required.

Network
If your computer is connected to an office network or home network, use an Ethernet cable to
connect the printer to the network. You cannot connect the printer directly to the computer. A
connection through a router or network switch is required. An Ethernet network can be used for
one or more computers and supports many printers and systems simultaneously. An Ethernet
connection is typically faster than USB and allows you direct access to the settings of the printer
using the Embedded Web Server.

Wireless Network
If your environment includes a wireless router or wireless access point, you can connect the printer
to the network with a wireless connection. A wireless network connection provides the same access
and services as a wired connection. A wireless network connection is typically faster than USB and
allows direct access to the settings of the printer using the Embedded Web Server.

CCoonnnneeccttiinngg ttoo aa CCoommppuutteerr UUssiinngg aa UUSSBB CCaabbllee
Before you connect the printer to a computer using a USB cable, ensure that the printer USB Type B
port is set to Printer Port. For details, contact your system administrator or refer to the System
Administrator Guide at www.xerox.com/office/ALC81XXdocs.

Note: The printer USB Type B port is set to SW Tools by default.

To connect the printer to a computer using a USB cable, you need one of these operating systems:

• Windows 7, Windows 8, Windows 8.1, Windows Server 2008 R2, Windows 10, Windows Server
2008 R2, Windows Server 2012, and Windows Server 2016.

• Macintosh OS X version 10.10 and later.
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• UNIX and Linux: Your printer supports connection to various UNIX platforms through the network
interface.

To connect the printer to a computer using a USB cable:

1. Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the
printer.

2. Connect the A end of the USB cable to the USB port on the computer.

3. If the Windows Found New Hardware Wizard appears, click cancel.

4. Install the print driver.

For more information, refer to Installing the Software.

CCoonnnneeccttiinngg ttoo aa WWiirreedd NNeettwwoorrkk
Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network
is used for one or more computers and supports many printers and systems simultaneously. An
Ethernet connection provides direct access to printer settings using the Embedded Web Server.

To connect the printer:

1. Connect the power cord to the printer, then plug the cord into an electrical outlet.

2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port on the back of the
printer. Connect the other end of the cable to a correctly-configured network port.

3. Power on the printer.

For details on configuring connection settings, refer to the System Administrator Guide at www.xerox.
com/office/ALC81XXdocs.

CCoonnnneeccttiinngg ttoo aa WWiirreelleessss NNeettwwoorrkk
If you have purchased the Xerox® Dual Band Wireless Kit, you can use the Wireless Wizard to connect
the device to a wireless network. If the device is connected to a wired network, you can configure
wireless settings using the Embedded Web Server or at the control panel touch screen using the
Wireless Install Wizard.

Note:

• For more information, refer to the Xerox® Dual Band Wireless Kit Hardware Install and
Setup instructions that are included with the kit.

• The device uses either the wireless or the wired network connection. Activating one network
connection deactivates the other network connection.

For details on configuring wireless network settings, refer to the System Administrator Guide at www.
xerox.com/office/ALC81XXdocs.

CCoonnnneeccttiinngg wwiitthh WWii--FFii DDiirreecctt
You can connect to your printer from any Wi-Fi-enabled mobile device, such as a tablet, computer, or
smart phone, using Wi-Fi Direct or Soft AP features. The Wi-Fi Direct feature is disabled by default on
the Xerox device.
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Note: The Wi-Fi Direct feature is available only on printers with the optional Wireless Network
Adapter installed. After you install the Wireless Network Adapter, the Wi-Fi Direct feature is
enabled by default.

WWii--FFii DDiirreecctt OOvveerrvviieeww
The Wi-Fi Direct feature allows you to print from a mobile device to your printer, using one of the
following methods.

• WPS push button, for Wi-Fi Direct-enabled Android devices with the Mopria print plug-in installed.

• Soft Access Point (AP), for Apple iPhones and other mobile devices that do not support the Wi-Fi
Direct function.

For information about using the Wi-Fi Direct feature on your mobile device, or connecting to the
printer using the Soft AP feature, refer the mobile device documentation from the manufacturer.

For information about configuring the Wi-Fi Direct feature on your printer, refer to the System
Administrator Guide at www.xerox.com/office/ALC81XXdocs.

UUssiinngg WWii--FFii DDiirreecctt oonn YYoouurr MMoobbiillee DDeevviiccee
The Wi-Fi Direct WPS Push Button feature requires the Mopria Print Service App installed on your
mobile device. The printer does not require a wireless connection.

Installing Mopria Print Service
1. On your mobile device, go to the Google Play Store, then search forMopria Print Service.

2. Install theMopria Print Service App.

3. Go to Settings, then touch Printing.

4. Go to the notification area, then touchMopria Print Service.

5. To enable Mopria Print Service, touch On.

6. Exit Settings.

Your mobile device searches for Wi-Fi Direct-enabled printers that are in range of the mobile device.

UUssiinngg WWii--FFii DDiirreecctt oonn yyoouurr PPrriinntteerr
Wi-Fi Direct is a direct wireless connection from your mobile device to the printer. The Wi-Fi Direct
feature is enabled by default when the Wi-Fi hardware is installed.

Using the Wi-Fi Direct feature does not require a wireless network connection to a printer. Contact
your System Administrator to connect your printer to a wired or wireless network.

Printing Using Wi-Fi Direct
To print a document from a Wi-Fi-enabled mobile device:

1. On the mobile device, open the document that you want to print.

2. In the device application, select the Print button.

3. If there is more than one printer in the area with Wi-Fi Direct enabled, select the required printer
from the list.
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4. Select the print settings required for the job.

5. Submit the job for printing.

A message appears on the mobile device.

6. Select Connect.

When the connection is made, a message appears on the printer.

7. At the printer control panel, touch OK.

The job prints.

CCoonnnneeccttiinngg wwiitthh NNeeaarr FFiieelldd CCoommmmuunniiccaattiioonn ((NNFFCC))

NNFFCC OOvveerrvviieeww

Near field communication (NFC) is a technology that enables devices to
communicate when they are in close range. NFC allows you to add a printer
to your Android mobile device easily. After you add the printer, there is no
need to use NFC on that printer. You can use NFC to obtain the network
interface to establish a TCP/IP connection between your device and the
printer.

Devices can communicate using NFC when they are within the following ranges:

• Device with case: 17–20 mm (0.7 x 0.8 in.)

• Device without case: 20–25 mm (0.8 x 1 in.)

Note: The range can vary depending on the device manufacturer. For information about the
required settings for individual mobile devices, refer the documentation supplied by the
manufacturer of your mobile device.

For details about configuring NFC on your printer, refer to the System Administrator Guide at www.
xerox.com/office/ALC81XXdocs.

UUssiinngg NNFFCC oonn yyoouurr MMoobbiillee DDeevviiccee
The NFC feature requires installation of the Xerox Print Service app on the mobile device.

Your mobile device must use the same Wi-Fi network environment as the printer. The printer does not
need to have a wireless connection.

Note: NFC supports Android 4.4 or greater devices.

Installing the Xerox Print Service Plugin
1. On your mobile device, go to the Google Play Store, then search for Xerox Print Service Plugin.

2. Install the Xerox Print Service Plugin app.

3. Go to Settings, then touch Printing.

4. Go to the notification pull-down bar, then touch Xerox Print Service.
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5. To enable Xerox Print Service, touch On.

6. Exit Settings.

Enabling NFC on the Mobile Device
Most mobile devices have NFC disabled by default.

To enable NFC:

1. Go to Settings.

2. Go to the NFC setting, then touch On.

3. Exit Settings.

UUssiinngg NNFFCC oonn yyoouurr PPrriinntteerr
The NFC chip is on the bottom right of the control panel. When NFC is enabled, the NFC icon is
lighted, and you can use the NFC function.

Refer to your mobile device user documentation for the mobile device NFC chip location.

Note: The NFC function must be enabled before use. For NFC enable instructions, refer to the
System Administrator Guide at www.xerox.com/office/ALC81XXdocs.

Mapping the Printer to your Mobile Device
1. Open the Xerox Print Service Plugin.

2. At the top right side of the screen, touch the selection button, then select Add Printer.

3. Touch the NFC option.

4. Hold the mobile device over the NFC icon on the control panel.

The mobile device and the printer communicate with each other. The mobile device searches the
network for the printer. When the printer is located, it is added to the list as a mapped printer.

You can submit print jobs from your mobile device to the printer.
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Printing using Mopria
1. Open the document that you want to print.

2. At the top of the screen, select the Print button.

3. If there is more than one printer mapped for use with NFC, select the printer required.

4. Select the print settings required for the job.

5. Submit the job for printing.

CCoonnffiigguurriinngg AAiirrPPrriinntt
AirPrint is a software feature that allows you to print documents from Apple iOS-based mobile devices
and MacOS-based devices without a print driver. AirPrint-enabled printers that use a wired or wireless
connection allow you to print or fax directly from a Mac, an iPhone, iPad, or iPod Touch. Additionally,
you can use AirPrint to scan from a wired or wireless printer to supported Apple devices.

For information about AirPrint configuration settings, refer to the System Administrator Guide at
www.xerox.com/office/ALC81XXdocs. Alternatively, use a desktop computer to access the Embedded
Web Server for your device, then click the Help link that appears at the bottom of each page. For
details, refer to Accessing the Embedded Web Server.

CCoonnffiigguurriinngg GGooooggllee CClloouudd PPrriinntt
Google Cloud Print allows you to print documents from an Internet-connected device without using a
print driver. Documents stored in the cloud, a personal computer, tablet, or smartphone can be sent to
the printer from anywhere.

For more information on Google Cloud Print, including procedures for managing accounts, sharing
printers, and printing, refer to the Google Cloud Print Help Center.

Before you begin:

• Set up a Google email account.

• Configure the printer to use IPv4.

• Configure Proxy Server settings as needed.

To configure Google Cloud Print:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

Note: For details about obtaining the IP address of your printer, refer to Finding the IP
Address of Your Printer.

2. In the Embedded Web Server, click Properties→Connectivity→Setup.

Note: If this feature does not appear, log in as a system administrator. For details, refer to
the System Administrator Guide at www.xerox.com/office/ALC81XXdocs.

3. For Mobile Workflows, for Google Cloud Print Service, click Edit.

4. For Status, for Registration Status, click Register Printer. The Printer Registration Options page
opens.
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5. To give the printer a user-friendly name, click Edit.

Note: Xerox recommends that you choose a user-friendly name that includes the printer
location and department.

6. Click Continue to Register. The Options for Registering Your Printer page opens.

7. To change enablement settings, for Enablement, select options as needed.

8. Click Register Printer. The Google Cloud Print Service page reappears with a link that allows you
to complete the device registration.

Note: If printer registration does not continue, to troubleshoot the problem, refer to the
System Administrator Guide at www.xerox.com/office/ALC81XXdocs.

9. Within 15 minutes, click the link for Enabled - Finish device registration. The Google Cloud Print
Printer confirmation page opens in a new browser tab.

Note:

• If prompted, log in to your Google account.

• If you do not click the link within 15 minutes, begin the registration process again.

10. Click Finish printer registration. A message confirms that the printer is registered. The Cloud
Printer is now ready to print.

11. To access the Google Cloud Print feature, in your Google account, clickManage Your Printer.

Note: The default printer name appears in this format: Model name (MAC address).

For additional information about Google Cloud Print configuration and settings, refer to the System
Administrator Guide at www.xerox.com/office/ALC81XXdocs.

CCoonnnneeccttiinngg ttoo aa TTeelleepphhoonnee LLiinnee
If an optional fax kit is installed, connect the telephone line to enable and configure the fax settings.

Note: One-line or two-line fax kits are available. To enable fax functions, install the fax card
provided with the kit, using the installation instructions provided.

WARNING: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger
telecommunication line cord.

1. Ensure that the printer is powered off.

2. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger to the Line port on
the back of the printer.

3. Connect the other end of the RJ11 cable to an operating telephone line.

4. Power on the printer.

5. Enable and configure the Fax functions.
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Initial Printer Setup
Before installing the printer software, verify that the printer is set up correctly. Setup includes
enabling the optional features and assigning an IP address for the Ethernet network connection.
Printer settings can be configured at the printer control panel or by using the Embedded Web Server.
To configure settings at the printer control panel, the Installation wizard starts the first time that you
power on the printer. The wizard prompts you with a series of questions to help configure basic
printer settings.

The System Administrator can configure the following settings:

• Language

• Network Connection

• Proxy Server Setup

• Date and Time

• Measurements

• LDAP Settings

• Apps Setup

• Security Settings

For more information on configuring the printer settings at the control panel or using the Embedded
Web Server, refer to the System Administrator Guide at www.xerox.com/office/ALC81XXdocs.
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Installing the Software
Before you install the print driver software, verify that the printer is plugged in, powered on,
connected correctly, and has a valid IP address. The IP address usually appears in the upper right
corner of the control panel. If you cannot find the IP address of your printer, refer to Finding the IP
Address of Your Printer.

Note: If the Software and Documentation disc is not available, download the latest drivers
from www.xerox.com/office/ALC81XXdrivers.

OOppeerraattiinngg SSyysstteemm RReeqquuiirreemmeennttss
• Windows 7, Windows 8, Windows 8.1, Windows Server 2008 R2, Windows 10, Windows Server

2012, Windows Server 2016, and Windows Server 2019.

• MacOS version 10.13 and later.

• UNIX and Linux: Your printer supports connection to various UNIX platforms through the network
interface.

IInnssttaalllliinngg tthhee PPrriinntt DDrriivveerrss ffoorr aa WWiinnddoowwss NNeettwwoorrkk
PPrriinntteerr
1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the

installer does not start automatically, navigate to the drive, then double-click the Setup.exe
installer file.

2. Click Xerox Smart Start — Driver Installer (Recommended).

3. At the License Agreement, click Agree.

4. From the list of discovered printers, select your printer.

Note:When you install print drivers for a network printer, if your printer does not appear in
the list, click Don’t See Your Printer?, then enter the IP address for your printer. To install
the recommended print driver, click Continue, then select Install.

5. Click Quick Install.

A message appears that confirms that the installation is successful.

6. To complete the installation and close the Installer window, click Done.

IInnssttaalllliinngg tthhee WWiinnddoowwss PPrriinntt DDrriivveerr ..zziipp FFiillee
You can download print drivers from Xerox.com in a .zip file, then use the Windows Add Printer Wizard
to install the print drivers on your computer.

To install the print driver from the .zip file:

1. Download, then extract the required .zip file to a local directory on your computer.

2. At your computer, open the Control Panel, then select Devices and Printers→Add a Printer.

3. Click The printer that I want isn't listed, then click Add a local printer or network printer with
manual settings.
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4. To use a previously established port, select Use an existing port, then from the list, select a
Standard TCP/IP Port.

5. To create a Standard TCP/IP port:

a. Select Create a New Port.

b. For Type of port, select Standard TCP/IP Port, then click Next.

c. In the Hostname or IP address field, type the printer IP address or host name.

d. To disable the feature, clear the check box for Query the printer and automatically select
the driver to use, then click Next.

6. Click Have Disk.

7. Click Browse. Browse to, then select the driver.inf file for your printer. Click Open.

8. Select your printer model, then click Next.

9. If a prompt appears because the print driver was installed previously, click Use the driver that is
currently installed (recommended).

10. In the Printer name field, type a name for your printer.

11. To install the print driver, click Next.

12. If needed, set the printer as the default printer.

Note: Before you select Share Printer, contact your system administrator.

13. To send a test page to the printer, click Print a test page.

14. Click Finish.

IInnssttaalllliinngg tthhee PPrriinntt DDrriivveerrss ffoorr aa WWiinnddoowwss UUSSBB PPrriinntteerr
1. Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the

printer.

2. Connect the A end of the USB cable to the USB port on the computer.

3. If the Windows Found New Hardware Wizard appears, click cancel.

4. Insert the Software and Documentation disc into the appropriate drive on your computer. If the
installer does not start automatically, navigate to the drive, then double-click the Setup.exe
installer file.

5. Click Xerox Smart Start — Driver Installer (Recommended).

6. At the License Agreement, click Agree.

7. From the list of discovered printers, select your printer, then click Quick Install.

A message appears that confirms that the installation is successful.

8. To complete the installation and close the Installer window, click Done.

IInnssttaalllliinngg tthhee PPrriinntteerr aass aa WWeebb SSeerrvviiccee oonn DDeevviicceess
Web Services on Devices (WSD) allows a client to discover and access a remote device and its
associated services across a network. WSD supports device discovery, control, and use.
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IInnssttaalllliinngg aa WWSSDD PPrriinntteerr UUssiinngg tthhee AAdddd DDeevviiccee WWiizzaarrdd
1. At your computer, click Start, then select Printers and Scanners.

2. To add the required printer, click Add a Printer or Scanner.

3. In the list of available devices, select the device that you want to use, then click Next.

Note: If the printer that you want to use does not appear in the list, click Cancel. To add
the printer manually, use the IP address of the printer. For details, refer to Installing the
Windows Print Driver .zip File.

4. Click Close.

IInnssttaalllliinngg tthhee DDrriivveerrss aanndd UUttiilliittiieess ffoorr MMaaccOOSS
1. Download the latest print driver from www.xerox.com/office/ALC81XXsupport.

2. Open the Xerox® Print Drivers 5.xx.x.dmg or .pkg as needed for your printer.

3. To run Xerox® Print Drivers 5.xx.x.dmg or .pkg, double-click the appropriate file name.

4. When prompted, click Continue.

5. To accept the license agreement, click I Agree.

6. To accept the current installation location, click Install, or select another location for the
installation files, then click Install.

7. If prompted, enter your password, then click OK.

8. From the list of discovered printers, select your printer, then click Next.

9. If your printer does not appear in the list of discovered printers:

a. Click the Network Printer Icon.

b. Type the IP address of your printer, then click Continue.

c. Select your printer in the list of discovered printers, then click Continue.

10. If your printer was not detected, verify that the printer is powered on and that the Ethernet or
USB cable is connected properly.

11. To accept the print queue message, click OK.

12. Select or clear the Set Printer as Default and Print a Test Page check boxes.

13. Click Continue, then click Close.

AAddddiinngg tthhee PPrriinntteerr ffoorr MMaaccOOSS
For networking, set up your printer using Bonjour® (mDNS), or for an LPD, LPR connection, connect
using the IP address of your printer. For a non-network printer, create a desktop USB connection.

For more information, go to the Online Support Assistant at: www.xerox.com/office/ALC81XXsupport.
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Adding the Printer Using Bonjour
To add the printer using Bonjour®:

1. From the computer Applications folder or from the dock, open System Preferences.

2. Click Printers & Scanners.

The list of printers appears on the left of the window.

3. For the list of printers, click the Plus icon (+).

4. At the top of the window, click the Default icon.

5. Select your printer from the list, then click Add.

Note: If your printer is not detected, verify that the printer is powered on and that the
Ethernet cable is connected properly.

Adding the Printer by Specifying the IP Address
To add the printer by specifying the IP address:

1. From the computer Applications folder or from the dock, open System Preferences.

2. Click Printers & Scanners.

The list of printers appears on the left of the window.

3. In the list of printers, click the Plus (+) icon.

4. Click IP.

5. From the Protocol list, select the protocol.

6. In the Address field, enter the IP address of the printer.

7. In the Name field, enter a name for the printer.

8. From the Use list, choose Select a driver to use.

9. From the printer software list, select the print driver for your printer model.

10. Click Add.

IInnssttaalllliinngg PPrriinntt DDrriivveerrss aanndd UUttiilliittiieess ffoorr UUNNIIXX aanndd
LLiinnuuxx
For more information on installing print drivers and utilities for UNIX and Linux, refer to www.xerox.
com/office/ALC81XXdrivers.
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More Information
You can obtain more information about your printer from these sources:

Resource Location

Installation Guide Packaged with the printer.

Getting Started guide Print from the control panel. For details, refer to
Information Pages.

Other documentation for your printer www.xerox.com/office/ALC81XXdocs

Recommended Media List United States: www.xerox.com/rmlna

European Union: www.xerox.com/rmleu

Technical support information for your printer,
including online technical support, Online Support
Assistant, and print driver downloads.

www.xerox.com/office/ALC81XXsupport

Information Pages Print from the control panel. For details, refer to
Information Pages.

Embedded Web Server information In the Embedded Web Server, click Help.

Order supplies for your printer www.xerox.com/office/supplies

A resource for tools and information, including
interactive tutorials, printing templates, helpful tips,
and customized features to meet your individual
needs.

www.xerox.com/office/businessresourcecenter

Local sales and Technical Customer Support www.xerox.com/office/worldcontacts

Printer registration www.xerox.com/register

Xerox® Direct online store www.direct.xerox.com/
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LLooccaattiinngg tthhee SSeerriiaall NNuummbbeerr
When you order supplies or contact Xerox for assistance, you need the serial number of your device.
You can obtain the serial number in several ways. To locate the serial number, print the Configuration
Report. You can view the serial number on the control panel or on the Embedded Web Server home
page. The serial number is printed on a label that is affixed to the printer. To view the label, open the
left side door.

For details on how to print the Configuration Report, refer to Information Pages.

To view the serial number on the control panel:

1. At the printer control panel, press the Home button.

2. Touch Device.

3. Touch About.

The model, serial number, and software version is displayed.

4. To return to the Home screen, press the Home button.
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Personalize Overview
This chapter provides information on how to personalize your device user interface to meet the
specific demands of your workflows. Personalization enables individual logged-in users to work more
productively, and ensures that the features and functions displayed meet individual user needs,
improving efficiency.

Personalization allows you to configure apps, and hide, show, and rearrange apps on the Home screen
to suit your job priorities. You can create 1-Touch Apps to save and simplify lengthy or frequent
workflows. After you create 1-Touch Apps, they appear on the user Home screen. For each app, you
can hide or show individual features and configure default settings to meet your needs, and save job
settings for repeated use.

System administrators can use Customization to configure settings for all users. Customization allows
the system administrator to do the following:

• Hide, show, and rearrange apps on the Home screen

• Create 1-Touch Apps

• Hide or show app features

• Configure and save the default settings

For details, contact your system administrator, or refer to the System Administrator Guide at www.
xerox.com/office/ALC81XXdocs.

Note: Personalization settings configured by individual users override any equivalent
Customization settings configured by the system administrator.
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Personalizing the Home Screen
Using the personalization options, you can show, hide, or change the display order of apps for the
Home screen.

DDiissppllaayyiinngg oorr HHiiddiinngg aann AApppp oonn tthhee HHoommee ssccrreeeenn
To display or hide an app on the Home screen for the logged-in user:

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using
the keypad, then touch Done.

3. Scroll to the bottom, then touch Personalize.

4. Touch Personalize Home.

5. To display an installed, but hidden app:

a. Touch the Plus (+) icon.

b. Touch the app that you want to appear on the control panel.

6. To hide an installed app:

a. For the required app, touch X.

b. Touch Hide.

7. Touch Done.

8. Verify that only the required apps appear on the Home screen.

RReeaarrrraannggiinngg AAppppss oonn tthhee HHoommee ssccrreeeenn
To rearrange apps on the Home screen for the logged-in user:

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using
the keypad, then touch Done.

3. Scroll to the bottom, then touch Personalize.

4. Touch Personalize Home.

5. Touch and hold the required app, then drag the app to the new location. Release the app.

6. Touch Done.

7. Verify that the apps appear in the correct location on the Home screen.

DDeelleettiinngg aann AApppp ffrroomm tthhee HHoommee SSccrreeeenn
To delete an app from the Home screen for the logged-in user:

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using
the keypad, then touch Done.
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3. Scroll to the bottom, then touch Personalize.

4. Touch Personalize Home.

5. To delete an installed app:

a. For the required app, touch X.

b. At the prompt, touch Delete.

6. Touch Done.

7. Verify that only the required apps appear on the Home screen.

RReemmoovviinngg PPeerrssoonnaalliizzaattiioonn FFrroomm tthhee HHoommee SSccrreeeenn
To remove personalization from the Home screen for the logged-in user:

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using
the keypad, then touch Done.

3. Scroll to the bottom, then touch Personalize.

4. Select an option:
• Remove Home Personalization: This option removes all personalization from the Home

screen.

Caution: The Remove Home Personalization option removes personalization from the
Home screen, and other personalized device settings.

• Remove All Personalization: This option removes all personalization for the logged-in user,
including personalized 1–Touch apps.

Note: Any customizations configured by the system administrator, including 1-Touch,
EIP, Single Touch, and Weblet apps, are not affected.

5. At the prompt, touch Remove.

Apps appear in the default location on the Home screen.

6. Touch Done.
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Personalizing the Apps
The app personalization options enable you to modify the features available, save app default
settings, or remove personalized settings applied to an app.

You can personalize the Copy, ID Card Copy, Email, Fax, and Scan To apps for your device.

PPeerrssoonnaalliizziinngg tthhee FFeeaattuurree LLiisstt
To personalize the Features list for an app for the logged-in user:

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using
the keypad, then touch Done.

3. Touch the app required.

4. Scroll to the bottom, then touch Personalize.

5. Touch Personalize Feature List.

6. Touch the required option.
• To hide a feature, for the required feature, touch the Eye icon. To signify that the feature is

hidden, the Eye icon appears with a line across it.
• To show a feature, for the required feature, touch the Eye icon. To signify that a feature is

visible, the Eye icon appears with no line across it.

7. To reorder the menu features, touch and drag the features into the appropriate order.

8. To save the current configuration, touch Done.

SShhoowwiinngg aallll FFeeaattuurreess iinn tthhee FFeeaattuurreess LLiisstt
To show all the hidden features for an app:

1. At the printer control panel, press the Home button.

2. Touch the app required.

3. Select the job settings.

4. Scroll to the bottom, then touch Show Additional Features.

The hidden features list appears.

SSaavviinngg AApppp DDeeffaauulltt SSeettttiinnggss
You can use this feature to save a particular combination of app settings as the default settings.

To save the current app settings as default settings for the logged-in user:

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using
the keypad, then touch Done.

3. Touch the app required.

4. Select the job settings that you want to save as the default settings.
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5. Scroll to the bottom, then touch Personalize.

6. Touch Save Settings as Default.

The new settings override the previous default settings.

RReemmoovviinngg AApppp PPeerrssoonnaalliizzaattiioonn UUssiinngg tthhee CCoonnttrrooll
PPaanneell
To remove the current app personalization settings:

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using
the keypad, then touch Done.

3. Touch the app required.

4. Scroll to the bottom, then touch Personalize.

5. Touch Remove App Personalizations.

6. At the prompt, touch Remove.
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Creating and Using 1–Touch Apps
You can use 1-Touch Apps to create individual apps to complete frequent jobs or tasks. After you log
in and create a 1-Touch App, the app appears on the printer Home screen for the logged-in user. To
run the job, load the original documents in the automatic document feeder or on the document glass,
then touch the required 1-Touch App.

Note: If you create a 1–Touch App using Personalization, the app is available only for the
logged-in user. To create 1–Touch Apps that are available for all users, use Customization. For
details, contact your system administrator, or refer to the System Administrator Guide at www.
xerox.com/office/ALC81XXdocs.

System administrators can use the Fleet Orchestrator feature to clone and install 1–Touch Apps on
other devices. For information about Cloning and using the Fleet Orchestrator feature, refer to the
System Administrator Guide at www.xerox.com/office/ALC81XXdocs.

CCrreeaattiinngg aa 11––TToouucchh AApppp
To create a 1-Touch App for the logged-in user:

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using
the keypad, then touch Done.

3. Touch the app required.

4. Select the job settings for the 1–Touch App, as required.

5. Scroll to the bottom, then touch Create 1–Touch App.

6. To save the selected job settings, touch Save as 1-Touch App.

7. To enter a name, touch the Enter App Name entry field, then use the keypad. Touch Next.

8. Touch a color scheme option for your 1-Touch App, then touch Next.

9. Touch an icon that best suits the 1-Touch App that you are creating, then touch Next.

10. To enter instructions for users, touch the Enter App Instructions entry field, then use the keypad.
Touch Next.

When the 1-Touch App is selected, the instructions appear at the top of the screen.

11. Touch the app settings required:
• Allows Editing Quantity: Use this option to allow users to view and update the quantity.
• Show Feature Settings: Use this option to display a summary of the features programmed

for the 1- Touch App.

12. Touch Done.

The 1–Touch App appears on the Home screen for the logged-in user.
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DDeelleettiinngg oorr HHiiddiinngg aa 11––TToouucchh AApppp
To delete or hide a 1-Touch App from the Home screen:

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using
the keypad, then touch Done.

3. Touch Personalize.

4. Touch Personalize Home.

5. For the required 1-Touch App, touch X, then touch an option.
• Delete: Use this option to delete the 1-Touch App from the printer permanently.
• Hide: Use this option to remove the 1-Touch App from the Home screen. The 1-Touch App is

still available, and you can add the app to the Home screen at any time.

6. Touch Done.

UUssiinngg aa 11––TToouucchh AApppp
To use a 1-Touch App:

1. At the printer control panel, press the Home button.

2. Load the original documents in the automatic document feeder or on the document glass.

3. Select the 1-Touch App for your job.

4. Do one of the following.
• For Copy Jobs, if you selected Allow Editing Quantity during 1-Touch App setup, update the

number of copies, as required.
• If you selected the Show Feature Settings option during the 1-Touch App setup, update the

feature settings, as required.

5. Touch Start.

6. To return to the Home screen, press the Home button.
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Removing All Personalizations
To remove all personalizations from the device:

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using
the keypad, then touch Done.

3. Scroll to the bottom, then touch Personalize.

4. Touch Remove All Personalizations.

Caution: The Remove Home Personalization option removes personalization from the
Home screen, and other personalized device settings.

5. At the prompt, touch Remove All.
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Xerox ® Apps are a gateway to the features and functions of your device. There are standard Apps
already installed and displayed on the Home screen. Some Apps are installed as standard, but are
hidden when you use your device for the first time. You can show, hide, or reorder Apps on the Home
screen using the settings available in the Embedded Web Server.

For details about displaying, configuring, and customizing the Apps, refer to the System Administrator
Guide at www.xerox.com/office/ALC81XXdocs.

A range of Apps is available for download and installation from the Xerox® App Gallery. These apps
include Xerox® Extensible Interface Platform (EIP) Apps. EIP Apps enable you to install secure, signed
apps on compatible printers.

For more information about using the Xerox® App Gallery and downloading Apps, refer to Xerox®
App Gallery.
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Xerox® App Gallery

XXeerrooxx®® AApppp GGaalllleerryy OOvveerrvviieeww

Use the Xerox® App Gallery to find apps that provide new features or
capabilities for your device. The Xerox® App Gallery provides direct access to
apps that can improve your productivity, simplify workflows, and enhance
your user experience.

The Xerox® App Gallery enables you to browse and update apps easily. You can browse the App
Gallery without logging in. The moving banner provides an active display of apps, or you can scroll
the full list of apps. To get more details on an app, touch the app name in the list.

To use the Xerox® App Gallery App, ensure that your device uses either the wireless or the wired
network connection.

Note: If your device is configured to access the Internet through a proxy, to allow the Xerox®
App Gallery App to access the Internet, ensure that the proxy is configured correctly.

For more information and instructions on using the Xerox® App Gallery, refer to the Xerox® App
Gallery User Guide available at www.xerox.com/XeroxAppGallery.

CCrreeaattiinngg aa XXeerrooxx®® AApppp GGaalllleerryy AAccccoouunntt
With an App Gallery account, you have direct access to all the available Apps for your device. An App
Gallery account allows you to view and acquire Apps, install Apps on your device, and manage your
Apps and licenses.

You can set up an App Gallery account using the control panel or the Xerox ® App Gallery Web portal.
For more information about the Xerox ® App Gallery Web portal, refer to www.xerox.com/
XeroxAppGallery.

Note: If you have an existing Xerox App Gallery Account, refer to Logging in to your Xerox®
App Gallery Account.

To create an App Gallery account using the Control Panel:

1. At the printer control panel, press the Home button.

2. Touch Xerox App Gallery.

3. Touch Log In.

4. Touch Create Account.

5. Enter the information required into the appropriate fields:
• Email Address
• Confirm Email Address
• Password
• Confirm Password
• First and Last Name
• Company Name
• Country
• Payment Currency
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6. Review and accept the Terms of Service and the Data Administration Terms of Service, then click
OK.

7. After the account is created, a message appears that confirms that completion instructions will
be sent to the email address entered in step 5.

8. To complete the account creation process, verify your account:

a. Access the inbox for the email address provided in step 5, then open theWelcome to Xerox®
App Gallery email.

b. Click Verify Account.

A webpage opens.

c. To complete the verification process, enter the email address and password entered in step 5,
then click Log In.

A welcome message appears that confirms that the account verification process is complete.

LLooggggiinngg iinn ttoo yyoouurr XXeerrooxx®® AApppp GGaalllleerryy AAccccoouunntt
When you are logged in to the App Gallery, you can browse available Apps, and install and update
Apps.

To log in to your App Gallery Account:

1. At the printer control panel, press the Home button.

2. Touch Xerox App Gallery, then select Log In.

3. To enter your email address, use the touch screen keypad.

4. To enter your password, use the touch screen keypad.

5. To log in, touch OK or Enter.

IInnssttaalllliinngg oorr UUppddaattiinngg aann AApppp ffrroomm tthhee XXeerrooxx®® AApppp
GGaalllleerryy
Xerox® Apps add to, extend, or customize the functionality of your device. You can use the Xerox®App
Gallery App to browse and install Apps at your device control panel.

To install an App from the App Gallery:

1. At the printer control panel, press the Home button.

2. Touch Xerox App Gallery, then select Log In.

3. To enter your email address, use the touch screen keypad.

4. To enter your password, use the touch screen keypad.

5. Touch OK or Enter.

6. Touch the App required, then touch Install. The License Agreement screen appears.

Note: If the App was installed previously and a new version is available, the Install option
changes to an Update option.
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7. Touch Agree. The installation process begins.

If the App does not successfully install, to attempt the installation process again, touch Install.

8. To exit the Xerox® App Gallery App, press the Home button.

UUppddaattiinngg aann AApppp ffrroomm tthhee AApppp GGaalllleerryy
1. At the printer control panel, press the Home button.

2. Touch Xerox App Gallery, then select Log In.

3. To enter your email address, use the touch screen keypad.

4. To enter your password, use the touch screen keypad.

5. Touch OK or Enter.

6. Touch the App required, then touch Update. The License Agreement screen appears.

7. Touch Agree.

8. When the update is complete, the Update option changes to an Installed status.

9. To exit the Xerox® App Gallery App, press the Home button.
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Device
DDeevviiccee OOvveerrvviieeww

The Device App gives you access to information about your printer, including
the serial number and model. You can view the status of the paper trays,
billing and supplies information, and print information pages.

Many Device options can be configured to meet your individual needs. For details about configuring
all of the Device settings, refer to the System Administrator Guide at www.xerox.com/office/
ALC81XXdocs.

DDeevviiccee OOppttiioonnss
The following device options are available:

Option Description

About The About option provides an overview of your device, the device
serial number, and information about current settings.

Information
Pages

Your printer has a set of information pages that you can print.
These pages include configuration and font information,
demonstration pages, and more.

Notifications Use the Notifications option to see details of any current alerts or
errors on the device. A Fault History option displays fault codes and
the date that they occurred on the device.

Paper Trays Use the Paper Trays option to see the paper size, type, and color set
for each paper tray and the tray-capacity status.

Supplies Use the Supplies section to monitor the status of the components
you can replace. The supply level and estimated number of
impressions or days that remain for each unit is displayed.

Billing/Usage Use the Billing/Usage option to view the serial number and the
total number of impressions your device has made.

Tools Use the Tools option to customize settings such as the power-save
modes, the date and time, and the control panel brightness. You
can configure settings using the device control panel, or by using
the Embedded Web Server.

Note: For details on configuring the printer settings, see the
System Administrator Guide at www.xerox.com/office/
ALC81XXdocs.
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Option Description

Web-Based
Configuration
(Test Drive)

Use the Web-Based Configuration (Test Drive) tool to access device
capabilities and configuration options available on the Embedded
Web Server, at the device control panel.

Note: Some Embedded Web Server configuration options
and features are restricted. Examples of restricted options
and features are downloading and installing files, and
accessing links that redirect to external websites.

Remote Services Use the Remote Services option to send error and usage
information to the Xerox support team.

Note: Your System Administrator is required to enable this
feature using the Embedded Web Server.

For details on configuring the printer settings, refer to the System Administrator Guide at www.xerox.
com/office/ALC81XXdocs.

AAbboouutt
The About option provides an overview of your device and its current settings and status. You can
view the serial number, model number, and software version.

IInnffoorrmmaattiioonn PPaaggeess
Your printer has a set of information pages that you can print. These pages include configuration and
font information, demonstration pages, and more.

To print an information page, select an option, then touch Print.

The following Information Pages are available:

Name Description

Configuration Report The Configuration Report provides printer
information including the serial number, installed
options, network settings, port setup, tray
information, and more.

Billing Summary The Billing Summary Report provides information
about the device and a detailed listing of the billing
meters and sheet counts.

Getting Started The Getting Started guide provides an overview of
the key features of the printer.

Troubleshooting Print Quality Page The Troubleshooting Print Quality Page provides a list
of common print-quality problems and tips to help
solve them.
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Name Description

Supplies Usage Page The Supplies Usage Page provides coverage
information and part numbers for reordering
supplies.

Graphics Demo Page Print this page to check the quality of graphics.

PCL Font List The PCL Font List provides a printout of all PCL fonts
that are available on the printer.

PostScript Font List The PostScript Font List provides a printout of all
PostScript fonts that are available on the printer.

SSuuppppllyy SSttaattuuss
You can check the status and percentage of life remaining for your printer supplies at the control
panel or from the Embedded Web Server. When printer supplies near their replacement time, warning
alerts appear on the control panel. You can customize the alerts that appear on the control panel and
configure email alert notifications.

To check the supplies status at the control panel:

1. To view status information for the printer supplies, touch Device→Supplies.

2. To view details about a specific toner cartridge, including the part number for reordering, touch
Cyan,Magenta, Yellow, or Black.

3. To view more details, touch Other Supplies. Scroll through the list, then select an option.

4. To print the Supplies Usage Page, touch Print Supplies Report.

5. To return to the Supplies screen, touch X.

6. To return to the Device screen, touch X.

7. To return to the Home screen, press the Home button.

To check the supplies status and set up alerts, use the Embedded Web Server. For details about
configuring all Device settings, refer to the System Administrator Guide at www.xerox.com/office/
ALC81XXdocs.
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BBiilllliinngg aanndd UUssaaggee CCoouunntteerrss
The Billing/Usage menu displays the total number of impressions that the printer generated or
printed during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of
paper. For example, a sheet of paper that is printed on two sides counts as two impressions.

To view the Billing and Usage Counters:

1. At the printer control panel, press the Home button.

2. Touch Device→Billing/Usage.

The impression counts are displayed:

• Black Impressions: Total number of pages printed with no color specified.

• Color Impressions: Total number of pages printed that specify color.

• Total Impressions: Total number of color impressions and black impressions.

3. To view more details, touch Usage Counters, then select an option.
• Impression Counters: This option provides the number of impressions made by the printer.

The number of impressions cannot equal the number of sheets counted, depending on the
printer setup. If your printer is set up to count large sheets as large impressions or as multiple
smaller impressions, the number of impressions can differ.

• Sheet Counters: This option provides the number of impressions made by the printer.
Impressions for 2-Sided sheets are identified as a separate line from1-Sided sheets.

• Images Sent Counters: This option provides the number of images sent using the Fax, Email,
or Scan features.

• Fax Impressions Counters: This option provides the number of images sent using the Fax
features. Each fax feature is identified on a separate line.

• All Usage Counters: This option provides all printer usage information.

4. After viewing the usage readings, to return to the Home screen, press the Home button.

RReemmoottee SSeerrvviicceess
You can use the Remote Services option to send error and usage information to the Xerox support
team to help them resolve problems quickly.

For information about enabling Remote Services and uploading information to Xerox, refer to the
System Administrator Guide at www.xerox.com/office/ALC81XXdocs.
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Jobs
JJoobbss OOvveerrvviieeww

You can use Jobs to view current jobs, print saved and secure jobs, and view
details about completed jobs. You can pause, delete, print, or view job
progress or job details for a selected job.

MMaannaaggiinngg JJoobbss
From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs.
You can interrupt, pause, or delete jobs that are printing. You can also view job progress or job details
for a selected job.

A print job can be held by the printer when it is unable to complete the job. For example, if the printer
needs attention, paper, or supplies. When the condition is resolved, the printer automatically resumes
printing. When you send a Secure Print job, the job is held until you release it by entering a passcode
at the control panel. For more details, refer to Managing Special Job Types.

From the Jobs window in the Embedded Web Server, you can view a list of active and saved print jobs.
For more details, refer to Managing Jobs using the Embedded Web Server.

IInntteerrrruuppttiinngg PPrriinnttiinngg
1. At the control panel, touch the Interrupt button. The printer continues to print while it

determines the best place to pause the spooled print job.

2. Printing stops to allow the printer to complete another job.

3. To resume printing, touch the Interrupt button again.

PPaauussiinngg oorr DDeelleettiinngg aa PPrriinntt JJoobb
1. At the printer control panel, press the Home button.

2. To pause a job that is printing, touch the pause button on the control panel.

3. Select a task.
• To resume the print job, touch Resume.
• To delete the print job, touch Delete. At the prompt, touch Delete.

4. To return to the Home screen, press the Home button.

PPaauussiinngg oorr DDeelleettiinngg aa PPrriinntt JJoobb
1. At the printer control panel, press the Home button.

2. To pause a job that is printing, touch the pause button on the control panel.
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3. Select a task.
• To resume the print job, touch Resume Printing.
• To delete the print job, touch Delete Job. At the prompt, confirm the deletion.

4. To return to the Home screen, press the Home button.

PPrriinnttiinngg aa JJoobb HHeelldd ffoorr RReessoouurrcceess
1. At the printer control panel, press the Home button.

2. Touch Jobs.

3. From the jobs list, touch the held job name. The resources required for the job appear on the
control panel.

4. Do one of the following steps.
• To print the job, replenish the resources required. The job resumes automatically when the

required resources are available. If the job does not print automatically, touch Resume.
• To choose an alternative paper source to enable the job to print, touch Print On Alternate

Paper. Select a paper tray, then touch OK.
• To delete the print job, touch Delete. At the prompt, touch Delete.

Note: The Print On Alternate Paper option is enabled using the Embedded Web Server. For
details about the Print On Alternate Paper option, refer to the System Administrator Guide
at www.xerox.com/office/ALC81XXdocs.

5. To return to the Home screen, press the Home button.

MMaannaaggiinngg SSppeecciiaall JJoobb TTyyppeess
Special job types allow you to send a print job from your computer, then print it from the printer
control panel. Select special job types in the print driver, Printing Options tab, under Job Type.

SSaavveedd JJoobb
Saved Jobs are documents that are sent to the printer and stored there for future use. All users can
print or delete a Saved Job.

At the control panel, from the Print From menu, you can view and print saved jobs. In the Embedded
Web Server, in the Jobs window, you can view, print, and delete saved jobs, and you can manage
where jobs are stored.

Printing using Saved Job
1. In your software application, access the print settings. For most software applications, press CTRL

+P for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
• For Windows, click Printer Properties. Depending on your application, the title of the button

can vary.
• For Macintosh, in the Print window, in the print options list, click Xerox Features.

3. For Job Type, select Saved Job.

a. Type a job name or select a name from the list.

b. Type a folder name or select a name from the list.
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c. To add a passcode, click Private, type the passcode, then confirm the passcode.

d. Click OK.

4. Select other required printing options.
• For Windows, click OK, then click Print.
• For Macintosh, click Print.

Printing deleting, moving, or copying a saved job in the Embedded Web Server
1. At your computer, open a Web browser. In the address field, type the IP address of the printer,

then press Enter or Return.

2. In the Embedded Web Server, click Home.

3. Click Jobs.

4. Click the Saved Jobs tab.

5. For the job that you want to process, select the check box.

6. From the menu, select an option.
• Print Job: This option prints a job immediately.
• Delete Job This option deletes the saved job.
• Move Job: Use this option to move the job to another folder location.
• Copy Job: Use this option to duplicate the job.

7. Click Go.

SSeeccuurree PPrriinntt
Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the
printer until you enter your passcode at the printer control panel.

After a Secure Print job is printed, it is deleted automatically.

Printing using Secure Print
1. In your software application, access the print settings. For most software applications, press CTRL

+P for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
• For Windows, click Printer Properties. Depending on your application, the title of the button

varies.
• For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Secure Print.

4. Type the passcode, confirm the passcode, then click OK.

5. Select any other required printing options.
• For Windows, click OK, then click Print.
• For Macintosh, click Print.

Releasing a Secure Print job
1. At the printer control panel, press the Home button.

2. Touch Jobs.

3. To view Secure Print jobs, touch Secure Jobs.
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4. Do one of the following:
• If you submitted a single Secure Print job, touch the folder, then touch the job. Enter the

passcode number, then touch OK. The job prints automatically.
• If you submitted multiple Secure Print jobs, touch the folder, enter the passcode number, then

touch OK. Select an option:

• To print a single Secure Print job, touch the job required.

• To print all the jobs in the folder, touch Print All.

• To delete a single Secure Print job, touch the Trash icon. At the prompt, touch Delete.

• To delete all the jobs in the folder, touch Delete All.

Note: After a Secure Print job prints, the printer deletes it automatically.

5. To return to the Home screen, press the Home button.

SSaammppllee SSeett
The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining
copies. After reviewing the sample set, you can either print the remaining copies or delete them at
the printer control panel.

Sample Set is a type of saved job with these features:

• A Sample Set job appears in a folder named after the user ID associated with the print job.

• A Sample Set job does not use a passcode.

• Any user can print or delete a Sample Set job.

• A Sample Set prints one copy of a job to allow you to proofread the job before printing any
remaining copies.

After a Sample Set job is printed, it is deleted automatically.

To print a Sample Set, refer to Printing using Sample Set.

Printing using Sample Set
1. In your software application, access the print settings. For most software applications, press CTRL

+P for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
• For Windows, click Printer Properties. Depending on your application, the title of the button

varies.
• For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Sample Set.

4. Select any other required printing options.
• For Windows, click OK, then click Print.
• For Macintosh, click Print.

Releasing a Sample Set
1. At the printer control panel, press the Home button.

2. To view available jobs, touch Jobs.
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3. Touch the Sample Set job.

Note: The Sample Set file description shows the job as Held for Future Printing, and shows
the number of remaining copies of the job.

4. Select an option.
• To print the remaining copies of the job, touch Release.
• To delete the remaining copies of the job, touch Delete.

5. To return to the Home screen, press the Home button.

MMaannaaggiinngg JJoobbss uussiinngg tthhee EEmmbbeeddddeedd WWeebb SSeerrvveerr
In the Embedded Web Server Active Jobs list, you can view a list of active jobs and delete print jobs.
You can use the Embedded Web Server to submit jobs for printing at the device. You can use the Job
Submission feature to print .ps, .pdf, .pcl, and .xps files without installing a print driver. You can select
jobs for printing from your local computer hard drive, mass storage devices, or a network drive.

Saved jobs are documents sent to the printer and stored there for future use. Any saved jobs appear
on the Saved Jobs page. Use the Saved Jobs page to view, print, and delete saved jobs, and create
and manage folders in which they are stored.

To manage jobs using the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

2. In the Embedded Web Server, click Jobs.

3. Click the job name.

4. From the menu, select an option.

• To pause the print job, click Pause, then click Go.

• To delete the print job, click Delete, then click Go. At the prompt, click OK.

5. To return to the Home screen, click Home.

SSuubbmmiittttiinngg JJoobbss ffoorr PPrriinnttiinngg uussiinngg tthhee EEmmbbeeddddeedd WWeebb SSeerrvveerr
1. At your computer, open a Web browser. In the address field, type the IP address of the printer,

then press Enter or Return.

2. In the Embedded Web Server, click Home.

3. Click Print.

4. For File Name, click Browse or Choose File, then do one of the following steps.
• Navigate to the file, then select it.
• Type the path to the file that you want to select.

5. In the Printing area, for Copies, select Auto, or enter the number of copies to print.
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6. For Job Type, select an option:
• Normal Print: This option prints a job immediately.
• Secure Print: This option prints a job after you enter your passcode at the printer control

panel.
• Sample Set or Proof Print: These options print one copy of a multiple-copy print job. The

device holds the remaining copies in memory until you release them for printing at the control
panel.

• Save Job for Reprint: This option saves a print job in a folder on the print server for future
printing. You can specify a job name and folder.

• Delay Print: This option prints a job at a specified time up to 24 hours from the original job
submission.

7. As needed, for Paper Selection, select paper size, color, type, and tray.

8. As needed, select job options.
• 2-Sided Printing
• Collate
• Orientation
• Staple
• Folding
• Output Destination

Note: The available options vary by device.

9. If Accounting is enabled, enter your User ID and Account ID.

10. Click Submit Job.

RReepprriinnttiinngg SSaavveedd JJoobbss uussiinngg tthhee EEmmbbeeddddeedd WWeebb SSeerrvveerr
1. At your computer, open a Web browser. In the address field, type the IP address of the printer,

then press Enter or Return.

2. In the Embedded Web Server, click Home.

3. Click Jobs.

4. Click the Saved Jobs tab.

5. For the job that you want to process, select the check box.

6. From the menu, select an option.
• Print Job: This option prints a job immediately.
• Delete Job This option deletes the saved job.
• Move Job: Use this option to move the job to another folder location.
• Copy Job: Use this option to duplicate the job.

7. Click Go.
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Copy

CCooppyy OOvveerrvviieeww

To make a copy, the device scans your original documents and temporarily
stores the images. It then prints the images based on the options that you
selected. You can change settings for individual jobs based on the original
documents. You can save settings that you use for regular jobs and retrieve
them for later use.

For details on configuring and customizing the Apps, refer to the System Administrator Guide at www.
xerox.com/office/ALC81XXdocs.

If Authentication or Accounting is enabled on your device, to access Copy features, enter your login
details.

For information about all the App features and available settings, refer to Apps Features.
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MMaakkiinngg aa CCooppyy
To make a copy:

1. Load your original documents.
• For single pages or paper that cannot be fed using the duplex automatic document feeder,

use the document glass. Lift the duplex automatic document feeder, then place the original
document face down in the upper-left corner of the document glass.

• For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any
staples and paper clips from the pages. Insert the original documents face up in the duplex
automatic document feeder, with the top of the page entering the feeder first. Adjust the
paper guides so that they fit against the original documents.

Note:When the original documents are detected, the automatic document feeder
confirmation indicator LED illuminates.

2. At the printer control panel, press the Home button.

3. Touch Copy.

Note:When the Color Preset Screen setting is enabled, a color preset screen appears each
time you access the Copy App. At the Make All My Copies screen, select a color printing
option for your copy jobs.
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4. To clear previous app settings, touch Reset.

5. To enter the number of copies needed, use the numeric keypad.

6. Adjust copy settings as needed.
• To scan more documents using the document glass, or to change settings for different

sections of the job, touch Build Job.
• If you are scanning from 2-sided original documents, touch 2-Sided Copying, then select an

option.

For details about available features, refer to Apps Features.

7. Touch Start. If you placed documents in the feeder, scanning continues until the feeder is empty.

8. If Build Job is enabled, touch Scan, then, when prompted, do these steps:
• To change settings, touch Program Next Segment.
• To scan another page, touch Scan Next Segment.
• To finish, touch Submit.

9. To return to the Home screen, press the Home button.

CCooppyy WWoorrkkfflloowwss
Note: Some features are hidden from view when the Copy App is installed. For details on configuring
and customizing the Apps, refer to the System Administrator Guide at www.xerox.com/office/
ALC81XXdocs.

AAddjjuussttiinngg CCoolloorr SSeettttiinnggss
Before you print a copy of a color original image, you can adjust the balance of the printing colors
between cyan, magenta, yellow, and black. You can adjust the color of the copy using preset color
effects. For example, you can adjust colors for brightness or coolness. Adjusting the saturation makes
the image colors more vivid or pastel.

Note:When the Color Preset Screen setting is enabled, a color preset screen appears each time
you access the Copy App. At the Make All My Copies screen, select a color printing option for
your copy jobs.

Select color or black and white output
1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Output Color.
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4. For Output Color, touch an option.
• Auto Detect: The device detects the color content in the original document. If the original

content is a color document, the printer makes copies in full color. If the original content is a
black and white document, the printer makes copies in black only.

• Black & White: This option produces copies in black and white only. Colors in the original
content are converted to shades of gray.

• Color: This option copies in full color output using all four printing colors, cyan, magenta,
yellow, and black.

• To access the Single Color option, touchMore.

Single Color produces shades of a single color. To select a color, touch Color, then select an
option. Your color selection appears on the sample page.

5. Touch OK.

Adjusting the Color Balance
1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Color Balance.

Note: This feature is not available when Output Color is set to Black and White.

4. To adjust the density levels of all four colors:

a. On the Color Balance screen, touch Basic Color.

b. Move the sliders to adjust the level for each color.

5. To adjust the highlight, midtone, and shadow density levels by color:

a. On the Color Balance screen, touch Advanced Color.

b. Touch the color you want to adjust.

c. Move the sliders to adjust the levels for highlights, midtones, and shadows.

d. To adjust more colors, repeat the previous two steps.

6. Touch OK.

Adding color effects
1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Color Presets.

Note: This feature is not available when Output Color is set to Black and White.

4. On the Color Presets screen, touch the required preset color effect. The sample images show how
the colors are adjusted.

5. Touch OK.

Adjusting the Saturation
1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Saturation.
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4. To adjust the saturation, move the slider.

5. Touch OK.

EErraassiinngg tthhee EEddggeess ooff CCooppiieess
You can erase content from the edges of your copies using the Edge Erase feature. You can specify
the amount to erase on the right, left, top, and bottom edges.

To erase the edges of copies:

1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Edge Erase.

4. Select one of the following options.
• All Edges: This option erases all four edges by the same amount. To adjust the amount to

erase, move the slider.
• Individual Edges: This option allows you to specify different amounts to erase from the

edges. Touch the required Top, Bottom, Left or Right field. To enter the amount to erase, use
the numeric keypad, or touch the arrows.

5. To mirror the same erase amount applied to Side 1 on Side 2, touch theMirror Side 1 check box.

6. To select a pre-defined amount of erase, use the Presets option.

7. Touch OK.

SSppeecciiffyyiinngg tthhee SSiizzee ooff tthhee OOrriiggiinnaall
Use the Original Size feature to set a standard or custom size for scanning, or for the printer to
determine the original size document automatically. You can use this feature to enable mixed-size
original document scanning.

To specify the original size:

1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Original Size.

4. Select an option.
• Auto Detect: This option allows the printer to determine the size of the original document.
• Preset Scan Area: This option specifies the area to scan when it matches a standard paper

size. In the scrolling list, touch the desired paper size.
• Custom Scan Area: You can specify the width and length of the area to scan. To specify the

original width or length, touch the appropriate field. To enter the size, use the numeric
keypad, or use the arrows.

• Mixed Size Originals: You can scan standard-size originals of varying sizes. To determine
which original sizes can be mixed in the same job, use the diagram on the screen.

5. Touch OK.
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SShhiiffttiinngg tthhee IImmaaggee
You can change the placement of an image on the copy page. This is useful if the image is smaller
than the page size. For image shift to work correctly, position original documents as follows.

• Document Feeder: Position original documents face up, long edge entering the feeder first.

• Document Glass: Position original documents face down, in the upper-left corner of the document
glass, long edge to the left.

To change the placement of the image:

1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Image Shift.

4. Select one of the following options.
• Off: This option is the default setting.
• Auto Center: This option centers the image on the page.

5. To enter a specific amount of image shift, touchMore, then touchMargin Shift. Touch the
required Up / Down or Left / Right fields. To enter the amount of shift, use the numeric keypad,
or touch the arrows.

6. To mirror the same image shift applied to Side 1 on Side 2, touch theMirror Side 1 check box.

7. To select a pre-defined amount of shift, use the Presets option.

8. Touch OK.

BBooookk CCooppyyiinngg
You can use the Book Copying feature to copy books, magazines, or other bound documents. You can
use this feature to copy images for different results.

You can copy either the left or right page onto a single sheet of paper. You can copy both the left and
right pages onto two sheets of paper.

Note: Use the document glass to make copies from books, magazines, or other bound
documents. Do not place bound originals in the document feeder.

To set up book copying:

1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Book Copying.

4. Select one of the following options.
• Off: This option is the default setting.
• Both Pages: This option scans both pages of an open book onto two sheets of paper.
• Left/Right Page Only: This option scans the left or right page of an open book onto a single

sheet of paper.

5. If Binding Edge Erase is required, touchMore. Touch the Binding Edge Erase field. To enter the
amount to erase, use the numeric keypad, or touch the arrows. You can erase up to 50 mm (2 in.)
from both pages, or 25 mm (1 in.) from one page.

6. Touch OK.
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CCrreeaattiinngg aa BBooookklleett
The Booklet Creation feature prints two pages on each side of the paper. The printer reorders and
reorients the pages so that they are in the correct order and orientation when folded. If more
finishing options are available, the pages can be stapled and folded to create a booklet.

To create a booklet:

Note: In this mode, the printer scans all the original documents before it prints the copies.

1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Booklet Creation.

4. Select one of the following options.
• Off: This option is the default setting.
• On: This option enables Booklet Creation.

Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select
the required paper tray, then touch OK.

5. To change the Original Input, Paper Supply or finishing options, touchMore, then select an
option.
• To scan 1 or 2-sided originals, touch Original Input, then select an option.
• To change the paper source for the booklet, touch Paper Supply, then select an option.
• If your printer has a finisher installed, for Fold & Staple, select a staple or fold option.

6. Touch OK.

AAddddiinngg CCoovveerrss
You can print the first and last pages of your copy job on different paper, such as colored or
heavyweight paper. The printer selects the paper from a different tray. The covers can be blank or
printed.

To add covers to your copy job:

1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Special Pages→Covers.

Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select
the required paper tray, then touch OK.

4. For Covers Options, select an option.
• Front & Back Same: This option includes front and back covers from the same tray.
• Front & Back Different: This option includes a front and a back cover from different trays.
• Front Only: This option includes a front cover only.
• Back Only: This option includes a back cover only.
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5. For Printing Options, select an option.
• Blank Cover: This option inserts a blank cover.
• Print on Side 1 Only: This option prints on the front side of the cover only. To rotate the

image on side 2 by 180degrees, touch Rotate Side 2.
• Print on Side 2 Only: This option prints on the back of the cover only. To rotate the image on

side 2 by 180degrees, touch Rotate Side 2.
• Print on Both Sides: This option prints on both sides of the cover.
• Rotate Side 2: If covers are 2-Sided, touch this option to rotate the image on side 2 by 180

degrees.

6. For Paper Supply, touch the required tray.

7. Touch OK. The options that you selected appear on the Special Pages screen.

8. To edit or delete a special page entry, touch the entry in the list. From the menu, touch the
required option.

9. Touch OK.

AAddddiinngg IInnsseerrttss
You can insert blank pages or pre-printed sheets in specific locations in your copy job. To do this, you
specify the tray that contains the inserts.

To add inserts to a copy job:

1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Special PagesInserts.

Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select
the required paper tray, then touch OK.

4. To specify the number of sheets to insert, touch the Insert Quantity field. To enter the number of
sheets, use the numeric keypad, or use the arrows. Touch Enter.

5. To enter a location for the insert, touch the Insert After Page entry box. To enter a page number,
use the numeric keypad. Touch Enter.

6. To specify the paper tray to use for the insert:

a. Touch Paper Supply.

b. Touch the required paper tray.

c. Touch OK.

7. Touch Add. The insert appears in the list on the Inserts screen. To add more inserts, repeat the
previous steps.

8. Touch X. The options that you selected appear on the Special Pages screen.

9. To edit or delete a special-page entry, touch the entry in the list. From the menu, touch the
required option.

10. Touch OK.
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SSppeecciiffyyiinngg CChhaapptteerr SSttaarrtt PPaaggiinnaattiioonn
If you select 2-sided copies, you can set each chapter to start on the front or back of the page. If
necessary, the printer leaves one side of the paper blank so that the chapter starts on the specified
side of the paper.

To specify chapter start pagination:

1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Special Pages→Chapter Starts.

4. To specify the chapter start page, touch Page Number. To enter the page number, use the
numeric keypad. Touch Enter.

5. For Start Chapter, select an option.
• On Right Page: This option specifies the front of the paper.
• On Left Page: This option specifies the back of the paper.

6. Touch Add. The page is added to the list on the right side of the screen.

7. To set other pages, repeat the previous steps.

8. Touch X. The options that you selected appear on the Special Pages screen.

9. To edit or delete a special-page entry, touch the entry in the list. From the menu, touch the
required option.

10. Touch OK.

SSppeecciiffyyiinngg EExxcceeppttiioonn PPaaggeess
You can specify exception pages to print on paper that is loaded in a different paper tray than the
paper for the rest of the document. Ensure that the paper you use for the exception pages is the
same size as the paper that you use for the rest of the document.

To specify the exception pages:

1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Special Pages→Exceptions.

Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select
the required paper tray, then touch OK.

4. To enter the range of pages to print on different paper:
• To enter the starting page number, touch the first Page Number field. To enter the starting

page number, use the numeric keypad. Touch Enter.
• To enter the ending page number, touch the second Page Number field. To enter the last

page number, use the numeric keypad. Touch Enter.

Note: To specify a single page as an exception, enter that page number as the start and
end of the range.

5. To specify the paper to use for the exception pages:

a. Touch Paper Supply.

b. Touch the tray that contains paper to use for the exception pages.
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c. Touch OK.

6. Touch Add. The page range is added to the list on the right side of the screen.

7. To set other pages, repeat the previous steps.

8. Touch X. The options that you selected appear on the Special Pages screen.

9. To edit or delete a special-page entry, touch the entry in the list. From the menu, touch the
required option.

10. Touch OK.

AAddddiinngg AAnnnnoottaattiioonnss
You can automatically add annotations such as page numbers and the date to your copies.

Note:

• You cannot add annotations to covers, inserts, or blank chapter-start pages.

• If Booklet Creation is selected, you cannot add annotations.

To add annotations:

1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Annotations.

4. To add page numbers:

a. Touch Page Number.

b. Touch On.

c. Touch the Starting Page Number entry box. To enter a page number, use the numeric
keypad, then touch Enter.

d. Touch Apply To, then select an option.

e. To position the page number, touch an arrow. The sample page shows the location of the
page number.

f. Touch OK.

5. To insert a comment:

a. Touch Comment.

b. Touch On.

c. For Stored Comments, touch an option in the list.

• Touch an existing comment.

• To create a comment, touch an Available option. To enter the annotation text, use the
touch screen keypad, then touch OK.

• To edit or delete a comment, use the buttons below the Stored Comments list.

d. Touch Apply To, then select an option.

e. To position the comment, touch an arrow. The sample page shows the location of the
comment.
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f. Touch OK.

6. To insert the current date:

a. Touch the desired current date location.

b. Touch Date.

c. Touch On, then touch the date format that you wish to use.

d. Touch Apply To, then select an option.

e. To position the date in the header or footer, touch an arrow. The sample page shows the
location of the date.

f. Touch OK.

7. To insert a Bates Stamp:

a. Touch Bates Stamp.

b. Touch On.

c. For Stored Prefixes, touch an option in the list.

• Touch an existing prefix.

• To create a prefix, touch an Available option. To enter text, use the touch keypad, then
touch OK.

• To edit or delete a prefix, use the buttons below the Stored Prefixes list.

d. Touch Starting Page Number. To enter the starting page number, use the alphanumeric
keypad. You can use leading zeros to indicate the number of digits required. Touch Enter.

e. Touch Apply To, then select an option.

f. To position the Bates Stamp in the header or footer, touch an arrow. The sample page shows
the location of the Bates Stamp.

g. Touch OK.

8. To change the text formatting, touch Format & Style, choose the required settings, then touch
OK.

9. To remove all entered annotations, touch Delete All.

10. Touch OK.

CChhaannggiinngg tthhee PPaaggee LLaayyoouutt
You can use Page Layout to place a defined number of pages on one or both sides of the paper.

To change the page layout:

1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Page Layout.
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4. Select one of the following options.
• Pages per Side: This option places a defined number of pages on one or both sides of the

paper. Select the required number of pages per side.
• Repeat Image: This option places a defined number of the same image on one or both sides

of the paper. Select the number of images required. Auto Repeat allows the printer to
determine the maximum number of images that can fit on the currently selected paper size.

5. To enter a specific number of rows and columns, touch Specify Rows & Columns. Touch the Rows
or Columns field. To enter the number of rows and columns, use the numeric keypad, or touch the
arrows. To rotate the paper, select the check box for Rotate Background.

6. To change the original orientation, touch Original Orientation. Select Portrait or Landscape.

7. Touch OK.

BBuuiillddiinngg aa CCooppyy JJoobb
Use this feature to produce complex jobs that include a variety of originals requiring different App
settings. Each segment of the job can have different settings. After all the segments are programmed,
scanned, and temporarily stored in the printer, the job is processed and completed.

To build a job:

1. At the printer control panel, press the Home button.

2. Touch Copy.

3. To clear previous App settings, touch Reset.

4. Touch Build Job.

5. Split the job into the required segments for scanning.

6. Program and scan the first segment:

a. Load the original document for the first segment.

b. Select the options required for the segment.

c. Touch Scan.

7. Set the required build job display options.

8. Print a Sample segment or delete a segment.

a. To print a sample of the previous segment scanned, touch the segments option, then touch
Sample Last segment.

b. To delete the previous segment scanned, touch the segments option, then touch Delete Last
Segment.

c. To delete all the previous segment scanned, touch the segments option, then touch Delete
All Segments.

9. Program and scan more segments.

a. Load the originals for the next segment.

b. To change the settings for the next segment, touch Program Next Segment, then select the
options required for the segment.

c. Touch Scan Next Segment.
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10. Continue scanning segments until all original documents are scanned.

11. Touch Submit.

PPrriinnttiinngg aa SSaammppllee JJoobb
Sample Job allows you to print a test copy of a job to inspect before printing multiple copies. This
feature is useful for complex or high-volume jobs. After you print and inspect the test copy, you can
choose to print or cancel the remaining copies.

To print a sample copy of your job:

1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Adjust the copy settings as needed.

4. Enter the number of copies needed.

5. Touch the Sample Job toggle button.

6. Touch the Start button. The sample job prints.

7. Inspect the sample job, then select one of the following options:
• If the copy is unsatisfactory, touch Delete. Touch Delete to confirm. The job is canceled and

no more copies are printed.
• If the copy is satisfactory, touch Print. The remaining copies are printed.

8. To return to the home screen, press the Home button.

SSaavviinngg CCuurrrreenntt CCooppyy SSeettttiinnggss
To use a particular combination of copy settings for future copy jobs, you can save the settings with a
name and retrieve them for later use.

To save the current copy settings:

1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Change the settings required.

4. Touch Save Current Settings.

5. To create a new saved setting, touch any option labeled <Available>.

6. Enter a name for the saved setting using the touch screen keyboard, then touch OK.

RReettrriieevviinngg SSaavveedd CCooppyy SSeettttiinnggss
You can retrieve and use any previously saved copy settings for current jobs.

Note: To save the copy settings with a name, refer to Saving Current Copy Settings.

To retrieve saved settings:

1. At the printer control panel, press the Home button.

2. Touch Copy.
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3. Touch Retrieve Saved Settings.

4. Touch the saved setting required.

Note: To delete a saved setting, touch the setting, then touch Delete Settings. Touch
Delete to confirm.

5. Touch OK. The saved settings are loaded for the current copy job.
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ID Card Copy

IIDD CCaarrdd CCooppyy OOvveerrvviieeww

You can use the ID Card Copy App to copy both sides of an ID card or small
document onto one side of paper. To copy the card properly, place each side
in the upper-left corner of the document glass. The printer stores both sides
of the document, then prints them side by side on the paper.

The ID Card Copy App is hidden from view on initial device setup. For details about configuring and
customizing the Apps, refer to the System Administrator Guide at www.xerox.com/office/
ALC81XXdocs.

For information about all the App features and available settings, refer to Apps Features.

CCooppyyiinngg aann IIDD CCaarrdd
To copy an ID card:

1. Lift the document feeder, then place the original document in the upper-left corner of the
document glass.

2. At the printer control panel, press the Home button.

3. Touch ID Card Copy.

4. To clear previous App settings, touch Reset.

5. Adjust the settings as required.

6. Touch Scan Front.

7. When scanning is finished, lift the document feeder. Place the second side of the original
document in the upper-left corner of the document glass.

8. To scan the second side of the original document and print the copies, touch Scan Back.

9. To return to the home screen, press the Home button.
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Email
EEmmaaiill OOvveerrvviieeww

You can use the Email App to scan images and attach them to emails. You
can specify the file name and format of the attachment, and include a
subject heading and message for the email.

For details about configuring and customizing the Apps, refer to the System Administrator Guide at
www.xerox.com/office/ALC81XXdocs.

For information about all the App features and available settings, refer to Apps Features.
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SSeennddiinngg aa SSccaannnneedd IImmaaggee iinn aann EEmmaaiill
To send a scanned image in an email:

1. Load your original documents.
• For single pages or paper that cannot be fed using the duplex automatic document feeder,

use the document glass. Lift the duplex automatic document feeder, then place the original
document face down in the upper-left corner of the document glass.

• For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove all
staples and paper clips from the pages. Insert the original documents face up in the duplex
automatic document feeder, with the top of the page entering the feeder first. Adjust the
paper guides so that they fit against the original documents.

Note:When the original documents are detected, the automatic document feeder
confirmation indicator LED illuminates.

2. At the printer control panel, press the Home button.

3. Touch Email.

4. To clear previous app settings, touch Reset.
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5. Enter recipients.
• If the entry screen appears, to enter a recipient, touch an option, or touch X.
• To select a contact or group from the Address Book, touch Device Address Book. Touch

Favorites or Contacts, then select a recipient. Touch OK.
• To select a contact from the Network Address Book, touch Network Address Book. Enter a

name, touch Search, then select a recipient. Touch OK.
• To enter the email address manually, touchManual Entry. In the Enter Email Address field,

enter the email address, then touch Add.
• To add your own email address to the recipient list, touch Add Me. If necessary, enter your

login details.
• To add more recipients, touch Add Recipient, then repeat the procedure.

Note: The choices available for adding recipients depends on system configuration.

6. To organize the recipients, touch one of the recipient names on the list. From the menu, select
To:, Cc:, or Bcc:.

7. Adjust the email settings as needed.
• To change the subject, touch Subject, enter a new subject, then touch OK.
• To save the scanned document as a specific file name, touch the attachment file name, enter

a new name, then touch OK.
• To save the scanned document as a specific file format, touch the attachment file format,

then select the required format. To create a searchable file or to add password protection,
from the file format menu, selectMore.

• To change the email message, touchMessage, enter a new message, then touch OK.
• To scan more documents using the document glass, or to change settings for different

sections of the job, touch Build Job.
• If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an

option.

For details about available features, refer to Apps Features.

8. To start the scan, touch Send.

9. If Build Job is enabled, touch Scan, then, when prompted, do these steps.
• To change settings, touch Program Next Segment.
• To scan another page, touch Scan Next Segment.
• To finish, touch Submit.

10. To return to the Home screen, press the Home button.

PPrreevviieewwiinngg JJoobbss
Use the Preview option to view and verify scanned images.

1. At the printer control panel, press the Home button.

2. To clear previous app settings, touch Reset.

3. Load your original documents.
• For single pages or paper that cannot be fed using the duplex automatic document feeder,

use the document glass. Lift the duplex automatic document feeder, then place the original
document face down in the upper-left corner of the document glass.

• For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove all
staples and paper clips from the pages. Insert the original documents face up in the duplex
automatic document feeder, with the top of the page entering the feeder first. Adjust the
paper guides so that they fit against the original documents.

108 Xerox® AltaLink® C81XX Series Color Multifunction Printer
User Guide

Xerox® Apps



4. Touch the app required, then select the job settings.

5. To enable preview, touch Preview.

6. If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an
option.

7. To start scanning, touch Preview.

The original documents are scanned, then preview images appear on the device user interface.

8. Scroll through and verify the preview images.
• To change the size of the preview image thumbnails, in the bottom-left corner, touch the

large or small thumbnail view options.
• To zoom in on an image, tap the image twice.
• To zoom out, tap the image twice.

9. To scan more original documents:

a. Load your original documents in the document feeder, or place a single document on the
document glass.

b. Swipe to scroll to the end of the thumbnail images, then touch Scan More (+).

c. If you are using the document glass, touch the original document size, then touch OK.

The original documents are scanned and new preview images appear on the user interface.

d. Continue this procedure until you have scanned all the original documents.

10. To process the job and send the scanned images, touch Submit. To discard the job, touch X, then
touch Delete and Close.

11. To return to the Home screen, press the Home button.

AAddddiinngg oorr EEddiittiinngg CCoonnttaaccttss iinn tthhee DDeevviiccee AAddddrreessss
BBooookk ffrroomm tthhee CCoonnttrrooll PPaanneell
You can set up the Device Address Book using the Embedded Web Server. The Address Book can
contain up to 5000 contacts that you can access when you enter recipients or destinations using
apps.

To add or edit contacts in the Device Address Book from the control panel:

Note: Before you can use this feature, the system administrator must enable Create/Edit
Contact from Touch Screen for All Users.

1. Load your original documents.

2. At the printer control panel, press the Home button.

3. Touch Email.

4. To clear previous App settings, touch Reset.

5. TouchManual Entry. To enter an email address, use the touch screen keypad.

6. To add the recipient to the Device Address Book, touch the Address Book icon.
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7. Do one of the following steps.
• To create an entry, touch Create New Contact. To enter contact details, touch a field, then

use the touch screen keypad. Touch OK.
• To add to an existing entry, touch Add to Existing Contact. In the list, touch a contact. To

find a contact, touch Search.

8. To mark a recipient to appear as a favorite option, touch the Star icon.

9. Adjust the email settings as needed.

10. To start the scan, touch Send.

11. To return to the Home screen, press the Home button.
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Workflow Scanning

WWoorrkkffllooww SSccaannnniinngg OOvveerrvviieeww

The Workflow Scanning App allows you to scan an original document,
distribute, and archive the scanned image file. The Workflow Scanning
feature simplifies the task of scanning many multi-page documents and
saving the scanned image files in one or more file locations.

Note: The system administrator must set up this feature before you can use it. For details, refer
to the System Administrator Guide at www.xerox.com/office/ALC81XXdocs.

The Workflow Scanning App enables you to scan documents using pre-defined settings to a range of
file destinations quickly and easily. There are several workflow options:

• Distribution workflows enable you to scan documents to one or more file destinations. File
destinations include an FTP site, a website, and a network server. You can add fax destinations to
workflows too.

• Scan to Mailbox enables you to scan documents to public or private mailbox folders on the printer
hard drive.

• Scan to Home enables you to scan documents to a personal Home folder on your network.

• Scan to USB enables you to scan documents to a connected USB Flash drive.

Note:

• To scan original documents to a file destination associated with a contact in the address
book, refer to Scan To.

• To scan original documents to an email address, refer to Email.

For information about all the App features and available settings, refer to Apps Features.
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UUssiinngg WWoorrkkffllooww SSccaannnniinngg
To scan an original document:

1. Load your original documents.
• For single pages or paper that cannot be fed using the duplex automatic document feeder,

use the document glass. Lift the duplex automatic document feeder, then place the original
document face down in the upper-left corner of the document glass.

• For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any
staples and paper clips from the pages. Insert the original documents face up in the duplex
automatic document feeder, with the top of the page entering the feeder first. Adjust the
paper guides so that they fit against the original documents.

Note:When the original documents are detected, the automatic document feeder
confirmation indicator LED illuminates.

2. At the printer control panel, press the Home button.

3. TouchWorkflow Scanning.

4. To clear previous app settings, touch Reset.
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5. To select a workflow, from the Pick a Workflow screen, touch an option. If necessary, to refresh
the workflow list, touch Update.

Note: If the Pick a Workflow screen does not appear automatically, to display the screen,
touch Change Workflow.

6. If needed, enter recipients, workflow destination details, or browse to the location required for the
scanned documents.

7. To add a file destination, touch Add File Destinations. From the list, select a file destination.

Note: You can add file destinations to a workflow from the predefined list of file repository
settings.

• In the Embedded Web Server, to create a new workflow, you can add file destinations
from the predefined list.

• In the Workflow Scanning App, for a selected workflow, you can add more file
destinations from the predefined list.

For details, refer to the System Administrator Guide at www.xerox.com/office/ALC81XXdocs.

8. Adjust the workflow scanning settings as needed.
• To save the scanned document as a specific file name, touch the attachment file name, enter

a new name, then touch OK.
• To save the scanned document as a specific file format, touch the attachment file format,

then select the required format.
• To define what action the device takes when the filename is used already, touch If File

Already Exists. Select an option, then touch OK.

Note: If the Add to pdf folder option is not available, access the Embedded Web Server,
then enable the Filing Option settings. For details, refer to the System Administrator
Guide at www.xerox.com/office/ALC81XXdocs.

• If you are using the document glass, to combine pages into a single scan file, enable the Build
Job feature. To enable the feature, touch the toggle button for Build Job.

• If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an
option.

For details about available features, refer to Apps Features.

9. To start the scan, touch Scan.

10. If Build Job is enabled, when prompted, do these steps:
• To change settings, touch Program Next Segment.
• To scan another page, touch Scan Next Segment.
• To finish, touch Submit.

11. To return to the Home screen, press the Home button.

Note:

• For remote scanning, a network connection is required.

• For details about remote scanning, refer to the Help in the Embedded Web Server.

• Print, copy, and fax jobs can print while you are scanning original documents or
downloading files from the printer hard drive.
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DDiissttrriibbuuttiioonn WWoorrkkfflloowwss
Distribution Workflows are customized workflows used in the Workflow Scanning App. A workflow
contains pre-programmed settings for a scan job that specify how and where scanned documents are
distributed. A workflow can include one or more file destinations, as well as fax destinations. You can
store customized scan settings in each workflow.

Using the Embedded Web Server, you can create a workflow using one or more scan destinations. The
following options are available:

• Predefined scan destinations from the list of file repositories.

• New scan destinations such as an FTP site, a website, or an SMB server.

• Fax number destinations.

When you create a workflow, it appears in the list of workflows in the Pick a Workflow screen of the
Workflow Scanning App.

At the printer control panel, when you select a workflow, you can change the scan settings and add
more scan destinations from the predefined list.

Predefined Network File Repositories
A file repository is a predefined file destination that you can use in a workflow. You can use the
printer control panel to add a file repository to a workflow.

The system administrator configures the file repositories available as predefined scanned file
destinations. At least one repository must be set up for the Workflow Scanning feature to be
available. For details, refer to the System Administrator Guide at www.xerox.com/office/ALC81XXdocs.

Note: On the Pick a Workflow screen, the DEFAULT workflow is associated with the default file
repository.

Creating a New Workflow
1. At your computer, open a Web browser, in the address field, type the IP address of the printer,

then press Enter or Return.

Note: For details about obtaining the IP address of your printer, refer to Finding the IP
Address of Your Printer.

2. Click the Scan tab.

3. In the Display area, selectWorkflows, then select Create New Workflow.

4. For Add Destination to Workflow, select an option:
• To add an existing file destination to the workflow, select Select from a Predefined List.
• To add a file destination to the workflow, select Enter a Scan Destination.
• To add a fax destination to the workflow, select Enter a Server Fax Number.

5. For Select from a Predefined List, select a destination from the File Destination list, then click Add.

6. For Enter a Scan Destination, add these details:

a. Click the Friendly Name field, then enter a name for the scan destination.

b. For Protocol, select an option, then enter the destination address.

• For IP Address, enter the IP Address: Port number.

• For Host Name, enter the Host Name: Port number.
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c. Enter the name of the destination folder as needed. In SMB, the destination folder is the
shared folder.

d. In Document Path, enter the name of the subfolder within the destination folder. Select a
Filing Policy.

e. Enter a valid login name and password.

Note: Use the login name for the computer that holds the destination folder. The login
name can include the domain name, such as domain name\login name.

7. Click Add.

8. To add another destination to the workflow:
• To add a file destination, for File Destinations, click Add.
• To add a fax destination, for Fax Destinations, click Add.

9. Set the scan settings for the workflow as required.

After a workflow is created in the Embedded Web Server, the workflow is added to the list in the
Workflow Scanning App.

SSccaannnniinngg ttoo aa SShhaarreedd NNeettwwoorrkk FFoollddeerr
You can scan to a shared folder on a network using SMB. The folder can be on a server or computer
running SMB services.

To scan to a shared network folder, create a shared folder with read and write access privileges.

Sharing a Folder on a Windows Computer
1. Open Windows Explorer.

2. Right-click the folder you want to share, then select Properties.

3. Click the Sharing tab, then click Advanced Sharing.

4. Select Share this folder.

5. Click Permissions.

6. Select the Everyone group, then verify that all permissions are enabled.

7. Click OK.

Note: Remember the Share name for later use.

8. Click OK again.

9. Click Close.

Sharing a Folder in Macintosh OS X Version 10.7 and Later
1. From the Apple menu, select System Preferences.

2. From the System Preferences window, select Sharing, then select File Sharing.

3. Under Shared Folders, click the Plus icon ( +). Browse to the folder that you want to share on the
network, then click Add.

4. To modify access rights for your folder, select the folder. The groups activate.

5. From the Users list, click Everyone, then use the arrows to select Read & Write.
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6. Click Options, then select a share-folder option.
• To share the folder, select Share files and folders using SMB.
• To share the folder with specific users, next to the user name, select On.

7. Click Done.

8. Close the System Preferences window.

Note:When you open a shared folder, a Shared Folder banner appears in the Finder for the
folder and subfolders.

SSccaannnniinngg ttoo aa MMaaiillbbooxx FFoollddeerr
Scanning to a folder is the simplest scanning method. This function allows users to scan files to
mailboxes, which are folders created on the printer hard drive. When you scan an image at the
printer, the scan file is stored in a folder on the internal hard drive. You can use the Embedded Web
Server to retrieve the stored scan file to save to your computer.

The default settings create a 1-sided, color, portable document format .pdf file. You can change the
default settings using the printer control panel, or using the Embedded Web Server at your computer.
Control panel selections override the settings in the Embedded Web Server.

Scanning to the Public Mailbox Folder
The printer provides a public mailbox folder to store scanned images. You do not need a password to
scan images to the public mailbox folder, or to retrieve the scanned images. All users can view
scanned documents in the public mailbox folder. You can create a password-protected private
mailbox folder. For details, refer to Creating a Private Mailbox Folder.

To scan an image to the public mailbox folder:

1. Load your original documents.

2. At the printer control panel, press the Home button.

3. TouchWorkflow Scanning.

4. To select a workflow, from the Pick a Workflow screen, touch Default Public Mailbox.

Note: If the Pick a Workflow screen is not automatically displayed, to display it, touch
Change Workflow.

5. To add a file destination, touch Add File Destinations, then select a file destination from the list.

6. Adjust the workflow scanning settings as needed.
• To save the scanned document as a specific file name, touch the attachment file name, enter

a new name, then touch OK.
• To save the scanned document as a specific file format, touch the attachment file format,

then select the required format.
• If you are using the document glass, to combine pages into a single scan file, enable Build

Job.
• If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an

option.

For details about available features, refer to Apps Features.

7. To start the scan, touch Scan. The Job Progress screen appears, and the original document is
scanned. The printer stores the scanned image on the printer hard drive.
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8. If Build Job is enabled, when prompted, do these steps.
• To change settings, touch Program Next Segment.
• To scan another page, touch Scan Next Segment.
• To finish, touch Submit.

9. To move the file to your computer, use the Embedded Web Server. For details, refer to Retrieving
Scan Files from a Mailbox Folder.

Scanning to a Private Mailbox Folder
This feature allows you to scan documents to a private mailbox folder. Private mailbox folders can
require a password.

You can use the Embedded Web Server to create your private mailbox folders. For details, refer to
Creating a Private Mailbox Folder.

To scan to a private mailbox folder:

1. Load your original documents.

2. At the printer control panel, press the Home button.

3. TouchWorkflow Scanning.

4. To select a workflow, from the Pick a Workflow screen, select a private mailbox folder.

Note: If the Pick a Workflow screen is not automatically displayed, to display it, touch
Change Workflow.

5. On the Mailbox Password screen, enter the password, then touch OK.

6. To add a file destination, touch Add File Destinations, then select a file destination from the list.

7. Adjust the workflow scanning settings as needed.
• To save the scanned document as a specific file name, touch the attachment file name, enter

a new name, then touch OK.
• To save the scanned document as a specific file format, touch the attachment file format,

then select the required format.
• If you are using the document glass, to combine pages into a single scan file, enable Build

Job.
• If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an

option.

For details about available features, refer to Apps Features.

8. To start the scan, touch Scan.

9. If Build Job is enabled, when prompted, do these steps:
• To change settings, touch Program Next Segment.
• To scan another page, touch Scan Next Segment.
• To finish, touch Submit.

10. To move the file to your computer, use the Embedded Web Server. For details, refer to Retrieving
Scan Files from a Mailbox Folder.
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Creating a Private Mailbox Folder
If the scan policy to allow additional folders is enabled, you can create a private mailbox folder. The
system administrator can create a private mailbox folder at any time. For details, refer to the System
Administrator Guide at www.xerox.com/office/ALC81XXdocs.

To create a private mailbox folder with a password:

1. At your computer, open a Web browser, in the address field, type the IP address of the printer,
then press Enter or Return.

Note: For details about obtaining the IP address of your printer, refer to Finding the IP
Address of Your Printer.

2. Click the Scan tab.

3. In the Display section, selectMailboxes.

Note: If the Display section does not appear, Scan to Mailbox is not enabled. For details,
refer to the System Administrator Guide at www.xerox.com/office/ALC81XXdocs.

4. In the Scan to Mailbox section, click Create Folder.

5. Click the Folder Name: field, then type a name for the folder.

6. In the Folder Password field, type a password that adheres to the password rules.

7. In the Confirm Folder Password field, type the password again.

8. Click Apply.

Your private mailbox folder appears in the mailbox folder list in the Embedded Web Server and on the
printer touch screen under Pick a Workflow. The contents are stored on the printer hard drive.

Retrieving Scan Files from a Mailbox Folder
You can use the Embedded Web Server to retrieve scan files from a mailbox folder and copy the files
to your computer.

To retrieve your scan files:

1. At your computer, open a Web browser, in the address field, type the IP address of the printer,
then press Enter or Return.

Note: For details about obtaining the IP address of your printer, refer to Finding the IP
Address of Your Printer.

2. Click the Scan tab.

3. In the Display section, selectMailboxes.
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4. In the Scan to Mailbox section, click the folder containing the scan.

Note:

• For a password protected private folder, click the Folder Password field, type the
password, then click OK.

• If your image file does not appear, click Update View.

Your scan file appears in the Folder Contents window.

5. Under Action, select an option, then click Go.
• Download saves a copy of the file to your computer. When prompted, click Save, then

navigate to the location on your computer to save the file. Open the file or close the dialog
box.

• Reprint prints the file without saving a copy of the file to your computer.
• Delete removes the file from the mailbox. When prompted, click OK to delete the file or

Cancel to cancel the operation.

Note: You can also print a mailbox file using the Print From App. For details, refer to Print From.

SSccaannnniinngg ttoo aa UUsseerr HHoommee FFoollddeerr
Scan to Home allows you to scan documents to a home directory on an external server. The home
directory is distinct for each authenticated user. The directory path is established through LDAP.

The Scan to Home feature is available as the Home workflow in the Workflow Scanning App.

To enable the Home workflow:

• Ensure that LDAP Network Authentication is configured.

• Ensure that Home folder locations are defined for each user in the LDAP directory.

Note:When a user logs in to the printer using network credentials, the Home workflow appears
on the Pick a Workflow screen.

To use the Home workflow:

1. Load your original documents.

2. To log in to the printer, touch Log In, then log in with your network credentials.

3. At the printer control panel, press the Home button.

4. TouchWorkflow Scanning.

5. From the Pick a Workflow screen, touch the Home workflow.

Note:

• If the Pick a Workflow screen is not automatically displayed, to display it, touch Change
Workflow.

• If the Home workflow is not displayed, check that you have logged in with the required
credentials.

6. To add a file destination, touch Add File Destinations, then select a file destination from the list.
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7. Adjust the workflow scanning settings as needed.
• To save the scanned document as a specific file name, touch the attachment file name, enter

a new name, then touch OK.
• To save the scanned document as a specific file format, touch the attachment file format,

then select the required format.
• If you are using the document glass, to combine pages into a single scan file, enable Build

Job.
• If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an

option.

For details about available features, refer to Apps Features.

8. To start the scan, touch Scan.

9. If Build Job is enabled, when prompted, do these steps.
• To change settings, touch Program Next Segment.
• To scan another page, touch Scan Next Segment.
• To finish, touch Submit.

10. To return to the Home screen, press the Home button.

SSccaannnniinngg ttoo aa UUSSBB FFllaasshh DDrriivvee
You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function
produces scans in .jpg, .pdf, .pdf (a), .xps, and .tif file formats.

The Scan to USB feature is available as the USB workflow in the Workflow Scanning App.

Note: Only USB Flash drives formatted to the typical FAT32 file system are supported.

To scan to a USB Flash drive:

1. Load your original documents.

2. At the printer control panel, press the Home button.

3. Insert the USB Flash drive into the USB memory port.

4. At the USB Drive Detected screen, touch Scan to USB.

Note: If the USB Flash drive is inserted in the printer already, touchWorkflow Scanning.
Touch Change Workflow, then touch USB.

5. To add a file destination, touch Add File Destinations, then select a file destination from the list.

6. Adjust the workflow scanning settings as needed.
• To save the scanned document as a specific file name, touch the attachment file name, enter

a new name, then touch OK.
• To save the scanned document as a specific file format, touch the attachment file format,

then select the required format.
• If you are using the document glass, to combine pages into a single scan file, enable Build

Job.
• If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an

option.

For details about available features, refer to Apps Features.

7. To start the scan, touch Scan.
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8. If Build Job is enabled, when prompted, do these steps.
• To change settings, touch Program Next Segment.
• To scan another page, touch Scan Next Segment.
• To finish, touch Submit.

WARNING: Do not remove the USB Flash drive while the printer is processing the scan job.
If you remove the Flash drive before the transfer is complete, the file can become unusable
and other files on the drive can be damaged.

9. To return to the Home screen, press the Home button.

SSiinnggllee--TToouucchh AAppppss
A Single-Touch App enables you to use a workflow without having to use the Workflow Scanning App.
Single-Touch Apps are displayed on the Home screen, and used with a single touch.

You can use the Embedded Web Server to design the app, associate it with a workflow, and assign
user rights. For details about creating Single-Touch Apps for workflow scanning destinations, refer to
the System Administrator Guide at www.xerox.com/office/ALC81XXdocs.
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Scan To
SSccaann TToo OOvveerrvviieeww

You can use the Scan To App to scan documents to multiple destinations and
recipients in a single scan. A Scan To destination can be a USB Flash drive, a
shared network folder, or an SMB network location. A Scan To recipient can be
a contact in the device address book or network address book, an email
address, or the logged-in user.

The Scan To App supports the following scanning functions:

• Scan original documents to an email address. For details, refer to Scanning to an Email Address.

• Scan original documents to a USB Flash drive. For details, refer to Scanning to a USB Flash Drive.

• Scan original documents to a folder in a shared network location using SMB transfer protocol. For
details, refer to Scanning to a Shared Folder on a Networked Computer.

• Scan original documents to the email address associated with the logged-in user. For details, refer
to Scanning to the Logged-In User.

To scan documents to one or more file destinations using customized workflows, refer to Workflow
Scanning.

For details about configuring and customizing apps, refer to the System Administrator Guide at www.
xerox.com/office/ALC81XXdocs.

For information about all the App features and available settings, refer to Apps Features.

SSccaannnniinngg ttoo aann EEmmaaiill AAddddrreessss
You can scan a document and send the scanned file to an email address. The Scan To App produces
scans in .jpg, .pdf, .pdf (a), .xps, and .tif file formats.

Before you scan to an email address, ensure that you configure the printer with the email server
information. For details, refer to the System Administrator Guide at www.xerox.com/office/
ALC81XXdocs.

To scan an image and send it to an email address:

1. Load the original document on the document glass or into the automatic document feeder.

Note:When the original documents are detected, the automatic document feeder
confirmation indicator LED illuminates.

2. At the control panel, touch Home.

3. Touch Scan To.

4. If the Scan To destination window does not appear, touch Add Destination.
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5. Add recipients.
• To enter the email address manually, touch Email. Enter an email address, then touch Add.
• To select a contact or group from the Device Address Book, touch Device Address Book.

Touch Favorites or Contacts, then select a recipient.
• To select a contact or group from the Network Address Book, touch Network Address Book. In

the search bar, type the name of the contact or group that you want to add, then touch
Search. From the list of results, select a recipient.

Note: For details about using the Address Book and managing and creating Favorites, refer
to the System Administrator Guide at www.xerox.com/office/ALC81XXdocs.

6. To add another Scan To destination, touch Add Destination, then select the required destination.

7. To save the scanned document as a specific filename, touch the attachment filename, then enter
a new name using the touch screen keypad. Touch Enter.

8. To save the scanned document as a specific file format, touch the attachment file format, then
select the required format.

Note: To make scanned documents searchable, your system administrator can enable the
Searchable feature.

9. Adjust scanning options as needed.
• To change the email subject line, touch Subject. Enter a new subject line using the touch

screen keypad, then touch Enter.
• To change the email body message, touchMessage. Enter a new message, then touch OK.
•

To scan multiple pages using the document glass, or to change settings for different sections
of the job, touch Build Job.

10. To begin the scan, touch Scan.

11. If Build Job is enabled, when prompted, do these steps.
• To change settings for the next segment of the document, touch Program Segment.
• To scan another page, load the new document onto the document glass, then touch Scan

Segment.
• To finish, touch Submit.

12. To return to the Home screen, press the Home button.

SSccaannnniinngg ttoo aa UUSSBB FFllaasshh DDrriivvee
You can scan a document and store the scanned file on a USB Flash drive. The Scan To App produces
scans in .jpg, .pdf, .pdf (a), .xps, and .tif file formats.

Note: Only USB Flash drives formatted to the typical FAT32 file system are supported.

To scan to a USB Flash drive:

1. Load the original document on the document glass or in the automatic document feeder.

2. At the printer control panel, press the Home button.

3. Touch Scan To.

4. If the Scan To destination window does not appear, touch Add Destination.
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5. Insert your USB Flash drive into the USB port on the front of the printer, then touch USB.

Note: If you select USB as the Scan To destination before inserting a USB Flash drive, you
will be prompted to insert it.

6. To add another Scan To destination, touch Add Destination, then select the required destination.

7. To save the scanned document as a specific file name, touch the attachment file name, then
enter a new name using the touch screen keypad. Touch Enter.

8. To save the scanned document as a specific file format, touch the attachment file format, then
select the required format.

9. Adjust scanning features as needed.

10. To scan multiple pages using the document glass, or to change settings for different sections of
the job, touch Build Job.

11. To begin the scan, press Scan.

12. If Build Job is enabled, when prompted, do these steps.
• To change settings for the next segment of the document, touch Program Segment.
• To scan another page, load the new page onto the document glass, then touch Scan

Segment.
• To finish, touch Submit.

The printer scans your images to the root folder of the USB Flash drive.

13. If you are scanning from the document glass, when prompted, to finish, touch Done or to scan
another page, touch Add Page.

Note: If you are scanning a document from the automatic document feeder, a prompt
does not appear.

Caution: Do not remove the USB Flash drive while the device is scanning and processing
the job. If you remove the Flash drive before the transfer is complete, the file can become
unusable and other files on the drive can be damaged.

14. To return to the Home screen, press the Home button.

SSccaannnniinngg ttoo aa SShhaarreedd FFoollddeerr oonn aa NNeettwwoorrkkeedd
CCoommppuutteerr
You can scan a document and save the scanned file to a folder on a networked computer. The Scan
To App produces scans in .jpg, .pdf, .pdf (a), .xps, and .tif file formats.

Note: To scan to a user home folder, use the Workflow Scanning App. For details, refer to
Adding a Scan To Destination to an Address Book Entry.

BBeeffoorree YYoouu BBeeggiinn
Before scanning to a folder on a networked computer, perform these steps:

• Create a shared folder on your computer:
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– For Windows, refer to Sharing a Folder on a Windows Computer.

– For Macintosh, refer to Sharing a Folder in Macintosh OS X Version 10.7 and Later.

• Configure an SMB Folder. For details, refer to the System Administrator Guide, at www.xerox.com/
office/ALC81XXdocs.

• Use the Embedded Web Server to associate a Scan To destination with a Device Address Book
contact. For details, refer to Adding a Scan To Destination to an Address Book Entry.

Note: Ensure that the Address Book contains at least one contact with a scan-to destination.

SSccaannnniinngg ttoo aa SShhaarreedd FFoollddeerr oonn aa NNeettwwoorrkkeedd CCoommppuutteerr
1. Load the original document on the document glass or into the automatic document feeder.

2. At the printer control panel, press the Home button.

3. Touch Scan To.

4. To specify the destination of the scanned document, select one of the following options.
• To scan to an SMB folder on a networked computer, touch Network. Browse to the required

folder, or enter the network path name, then touch OK.

Note: For information on configuring SMB folders, refer to the System Administrator
Guide at www.xerox.com/office/ALC81XXdocs.

• To scan to a folder associated with a contact in the address book, touch Device Address Book.
Select the required contact, then touch the Scan To location.

Note: For details on how to associate a networked folder with an address book contact,
refer to Adding a Scan To Destination to an Address Book Entry.

5. To add another Scan To destination, touch Add Destination, then select the required destination.

6. To save the scanned document as a specific filename, touch the attachment filename. Enter a
new name using the touch screen keypad, then touch Enter.

7. To save the scanned document as a specific file format, touch the attachment file format, then
select the required format.

8. Adjust scanning options as needed.

9. To scan multiple pages using the document glass, or to change settings for different sections of
the job, touch Build Job.

10. To begin the scan, press Scan.

11. If Build Jobis enabled, when prompted, do these steps.
• To change settings for the next segment of the document, touch Program Segment.
• To scan another page, load the new document onto the document glass, then touch Scan

Segment.
• To finish, touch Submit.

12. To return to the Home screen, press the Home button.
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SSccaannnniinngg ttoo tthhee LLooggggeedd--IInn UUsseerr
You can use the Add Me function to scan a document and send the scanned file to the email address
associated with a logged-in user.

Note: Only users authenticated through an LDAP server can have an associated email address.

Before scanning to a logged in user, ensure that LDAP user authentication is configured. For details,
refer to the System Administrator Guide at www.xerox.com/office/ALC81XXdocs.

The Scan To App produces scans in .jpg, .pdf, .pdf (a), .xps, and .tif file formats.

To scan an image and send it to the email address of the logged-in user:

1. Load the original document on the document glass or into the automatic document feeder.

2. At the control panel, touch Home.

3. Touch Scan To.

4. If the Scan To destination window does not appear, touch Add Destination.

5. Touch Add Me.

6. If you are not logged in, a login screen appears. Enter your LDAP network user name and
password, then touch Done.

7. To add another Scan To destination, touch Add Destination, then select the required destination.

8. To save the scanned document as a specific file name, touch the attachment file name, then
enter a new name using the touch screen keypad. Touch Enter.

9. To save the scanned document as a specific file format, touch the attachment file format, then
select the required format.

Note: To make scanned documents searchable, your system administrator can enable the
Searchable feature.

10. Adjust scanning options as needed.

11. To scan multiple pages using the document glass, or to change settings for different sections of
the job, touch Build Job.

12. To begin the scan, touch Scan.

13. If Build Jobis enabled, when prompted, do these steps.
• To change settings for the next segment of the document, touch Program Segment.
• To scan another page, load the new document onto the document glass, then touch Scan

Segment.
• To finish, touch Submit.

14. To return to the Home screen, press the Home button.

PPrreevviieewwiinngg JJoobbss
Use the Preview option to view and verify scanned images.

1. At the printer control panel, press the Home button.

2. To clear previous app settings, touch Reset.
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3. Load your original documents.
• For single pages or paper that cannot be fed using the duplex automatic document feeder,

use the document glass. Lift the duplex automatic document feeder, then place the original
document face down in the upper-left corner of the document glass.

• For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove all
staples and paper clips from the pages. Insert the original documents face up in the duplex
automatic document feeder, with the top of the page entering the feeder first. Adjust the
paper guides so that they fit against the original documents.

4. Touch the app required, then select the job settings.

5. To enable preview, touch Preview.

6. If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an
option.

7. To start scanning, touch Preview.

The original documents are scanned, then preview images appear on the device user interface.

8. Scroll through and verify the preview images.
• To change the size of the preview image thumbnails, in the bottom-left corner, touch the

large or small thumbnail view options.
• To zoom in on an image, tap the image twice.
• To zoom out, tap the image twice.

9. To scan more original documents:

a. Load your original documents in the document feeder, or place a single document on the
document glass.

b. Swipe to scroll to the end of the thumbnail images, then touch Scan More (+).

c. If you are using the document glass, touch the original document size, then touch OK.

The original documents are scanned and new preview images appear on the user interface.

d. Continue this procedure until you have scanned all the original documents.

10. To process the job and send the scanned images, touch Submit. To discard the job, touch X, then
touch Delete and Close.

11. To return to the Home screen, press the Home button.

AAddddiinngg aa SSccaann TToo DDeessttiinnaattiioonn ttoo aann AAddddrreessss BBooookk
EEnnttrryy
You can create Address Book contacts using the Embedded Web Server. A contact is a user with an
associated email address, fax number, or scan to destination. If a contact has been set up to include a
scan to destination, the contact is available for selection in the Scan To App. Contacts can be marked
as a Favorite.

To create an address book contact and add a scan to destination:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

Note: For details about obtaining the IP address of your printer, refer to Finding the IP
Address of Your Printer.

2. Click Address Book.
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3. To add or edit a contact in the address book:
• To add a contact, click Add, then enter the contact information.
• To edit a contact, select the contact, then click Edit.

Note: If the Add button is unavailable, the address book has reached its limit. The Device
Address Book can contain up to 5000 contacts.

4. To associate a scan destination with this contact, for Scan To Destination, click the Add
Destination ( +) button. Enter the nickname that you want to appear in the Address Book.

5. Under Protocol, select an option, then enter the destination address:
• For FTP, SFTP, or SMB:

• For IP Address, enter the IP Address: Port number.

• For Host Name, enter the Host Name: Port number.

• For Netware, enter the Server Name, Server Volume, NDS Tree, and NDS Context.

6. For SMB, in the Share field, enter the name of the destination folder. For example, to save
scanned files to a shared folder named scans, type scans.

7. In Document Path, enter the name of the subfolder within the destination folder. For example, to
save the scanned files to a folder named colorscans inside the scans folder, type colorscans.

8. Enter a valid login name and password.

Note: Use the login name for the computer that holds the destination folder. For SMB, the
login name is your computer user name.

9. To confirm the validity of the destination details, click Destination Test.

10. Click Save, or select Add Another Contact After Saving, then click Save.

Note: To mark a contact as a Favorite for email, fax, or scan to destination, for the appropriate
field, click the Staricon. If you click the Star icon for Display Name, the contact becomes a
Global Favorite.
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Fax
FFaaxx OOvveerrvviieeww

When you send a fax from the printer control panel, the document is scanned
and transmitted to a fax machine, using a dedicated telephone line. You can
use the Fax App to fax documents to a fax number, an individual contact, or
to a group of contacts.

You can use the Fax App to do the following tasks:

• Delay the send of your fax job for up to 24 hours.

• Send a fax from your computer.

• Forward fax documents to an email address.

• Print a fax from a secure folder.

The fax function works best with an analog phone line. Voice-Over-Internet Protocols (VOIPs) such as
FIOS and DSL are not supported. Before you use the Fax App, configure the Fax Settings to ensure
that they are compatible with your local connection and regulations. The Fax Settings include
optional features you can use to configure the printer for faxing.

Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

For details about configuring the fax function and customizing the Apps, refer to the System
Administrator Guide at www.xerox.com/office/ALC81XXdocs.

For information about all the App features and available settings, refer to Apps Features.
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SSeennddiinngg aa FFaaxx
To send a fax:

1. Load your original documents.

• For single pages or paper that cannot be fed using the duplex automatic document feeder,
use the document glass. Lift the duplex automatic document feeder, then place the original
document face down in the upper-left corner of the document glass.

• For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any
staples and paper clips from the pages. Insert the original documents face up in the duplex
automatic document feeder, with the top of the page entering the feeder first. Adjust the
paper guides so that they fit against the original documents.

Note:When the original documents are detected, the automatic document feeder
confirmation indicator LED illuminates.

2. At the printer control panel, press the Home button.

3. Touch Fax.

4. To clear previous app settings, touch Reset.
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5. Enter recipients:
• If the entry screen appears, to enter a recipient, touch an option, or touch X.
• To select a contact or group from the Device Address Book, touch Device Address Book.

Touch Favorites or Contacts, then select a recipient.
• To enter the fax number manually, touchManual Entry. In the Enter Fax Number field, enter

the fax number, then touch Add.
• To add more recipients, touch Add Recipient, then repeat the procedure.

Note: To insert a pause as needed, touch Dial Pause. To enter longer pauses, touch Dial
Pause multiple times.

6. Adjust the fax settings as needed.
• To scan more documents using the document glass, or to change settings for different

sections of the job, touch Build Job.
• If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an

option.

For details about available features, refer to Apps Features.

7. Touch Send.

8. If Build Job is enabled, touch Scan, then, when prompted, do these steps:
• To change settings, touch Program Next Segment.
• To scan another page, touch Scan Next Segment.
• To finish, touch Submit.

9. To return to the Home screen, press the Home button.

FFaaxx WWoorrkkfflloowwss

SSeennddiinngg aa DDeellaayyeedd FFaaxx
You can set a time in the future for the printer to send your fax job. You can delay the send of your
fax job for up to 24 hours.

Note: Before you use this feature, ensure that the printer is set to the current time. For details,
refer to the System Administrator Guide at www.xerox.com/office/ALC81XXdocs.

To specify the time to send your fax:

1. Load your original documents.

2. At the printer control panel, press the Home button, then touch Fax.

3. Add fax recipients, then adjust fax settings as needed. For details, refer to Sending a Fax.

4. Touch Delay Send.

5. Touch Delay send, then set the time to send the fax.
• To set the hour, touch the Hour field, then use the numeric keypad, or touch the arrows.
• To set the minutes, touch theMinute field, then use the numeric keypad, or touch the arrows.
• If your printer is set to display the 12-hour clock, touch AM or PM.

6. Touch OK.

7. Touch Send. The fax is scanned and saved, then sent at the specified time.
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AAddddiinngg aa CCoovveerr SShheeeett
You can use the Cover Sheet option to add an introduction page to the beginning of your fax. You can
add a short comment to the cover sheet, as well as To and From details.

To include a cover sheet:

1. Load your original documents.

2. At the printer control panel, press the Home button, then touch Fax.

3. Add fax recipients, then adjust fax settings as needed. For details, refer to Sending a Fax.

4. Touch Cover Sheet→On.

5. To enter the name of the recipient, touch the To field, then use the touch screen keyboard. Touch
OK.

6. To enter the name of the sender, touch the From field, then use the touch screen keyboard. Touch
OK.

7. To add a comment, do one of the following steps.
• Touch an existing comment.
• Touch an <Available> comment, then touch the Edit icon. To type text, use the touch screen

keypad. Touch OK.

Note:

• To delete an existing comment, touch the comment, then touch X. To confirm the
action, touch Delete.

• To edit an existing comment, touch the comment, then touch the Edit icon. To change
the comment, use the touch screen keypad. Touch OK.

8. Touch OK.

PPrriinnttiinngg aa SSeeccuurree FFaaxx
When the Fax Secure Receive option is enabled, all faxes that the device receives are held in the Job
list until you enter a passcode. After you enter the passcode, the faxes are released and printed.

Note: Before you can receive a Secure Fax, ensure that the Secure Fax Receive feature is
enabled. For details, refer to the System Administrator Guide at www.xerox.com/office/
ALC81XXdocs.

To print a secure fax:

1. At the printer control panel, press the Home button.

2. Touch Jobs, then from the list, touch the secure fax job required.

3. Touch Print, then enter the passcode.

4. Touch Release All Fax Jobs.

All secure faxes print.

5. To return to the Home screen, press the Home button.
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DDeelleettiinngg aa SSeeccuurree FFaaxx
To delete a secure fax:

1. At the printer control panel, press the Home button.

2. Touch Jobs, then from the list, touch the secure fax job required.

3. Touch Delete, then enter the passcode.

4. Touch OK.

5. To return to the Home screen, press the Home button.

PPoolllliinngg aa RReemmoottee FFaaxx MMaacchhiinnee
Fax Polling allows you to store a fax document on the printer and make it available for other fax
machines to poll. You can also retrieve faxes stored on other fax machines. To use this feature, both
the polling printer and the remote printer must have the Fax Polling feature.

Storing a Fax for Polling
You can store faxes for polling as Non-Secure or Secure. When you select Secure Storage, you create a
list of remote device fax numbers that are allowed to access secure faxes.

Storing a Fax for Non-Secure Polling

1. Load your original documents.

2. At the printer control panel, press the Home button, then touch Fax.

3. If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.

4. Touch Store Polling Files.

5. Touch Non-Secure Storage, then touch OK. To confirm, touch Update Setting.

6. Touch Send. The original documents are scanned and stored for non-secure polling.

Storing a Fax for Secure Polling

1. Load your original documents.

2. At the printer control panel, press the Home button, then touch Fax.

3. If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.

4. Touch Store Polling Files.

5. Touch Secure Storage.

6. Touch Enter a Fax Number. To enter the fax number for the remote device, use the keypad.
Touch OK.

7. Touch the + button. The fax number is added to the access list.

8. Continue to enter fax numbers for all remote devices that require access to the secure documents.

9. Touch OK. To confirm, touch Update Setting.

10. Touch Send. The original documents are scanned and stored for secure polling.
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Deleting Documents Stored for Polling

1. At the printer control panel, press the Home button, then touch Fax.

2. If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.

3. Touch Store Polling Files.

4. Touch Empty Fax Polling. To confirm, touch Empty Fax Polling again.

5. Touch OK.

Printing Faxes Stored for Polling
To print faxes stored for polling:

1. At the printer control panel, press the Home button, then touch Fax.

2. If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.

3. Touch Print From Polling Device.

4. To print faxes that are stored for polling on the local device:

a. Touch Local Fax Polling.

b. Touch Print.

c. To delete stored faxes after they print, touch Empty Fax Polling. To confirm, touch Empty
Fax Mailbox.

The local faxes that are stored for polling print.

5. To print faxes that are stored for polling on a remote device:

a. Touch Remote Fax Polling.

b. Touch Enter Fax Number. To enter the fax number of the remote device, use the keypad.
Touch OK.

c. To add a number to the list, touch the + button. Enter more fax numbers as needed.

d. To edit the list of fax numbers, touch a number in the list, then touch Remove or Edit.

e. To set a specific time to poll the remote device, touch Delay Polling.

• Touch Delay Polling.

• To set the hour, touch the Hour field, then use the numeric keypad, or touch the arrows.

• To set the minutes, touch theMinute field, then use the numeric keypad, or touch the
arrows.

• If your printer is set to display the 12-hour clock, touch AM or PM.

• Touch OK.

f. Touch Print.

The faxes that are stored on the remote device for polling print.

6. Touch X to exit.
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Storing a Fax in a Local Mailbox
The system administrator must create a mailbox before you can use this feature. For details, refer to
the System Administrator Guide at www.xerox.com/office/ALC81XXdocs.

To store a fax in a local mailbox:

1. Load your original documents.

2. At the printer control panel, press the Home button, then touch Fax.

3. If the entry screen is displayed, touchMailboxes, or touch Add Recipient, then touchMailboxes.

4. Touch Store To Mailbox.

5. Touch Local Mailbox.

6. Touch a mailbox from the list.

7. If a passcode is required, touch theMailbox Passcodefield. To enter the four-digit mailbox
passcode, use the keypad. Touch OK.

8. Touch OK. The mailbox appears as the recipient of the fax.

9. To select a different mailbox, touch the recipient field, then touch Remove or Edit.

10. Touch Send. The original documents are scanned and stored in the mailbox.

Printing Local Mailbox Documents
To use this feature, ensure that you have the documents stored in a mailbox. For details, refer to
Storing a Fax in a Local Mailbox.

To print local mailbox documents:

1. At the printer control panel, press the Home button, then touch Fax.

2. If the entry screen appears, touchMailboxes, or touch Add Recipient, then touchMailboxes.

3. Touch Print From Mailbox.

4. Touch Local Mailbox.

5. Touch a mailbox from the list.

6. If a passcode is required, touch theMailbox Passcode field. To enter the four-digit mailbox
passcode, use the touch screen keypad. Touch OK.

7. Touch Print.

The documents in the mailbox print.

8. To delete the contents of the mailbox after the device finishes printing, touch Empty Mailbox. To
confirm, touch Empty Mailbox.

9. To exit, touch X.

Storing a Fax in a Remote Mailbox
To store a fax in a remote mailbox:

1. Load your original documents.

2. At the printer control panel, press the Home button, then touch Fax.

3. If the entry screen appears, touchMailboxes, or touch Add Recipient, then touchMailboxes.
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4. Touch Store To Mailbox.

5. Touch Remote Mailbox.

6. To enter the fax number of the remote device, touch Enter Remote Fax Number, then use the
numeric keypad. Touch OK.

7. To enter the mailbox number, touch theMailbox Number field, then use the numeric keypad.
Touch Enter.

8. Touch OK. To select a different mailbox, touch the recipient field, then touch Remove or Edit.

9. Touch Send.

The original documents are scanned, then stored in the remote mailbox.

Printing Remote Mailbox Documents
To print remote mailbox documents:

1. At the printer control panel, press the Home button, then touch Fax.

2. If the entry screen is displayed, touchMailboxes, or touch Add Recipient, then touchMailboxes.

3. Touch Print From Mailbox.

4. Touch Remote Mailbox.

5. To enter the fax number of the remote device, touch Enter Remote Fax Number, then use the
numeric keypad. Touch OK.

6. To enter the mailbox number, touch theMailbox Number field, then use the numeric keypad.
Touch Enter.

7. If a passcode is required, touch theMailbox Passcode field. To enter the four-digit mailbox
passcode, use the keypad. Touch OK.

8. Touch Print. The documents in the remote mailbox print.

9. Touch X to exit.

AAddddiinngg oorr EEddiittiinngg CCoonnttaaccttss iinn tthhee DDeevviiccee AAddddrreessss BBooookk ffrroomm tthhee
CCoonnttrrooll PPaanneell
You can set up the Device Address Book using the Embedded Web Server. The Address Book can
contain up to 5000 contacts that you can access when you enter recipients or destinations using
apps.

To add or edit contacts in the Device Address Book from the control panel:

Note: Before you can use this feature, the system administrator must enable Create/Edit
Contact from Touch Screen for All Users.

1. Load your original documents.

2. At the printer control panel, press the Home button.

3. Touch Fax.

4. To clear previous App settings, touch Reset.

5. TouchManual Entry. To type the fax number, use the touch screen keypad.

6. To add the recipient to the Device Address Book, touch the Address Book icon.
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7. Do one of the following steps.
• To create an entry, touch Create New Contact. Touch each field, then enter the contact

details using the touch screen keypad. Touch OK.
• To add to an existing entry, touch Add to Existing Contact. Touch a contact in the list, or use

the Search option to find a contact.

8. To mark a recipient to appear as a favorite option, touch the Star icon.

9. Adjust the fax settings as needed.

10. To start the scan, touch Send.

11. To return to the Home screen, press the Home button.

SSeennddiinngg aa FFaaxx FFrroomm YYoouurr CCoommppuutteerr
You can send a fax to the printer from an application on your computer.

Sending a Fax from Windows Applications
You can use the print driver to send a fax from Windows applications.

You can use the fax window to enter recipients, create a cover page with notes, and set options. You
can send a confirmation sheet, set the send speed, resolution, send time, and dialing options.

To send a fax from Windows applications:

1. With the desired document or image open in your application, open the Print dialog box. For
most software applications, click File→Print or press CTRL+P.

2. Select the required printer. To open the print driver dialog box, click Printer Properties.

3. On the Printing Options tab, from the Job Type list, select Fax.

4. In the Fax window, click the Recipients tab.

5. To add recipients manually:

a. Click the Add Recipient icon.

b. Type the recipient name and fax number, then add other information as required.

c. Click OK.

d. To add more recipients, repeat this procedure.

6. To add existing contacts from a phonebook:

a. Click the Add From Phonebook icon.

b. Select the required phonebook from the list.

c. Select names from the list, or search for a contact using the search bar.

d. To add the selected contacts to the Fax Recipients list, click the Down Arrow.

e. Click OK.

f. To add more recipients, repeat this procedure.

7. To include a cover sheet, click the Cover Sheet tab. From the Cover Sheet Options list, select Print
a Cover Sheet. Enter the details as needed, then click OK.

8. On the Options tab, select the required options, then click OK.
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9. To save your settings and return to the main print dialog page, click OK.

10. Click Print. In the Fax Confirmation window, click OK.

Sending a Fax from Macintosh® Applications
You can use the print driver to send a fax from many Macintosh® applications. To install the print
driver, refer to Installing the Software.

To send a fax from Macintosh® applications:

1. With the required document or image open in your application, open the Print dialog box. For
most software applications, click File→Print or press CMD+P.

2. Select the required printer.

3. In the Print window, in the print options list, click Xerox Features.

4. From the Paper/Output window, click Job Type, then click Fax.

5. To add a recipient, in the Fax window, click the Recipients tab, then click the Add Recipient icon.
Type the recipient name and fax number, add other information as required, then click OK. To
add more recipients, repeat this procedure.

6. To include a cover sheet, click the Cover Sheet tab. From the Cover Sheet list, select Print a Cover
Sheet, then enter the details as required.

7. To delay the fax send time, click the Options tab, click the Send Time menu, then click Send At.
To enter the send time, click the time entry field, then enter the time required.

8. To select additional fax options, from the Options window, select the fax settings required.

9. To save your settings and return to the main print dialog box, click OK.

10. To send the fax, click Print.
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Server Fax
SSeerrvveerr FFaaxx OOvveerrvviieeww

Server Fax allows you to send a fax over a network to a fax server. The fax
server then sends the fax to a fax machine over a phone line. Before you can
send a server fax, configure a fax filing repository or filing location. The fax
server retrieves the documents from the filing location and transmits them
over the telephone network.

For details about configuring and customizing the Apps, refer to the System Administrator Guide at
www.xerox.com/office/ALC81XXdocs.

For information about all the App features and available settings, refer to Apps Features.
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SSeennddiinngg aa SSeerrvveerr FFaaxx
If a fax server is connected to the network, you can send a document to a fax machine without
requiring a dedicated telephone line.

When you use the server fax, a document is scanned and sent to a fax repository on the network. The
fax server sends the fax over a telephone line to a fax machine.

Before you can use the server fax, the system administrator is required to enable the server fax app
and configure a fax repository or filing location.

To send a server fax:

1. Load your original documents.
• For single pages or paper that cannot be fed using the duplex automatic document feeder,

use the document glass. Lift the duplex automatic document feeder, then place the original
document face down in the upper-left corner of the document glass.

• For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any
staples and paper clips from the pages. Insert the original documents face up in the duplex
automatic document feeder, with the top of the page entering the feeder first. Adjust the
paper guides so that they fit against the original documents.

Note:When the original documents are detected, the automatic document feeder
confirmation indicator LED illuminates.

140 Xerox® AltaLink® C81XX Series Color Multifunction Printer
User Guide

Xerox® Apps



2. At the device control panel, press the Home button.

3. Touch Server Fax.

4. To clear previous app settings, touch Reset.

5. Enter recipients.
• If the entry screen appears, touch an option, or touch X.
• To select a contact or group from the Device Address Book, touch Device Address Book, then

select a recipient.
• To enter the fax number manually, touchManual Entry. In the Enter Fax Number field, enter

the fax number, then touch Add.
• To add more recipients, touch Add Recipient, then repeat the procedure.

Note: To insert a pause as needed, touch Dial Pause. To enter longer pauses, touch Dial
Pause multiple times.

6. Adjust server fax settings as needed.
• To scan more documents using the document glass, or to change settings for different

sections of the job, touch Build Job.
• If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an

option.

For details about available features, refer to Apps Features.

7. Touch Send.

8. If Build Job is enabled, touch Scan, then, when prompted, do these steps;
• To change settings, touch Program Next Segment.
• To scan another page, touch Scan Next Segment.
• To finish, touch Submit.

9. To return to the Home screen, press the Home button.

SSeennddiinngg aa DDeellaayyeedd SSeerrvveerr FFaaxx
You can set a time in the future for the printer to send your fax job. The delay can range from 15
minutes through 24 hours.

Note: Before you use this feature, set the printer to the current time.

To specify the time to send your server fax:

1. Load your original documents.

2. At the printer control panel, press the Home button.

3. Touch Server Fax.

4. Add server fax recipients, then adjust server fax settings as needed. For details, refer to Sending a
Server Fax.

5. Touch Delay Send.

6. Touch Delay Send, then set the time to send the server fax:
• To set the hour, touch the Hour field, then use the numeric keypad, or touch the arrows.
• To set the minutes, touch theMinute field, then use the numeric keypad, or touch the arrows.
• If your printer is set to display the 12-hour clock, touch AM or PM.

7. Touch OK.
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8. Touch Send. The fax is scanned and saved, then sent at the time you specified.

9. To return to the Home screen, press the Home button.
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Internet Fax
IInntteerrnneett FFaaxx OOvveerrvviieeww

You can use the Internet Fax App to scan images and attach them to emails.
You can specify the file name and format of the attachment, and include a
subject heading and message for the email.

For details on configuring and customizing the Apps, refer to the System Administrator Guide at www.
xerox.com/office/ALC81XXdocs.

For information about all the App features and available settings, refer to Apps Features.
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SSeennddiinngg aa SSccaannnneedd IImmaaggee iinn aann IInntteerrnneett FFaaxx
To send a scanned image in an email:

1. Load your original documents.
• For single pages or paper that cannot be fed using the duplex automatic document feeder,

use the document glass. Lift the duplex automatic document feeder, then place the original
document face down in the upper-left corner of the document glass.

• For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any
staples and paper clips from the pages. Insert the original documents face up in the duplex
automatic document feeder, with the top of the page entering the feeder first. Adjust the
paper guides so that they fit against the original documents.

Note:When the original documents are detected, the automatic document feeder
confirmation indicator LED illuminates.

2. At the printer control panel, press the Home button.

3. Touch Internet Fax.

4. To clear previous app settings, touch Reset.
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5. Enter recipients:
• If the entry screen appears, to enter a recipient, touch an option, or touch X.
• To select a contact from the Address Book, touch Device Address Book. Select a recipient,

then touch OK.
• To enter an Internet fax address manually, touchManual Entry. In the Enter an Internet Fax

Address field, enter the Internet fax address, then touch Add.
• To add more recipients, touch Add Recipient, then repeat the procedure.

6. To organize the recipients, touch one of the recipients on the list. From the menu, select To: or
Cc:.

7. Adjust the Internet fax settings as needed:
• To change the subject, touch Subject, enter a new subject, then touch OK.
• To save the scanned document as a specific filename, touch the attachment filename, enter a

new name, then touch OK.
• To save the scanned document as a specific file format, touch the attachment file format,

then select the required format.
• To change the Internet fax message, touchMessage, enter a new message, then touch OK.
• To scan more documents using the document glass, or to change settings for different

sections of the job, touch Build Job.
• If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an

option.

For details about available features, refer to Apps Features.

8. To start the scan, touch Send.

9. If Build Job is enabled, touch Scan, then, when prompted, do these steps:
• To change settings, touch Program Next Segment.
• To scan another page, touch Scan Next Segment.
• To finish, touch Submit.

10. To return to the Home screen, press the Home button.
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Print From
PPrriinntt FFrroomm OOvveerrvviieeww

You can use the Print From App to print jobs from various sources. You can
print jobs stored in a print-ready format from a USB stick. You can also print
Saved Jobs and jobs stored in a Mailbox.

To create a print-ready file, when you print your documents from programs such as Microsoft Word,
select the Print to File option. Check with your specific publishing application for options to create
print-ready files.

PPrriinnttiinngg FFrroomm aa UUSSBB FFllaasshh DDrriivvee
You can print single or multiple files stored on a USB Flash drive. The USB port is on the front of the
printer.

Note: Only USB Flash drives formatted to the typical FAT32 file system are supported.

To print from a USB Flash drive:

1. Insert the USB Flash drive into the USB port on the printer.

2. At the USB Drive Detected screen, touch Print from USB.

Note: If the Print from USB feature does not appear, enable the feature, or contact your
system administrator. For details, refer to the System Administrator Guide at www.xerox.
com/office/ALC81XXdocs.

3. To select a file for printing, browse to the file, then touch the check box. If multiple files require
printing, browse to each file, then select the check box for each file.

4. Touch OK.

A list of files selected for printing appears.

5. To remove files from the printing list:
• To remove a single file, touch the file, then select Remove. To confirm removal, touch Remove.
• To remove all the files, touch a file, then select Remove All. To confirm removal, touch

Remove All.

6. Adjust the feature settings as needed.

7. Touch Print.

8. When you are finished, remove the USB Flash drive.

9. To return to the Home screen, press the Home button.

PPrriinnttiinngg ffrroomm SSaavveedd JJoobbss
To print from saved jobs:

1. At the control panel, press the Home button, then touch Print From.

2. Touch Saved Jobs, then touch the name of the folder that contains the saved job.
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3. Touch the name of the saved job that you want to print.

4. Select the options for paper supply, quantity, 2-sided printing, and finishing.

5. Touch Print.

Note: To print a private saved job, at the Passcode Required screen, enter the passcode,
then touch OK.

6. To print another saved job, touch the current job name, then touch Remove. Touch Add
Document, touch Saved Jobs, then navigate to the job required.

7. To return to the Home screen, press the Home button.

PPrriinnttiinngg ffrroomm aa MMaaiillbbooxx
The print from mailbox feature allows you to print a file that is stored in a folder on the printer hard
drive.

To print from a mailbox:

1. At the control panel, press the Home button, then touch Print From.

2. SelectMailboxes, then touch the name of the folder that contains the document.

Note: If Mailboxes does not appear, enable the feature or contact the system
administrator. For details, refer to the System Administrator Guide at www.xerox.com/
office/ALC81XXdocs.

3. Touch the name of the document that you want to print.

4. Select the options for paper supply, quantity, 2-sided printing, and finishing.

5. Touch Print.

6. To select another job in the mailbox, touch the current job name, then touch Remove. Touch Add
Document, touchMailboxes, then navigate to the job required.

7. To return to the Home screen, press the Home button.
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@PrintByXerox

@@PPrriinnttBByyXXeerrooxx OOvveerrvviieeww

You can use the Xerox® @PrintByXerox App to print email attachments and
documents sent to your printer from mobile devices.

When your Xerox device is connected to the Internet, the @PrintByXerox App works with
the Xerox® Workplace Cloud for simple email-based printing.

Note: The @PrintByXerox App is free to use. For more advanced workflows, use Xerox®
Workplace Cloud. The Xerox® Workplace Cloud software requires a specific licence. For details,
refer to the Xerox® @PrintByXerox App Quick Start Guide available at www.xerox.com/
XeroxAppGallery.

PPrriinnttiinngg wwiitthh tthhee @@PPrriinnttBByyXXeerrooxx AApppp
1. Send an email with an attachment that contains a supported file type to Print@printbyxerox.

com.

First-time users receive a response email with a user ID and password.

2. At the Xerox device control panel, press the Home button.

3. Touch @PrintByXerox.

4. Enter your email address, then touch OK.

5. On the enter password screen, enter your password using the touch screen keypad, then touch
OK.

6. Select the documents that you want to print.

7. To modify print settings, touch Print Settings, then touch OK.

8. To release your print jobs, touch Print.
• A Submitting Jobs to Print message and the conversion state appear.
• When the documents begin to print, a green check mark appears.
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Printing Overview
Before you print, ensure that your computer and the printer are plugged in, powered on, and
connected to an active network. Ensure that you have the correct print driver software installed on
your computer. For details, refer to Installing the Software.

1. Select the appropriate paper.

2. Load paper in the appropriate tray. At the printer control panel, specify the paper size, color, and
type.

3. Access the print settings in your software application. For most software applications, for
Windows, press CTRL+P, or for Macintosh, press CMD+P.

4. Select your printer.

5. To access the print driver settings, for Windows, select Printer Properties, Print Options, or
Preferences. For Macintosh, select Xerox Features. The name of the option can vary depending
on your application.

6. Modify the print driver settings as necessary, then click OK.

7. To send the job to the printer, click Print.

8. If you selected a special job type, for example Secure Print or Sample Print, your job is held at the
printer and requires further action to print. To manage jobs at the printer, use the Jobs app.

For further information on managing print jobs, refer to Managing Jobs.
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Selecting Printing Options
Printing options, also called print driver software options, are specified as Printing preferences in
Windows and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing,
page layout, and print quality. Printing options that you set from Printing preferences within the
Devices and Printers window become the default setting. Printing options that you set within the
software application are temporary. The application and the computer do not save the settings after
the application is closed.

PPrriinntt DDrriivveerr HHeellpp
Xerox® print driver software Help information is available from the Printing Preferences window. To
see the help, click the Help (?) button in the bottom-left corner of the Printing Preferences window.

Information about Printing Preferences appears in the Help window. From this window, you can select
by topic or use the search field. In the search field, enter the topic or function required.
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WWiinnddoowwss PPrriinnttiinngg OOppttiioonnss

SSeettttiinngg DDeeffaauulltt PPrriinnttiinngg OOppttiioonnss ffoorr WWiinnddoowwss
When you print from any software application, the printer uses the print job settings that are
specified in the Printing Preferences window. You can specify your most common printing options and
save the options for reuse so that you do not have to change the settings each time that you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in
Printing Preferences.

1. On your computer, navigate to the list of printers:
• For Windows Server 2008 and later, click Start→Settings→Printers.
• For Windows 7, click Start→Devices and Printers.
• For Windows 8, click Start→Control Panel→Devices and Printers.
• For Windows 10, click Start→Settings→Devices→Printers & scanners.

Note: If you are using a custom Start menu application, the application can change the
navigation path to your list of printers.

2. For your printer, select Printing preferences:
• For Windows Server 2008 or later, Windows 7, or Windows 8, right-click the icon for your

printer, then click Printing preferences.
• For Windows 10, click the icon for your printer, then clickManage→Printing preferences.

3. In the Printing Preferences window, click a tab, then select the options. To save the settings, click
OK.

Note: For more information about Windows print driver options, click the Help button (?) in the
Printing Preferences window.

SSeelleeccttiinngg PPrriinnttiinngg OOppttiioonnss ffoorr aann IInnddiivviidduuaall JJoobb ffoorr WWiinnddoowwss
To use special printing options for a particular job, you can change the Printing Preferences before
sending the job to the printer.

1. With the document open in your software application, access the print settings. For most
software applications, click File→Print or press CTRL+P for Windows.

2. To open the Printing Preferences window, select your printer, then click the Printer Properties,
Print Options, or Preferences button. The title of the button can vary, depending on your
application.

3. Click a tab in the Printing Preferences window, then make selections.

4. To save your selections and close the Printing Preferences window, click OK.

5. To send the job to the printer, click Print.
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SSeelleeccttiinngg FFiinniisshhiinngg OOppttiioonnss ffoorr WWiinnddoowwss
If your printer has a finisher installed, you can select finishing options in the Properties window of the
print driver. Finishing options allow you to select how your document is delivered. For example, you
can select hole-punching, stapling, folding, or printing in a booklet format.

Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

To select finishing options in the PostScript and PCL print drivers:

1. In the print driver, click the Printing Options tab.

2. To select a finishing option, for Finishing, click the arrow.

Note: The print driver displays stapling positions for paper fed on the long edge. If paper
feeds on the short edge instead of the long edge, the finisher can insert the staple in the
wrong location.

3. To select the output tray, for Output Destination, click the arrow, then select an option:
• Automatic: This option determines the output destination based on the number of sets and

the stapling option selected. The printer sends multiple sets or stapled sets to the finisher
output tray.

• Center Tray: This option selects the output tray that is in the middle of the Offset Catch Tray,
or the selected finisher.

• Center Bottom Tray: This option selects the output tray that is on the bottom of the Offset
Catch Tray.

• Left Tray: This option selects the output tray that is on the left side of the printer or the
selected finisher.

• Finisher Tray: This option selects the output tray that is on the Global Integrated Office
Finisher.

• Right Tray: This option selects the output tray that is on top of the Office Finisher.
• Right Top Tray: This option selects the output tray that is on top of the Business Ready

Finisher.
• Right Middle Tray: This option selects the output tray that is in the middle of the Business

Ready Booklet Maker Finisher.
• Right Bottom Tray: This option selects the output tray that is on the bottom of the Business

Ready Finisher when the optional Booklet Maker is not installed.

4. To send the job to the printer, click OK, then click Print.
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SSeelleeccttiinngg PPrriinnttiinngg DDeeffaauullttss iinn WWiinnddoowwss ffoorr aa SShhaarreedd NNeettwwoorrkk
PPrriinntteerr
1. On your computer, navigate to the list of printers:

• For Windows Server 2008 and later, click Start→Settings→Printers.
• For Windows 7, click Start→Devices and Printers.
• For Windows 8, click Start→Control Panel→Devices and Printers.
• For Windows 10, click Start→Settings→Devices→Printers & scanners.

Note: If the Control Panel icon does not appear on the desktop, right-click the desktop,
then select Personalize→Control Panel Home→Devices and Printers.

2. For your printer, select Printer properties:
• For Windows Server 2008 or later, Windows 7, or Windows 8, right-click the icon for your

printer, then click Printing properties.
• For Windows 10, click the icon for your printer, then clickManage→Printer properties.

3. In the printer Properties dialog box, click the Advanced tab.

4. On the Advanced tab, click Printing Defaults.

5. On the print driver tabs, make your selections as needed, then click Apply.

6. To save the settings, click OK.

SSaavviinngg aa SSeett ooff CCoommmmoonnllyy UUsseedd PPrriinnttiinngg OOppttiioonnss ffoorr WWiinnddoowwss
You can define and save a set of options, so that you can apply them to future print jobs. After you
save a set of print options, they are available for selection from the Saved Settings or Presets list, or
the 1–Touch area, if available.

To save a set of printing options:

1. With the document open in your application, click File→Print.

2. To open the Printing Preferences window, select your printer, then click Properties or Preferences.

3. In the Printing Properties window, click the tabs, then select the required settings.

4. In the Printing Properties window, click Saved Settings or Presets, then click Save As.

5. Type a name for the saved setting or preset, then choose preset options, if available:
• Choose an icon for the preset.
• To enable the preset as 1–Touch, select 1–Touch Preset.
• To share the preset in all print drivers, select Show this Preset in All Drivers.

6. Click OK.

7. To print with these settings:
• From the Saved Settings or Presets list, select the name of the preset.
• For a 1–Touch preset, click 1–Touch, then click the required 1–Touch preset.
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MMaacciinnttoosshh PPrriinnttiinngg OOppttiioonnss

SSeelleeccttiinngg PPrriinnttiinngg OOppttiioonnss ffoorr MMaacciinnttoosshh
To use specific printing options, change the settings before sending the job to the printer.

1. With the document open in your application, click File→Print.

2. Select your printer.

3. In the Print window, in the print options list, click Xerox Features.

Note: To see all printing options, click Show Details.

4. Select any other required printing options from the lists.

5. To send the job to the printer, click Print.

SSeelleeccttiinngg FFiinniisshhiinngg OOppttiioonnss ffoorr MMaacciinnttoosshh
If your printer has a finisher installed, select finishing options in the Xerox® Features of the print
driver.

To select finishing options in the Macintosh print driver:

1. In the Print window, in the print options list, click Xerox Features.

2. To select a finishing option, click the arrow to the right of the Finishing field, then select an
option.

3. To select the output tray, click the arrow to the right of the Output Destination field, then select
an option.
• Automatic: This option determines the output destination based on the number of sets and

the stapling option selected. The printer sends multiple sets or stapled sets to the finisher
output tray.

• Center Tray: This option selects the output tray in the middle of the Offset Catch Tray, the
Office Finisher, or the Business Ready Finisher.

• Center Bottom Tray: This option selects the output tray on the bottom of the Offset Catch
Tray.

• Finisher Tray: This option selects the output tray on the Integrated Office Finisher.
• Left Tray: This option selects the output tray on the left side of the printer.
• Right Tray: This option selects the output tray on top of the Office Finisher.
• Right Top Tray: This option selects the output tray on top of the Business Ready Finisher.
• Right Middle Tray: This option selects the output tray that is in the middle of the Business

Ready Booklet Maker Finisher.
• Right Bottom Tray: This option selects the output tray that is on the bottom of the Business

Ready Finisher when the optional Booklet Maker is not installed.

4. To send the job to the printer, click Print.
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SSaavviinngg aa SSeett ooff CCoommmmoonnllyy UUsseedd PPrriinnttiinngg OOppttiioonnss ffoorr MMaacciinnttoosshh
You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

1. With the document open in your application, click File→Print.

2. Select your printer from the Printers list.

3. Select the required printing options from the lists in the Print dialog box.

Note: To see all printing options, click Show Details.

4. Click Presets→Save Current Settings as Preset.

5. Type a name for the printing options. To save the set of options in the Presets list, click OK.

6. To print using these options, select the name from the Presets list.

UUNNIIXX,, LLiinnuuxx,, aanndd AASS//440000 PPrriinnttiinngg
To provide printer spooling and network print server functionality, UNIX-based printing uses LPD/LPR
port 515 or lp to port 9100. Xerox printers can communicate using either protocol.

XXeerrooxx®® PPrriinntteerr MMaannaaggeerr
Xerox® Printer Manager is an application that allows you to manage and print to multiple printers in
UNIX and Linux environments.

Xerox® Printer Manager allows you to:

• Configure and check the status of network connected printers.

• Set up a printer on your network and monitor the operation of the printer once installed.

• Perform maintenance checks and view supplies status at any time.

• Provide a common look and feel across the many different suppliers of UNIX and Linux operating
systems.
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Installing Xerox® Printer Manager
Before you begin, ensure that you have root or superuser privileges to install Xerox® Printer Manager.

To install Xerox® Printer Manager:

1. Download the appropriate package for your operating system. To locate print drivers for your
printer, go to www.xerox.com/office/ALC81XXdrivers. The files available are:
• XeroxOSDPkg-AIXpowerpc-x.xx.xxx.xxxx.rpm for the IBM PowerPC family.
• XeroxOSDPkg-HPUXia64-x.xx.xxx.xxxx.depot.gz to support HP Itanium workstations.
• XeroxOfficev5Pkg-Linuxi686-x.xx.xxx.xxxx.rpm to support RPM-based 32-bit Linux

environments.
• XeroxOfficev5Pkg-Linuxi686-x.xx.xxx.xxxx.deb to support Debian-based 32-bit Linux

environments.
• XeroxOfficev5Pkg-Linuxx86_64-x.xx.xxx.xxxx.rpm to support RPM-based 64-bit Linux

environments.
• XeroxOfficev5Pkg-Linuxx86_64-x.xx.xxx.xxxx.deb to support Debian-based 64-bit Linux

environments.
• XeroxOSDPkg-SunOSi386-x.xx.xxx.xxxx.pkg.gz for Sun Solaris x86 systems.
• XeroxOSDPkg-SunOSsparc-x.xx.xxx.xxxx.pkg.gz for Sun Solaris SPARC systems.

2. To install the custom print driver, log in as root, then type the appropriate command for your
system:
• AIX: rpm -U XeroxOSDPkg-AIXpowerpc-x.xx.xxx.xxxx.rpm
• HPUX: swinstall -s XeroxOSDPkg-HPUXia64-x.xx.xxx.xxxx.depot.gz \*
• Solaris, x86 based: pkgadd -d XeroxOSDPkg-SunOSi386-x.xx.xxx.xxxx.pkg
• Solaris, SPARC based: pkgadd -d XeroxOSDPkg-SunOSsparc-x.xx.xxx.xxxx.pkg

The installation creates a Xerox directory in /opt/Xerox/prtsys.

3. To install the Xerox® Office Standard Driver on Linux platform, log in as root, then type the
appropriate command for your system:
• Linux, RPM based: rpm -U XeroxOfficev5Pkg-Linuxi686-x.xx.xxx.xxxx.rpm
• Linux, Debian based: dpkg -i XeroxOfficev5Pkg-Linuxi686-x.xx.xxx.xxxx.deb

The installation creates a XeroxOffice directory in /opt/XeroxOffice/prtsys.

Launching Xerox® Printer Manager
To launch Xerox® Printer Manager:

1. From your computer, access a command window. At the command prompt, log in as root, then
type xeroxofficeprtmgr.

2. Press Enter or Return.

PPrriinnttiinngg ffrroomm aa LLiinnuuxx WWoorrkkssttaattiioonn
To print from a Linux workstation, install either a Xerox® print driver for Linux or a CUPS (Common
UNIX Printing System) print driver. You do not need both drivers.

Xerox recommends that you install one of the full-featured custom print drivers for Linux. To locate
drivers for your printer, go to www.xerox.com/support/drivers.

If you use CUPS, ensure that CUPS is installed and running on your workstation. The instructions for
installing and building CUPS are contained in the CUPS Software Administrators Manual, written and
copyrighted by Easy Software Products. For complete information on CUPS printing capabilities, refer
to the CUPS Software Users Manual available from www.cups.org/documentation.php.
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Installing the PPD File on the Workstation
1. On the Xerox Support website, from the Drivers and Downloads page, download the Xerox® PPD

for CUPS (Common UNIX Printing System).

2. Copy the PPD file into the CUPS ppd/Xerox folder on your workstation. If you are unsure of the
location of the folder, use the Find command to locate the PPD files.

3. Follow the instructions that are included with the PPD file.

Adding the Printer
1. Verify that the CUPS (Common UNIX Printing System) daemon is running.

2. Open a Web browser, type http://localhost:631/admin, then press Enter or Return.

3. For User ID, type root. For password, type the root password.

4. Click Add Printer, then follow the onscreen prompts to add the printer to the CUPS printer list.

Printing with CUPS (Common UNIX Printing System)
CUPS supports the use of both the System V (lp) and Berkeley (lpr) printing commands.

1. To print to a specific printer in System V, type lp -dprinter filename, then press Enter.

2. To print to a specific printer in Berkeley, type lpr -Pprinter filename, then press Enter.

MMoobbiillee PPrriinnttiinngg OOppttiioonnss
This printer can print from iOS and Android mobile devices.

PPrriinnttiinngg wwiitthh WWii--FFii DDiirreecctt
You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or
smartphone, using Wi-Fi Direct.

For details, refer to Connecting with Wi-Fi Direct.

For details on using Wi-Fi Direct, refer to the documentation provided with your mobile device.

Note: Depending on which mobile device you are using, the printing procedure varies.

PPrriinnttiinngg wwiitthh AAiirrPPrriinntt
You can print directly from your iPhone, iPad, iPod touch, or Mac using AirPrint®. To enable AirPrint®
for your printer, refer to Configuring AirPrint.

To print with AirPrint®:

1. Open the email, photograph, webpage, or document that you want to print.

2. Tap the Action icon.

3. Tap Print.

4. Select your printer, then set the printer options.

5. Tap Print.

For more information on configuring and using AirPrint®, refer to the Using Apple® AirPrint® with
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Xerox® AltaLink® Multifunction Printers User Guide.

PPrriinnttiinngg ffrroomm aa MMoopprriiaa--EEnnaabblleedd MMoobbiillee DDeevviiccee
Mopria is a software feature that enables users to print from mobile devices without requiring a print
driver. You can use Mopria to print from your mobile device to Mopria-enabled printers.

Note:

• Mopria and all of its required protocols are enabled by default.

• Ensure that you have the latest version of the Mopria Print Service software installed on
your mobile device. You can obtain a free download of the software from the Google Play
Store.

• To connect the printer to Wi-Fi or Wi-Fi Direct, purchase and install the Xerox Wireless
Network Adapter. For more information, refer to the Xerox® Dual Band Wireless Kit
Hardware Install and Setup instructions that are included with the kit.

• To use Wi-Fi Direct, in the Embedded Web Server, enable the Wi-Fi Direct feature. For details
on configuring Wi-Fi Direct, refer to the System Administrator Guide at www.xerox.com/
office/ALC81XXdocs.

• To configure the Wireless settings, ensure that devices are connected to the same wireless
network as the printer.

• The name and location of your printer appears in a list of Mopria-enabled printers on
connected devices.

To print using Mopria, follow the directions that are provided with your mobile device.
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Print Jobs
MMaannaaggiinngg JJoobbss
From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs.
You can pause, delete, print, or view job progress or job details for a selected job. When you send a
secure print job, the job is held until you release it by typing a passcode at the control panel. For
details, refer to Printing Special Job Types

From the Jobs window in the Embedded Web Server, you can view a list of active and saved print jobs.

PPaauussiinngg,, PPrroommoottiinngg,, oorr DDeelleettiinngg aa JJoobb WWaaiittiinngg ttoo PPrriinntt
1. At the printer control panel, press the Home button.

2. Touch Jobs, then touch the name of the required print job.

3. Select a task.

Note: If you do not make a selection, the job automatically resumes after the set timeout
period.

• To pause the print job, touch Hold. To resume the print job, touch Release.
• To delete the print job, touch Delete. At the prompt, touch Delete.
• To move the job to the top of the list, touch Promote.
• To view the status of the job, touch Job Progress.
• To view information about the job, touch Job Details, then touch Job Settings or Required

Resources.

4. To return to the Home screen, press the Home button.

Note:

• The system administrator can restrict users from deleting jobs. If a system
administrator restricts job deletion, you can view the jobs, but you cannot delete them.

• Only the user that sent the job, or the system administrator, can delete a Secure Print
job.

PPrriinnttiinngg aa JJoobb HHeelldd ffoorr RReessoouurrcceess
1. At the printer control panel, press the Home button.

2. Touch Jobs.

3. From the jobs list, touch the held job name. The resources required for the job appear on the
control panel.
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4. Do one of the following steps.
• To print the job, replenish the resources required. The job resumes automatically when the

required resources are available. If the job does not print automatically, touch Resume.
• To choose an alternative paper source to enable the job to print, touch Print On Alternate

Paper. Select a paper tray, then touch OK.
• To delete the print job, touch Delete. At the prompt, touch Delete.

Note: The Print On Alternate Paper option is enabled using the Embedded Web Server. For
details about the Print On Alternate Paper option, refer to the System Administrator Guide
at www.xerox.com/office/ALC81XXdocs.

5. To return to the Home screen, press the Home button.

PPrriinnttiinngg SSppeecciiaall JJoobb TTyyppeess
Special job types allow you to send a print job from your computer, then print it from the printer
control panel. Select special job types in the print driver, Printing Options tab, under Job Type.

SSaavveedd JJoobb
Saved Jobs are documents that are sent to the printer and stored there for future use. All users can
print or delete a Saved Job.

At the control panel, from the Print From menu, you can view and print saved jobs. In the Embedded
Web Server, in the Jobs window, you can view, print, and delete saved jobs, and you can manage
where jobs are stored.

Printing using Saved Job
1. In your software application, access the print settings. For most software applications, press CTRL

+P for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
• For Windows, click Printer Properties. Depending on your application, the title of the button

can vary.
• For Macintosh, in the Print window, in the print options list, click Xerox Features.

3. For Job Type, select Saved Job.

a. Type a job name or select a name from the list.

b. Type a folder name or select a name from the list.

c. To add a passcode, click Private, type the passcode, then confirm the passcode.

d. Click OK.

4. Select other required printing options.
• For Windows, click OK, then click Print.
• For Macintosh, click Print.

Print, Delete, Move, or Copy a Saved Job in the Embedded Web Server
1. At your computer, open a Web browser. In the address field, type the IP address of the printer,

then press Enter or Return.

2. In the Embedded Web Server, click Home.

3. Click Jobs.
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4. Click the Saved Jobs tab.

5. For the job that you want to process, select the check box.

6. From the menu, select an option.
• Print Job: This option prints a job immediately.
• Delete Job This option deletes the saved job.
• Move Job: Use this option to move the job to another folder location.
• Copy Job: Use this option to duplicate the job.

7. Click Go.

SSeeccuurree PPrriinntt
Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the
printer until you enter your passcode at the printer control panel.

After a Secure Print job is printed, it is deleted automatically.

Printing using Secure Print
1. In your software application, access the print settings. For most software applications, press CTRL

+P for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
• For Windows, click Printer Properties. Depending on your application, the title of the button

varies.
• For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Secure Print.

4. Type the passcode, confirm the passcode, then click OK.

5. Select any other required printing options.
• For Windows, click OK, then click Print.
• For Macintosh, click Print.

Releasing a Secure Print job
1. At the printer control panel, press the Home button.

2. Touch Jobs.

3. To view Secure Print jobs, touch Secure Jobs.

4. Do one of the following:
• If you submitted a single Secure Print job, touch the folder, then touch the job. Enter the

passcode number, then touch OK. The job prints automatically.
• If you submitted multiple Secure Print jobs, touch the folder, enter the passcode number, then

touch OK. Select an option:

• To print a single Secure Print job, touch the job required.

• To print all the jobs in the folder, touch Print All.

• To delete a single Secure Print job, touch the Trash icon. At the prompt, touch Delete.

• To delete all the jobs in the folder, touch Delete All.

Note: After a Secure Print job prints, the printer deletes it automatically.

5. To return to the Home screen, press the Home button.
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SSaammppllee SSeett
The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining
copies. After reviewing the sample set, you can either print the remaining copies or delete them at
the printer control panel.

Sample Set is a type of saved job with these features:

• A Sample Set job appears in a folder named after the user ID associated with the print job.

• A Sample Set job does not use a passcode.

• Any user can print or delete a Sample Set job.

• A Sample Set prints one copy of a job to allow you to proofread the job before printing any
remaining copies.

After a Sample Set job is printed, it is deleted automatically.

To print a Sample Set, refer to Printing using Sample Set.

Printing using Sample Set
1. In your software application, access the print settings. For most software applications, press CTRL

+P for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
• For Windows, click Printer Properties. Depending on your application, the title of the button

varies.
• For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Sample Set.

4. Select any other required printing options.
• For Windows, click OK, then click Print.
• For Macintosh, click Print.

Releasing a Sample Set
1. At the printer control panel, press the Home button.

2. To view available jobs, touch Jobs.

3. Touch the Sample Set job.

Note: The Sample Set file description shows the job as Held for Future Printing, and shows
the number of remaining copies of the job.

4. Select an option.
• To print the remaining copies of the job, touch Release.
• To delete the remaining copies of the job, touch Delete.

5. To return to the Home screen, press the Home button.
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Printing Features

SSeelleeccttiinngg PPaappeerr OOppttiioonnss ffoorr PPrriinnttiinngg
There are two ways to select the paper for your print job. You can let the printer select which paper to
use based on the document size, paper type, and paper color you specify. You can also select a
specific tray loaded with the desired paper.

• To locate paper options in Windows, in the print driver, click the Printing Options tab.

• To locate paper options on Macintosh, in the Print window, in the print options list, click Xerox
Features. Within Xerox Features, in the options list, click Paper/Output.

SSeelleecctt BByy TTrraayy
Use Select By Tray to print from a specific tray without specifying paper attributes in the print driver
or at the printer control panel. This option prints the job from the selected tray, even when more than
one tray contains the correct paper for the job.

The following options are available:

• Automatically Select: This option prints from any tray that is loaded with the size and type of
paper that is required for the print job.

• Tray X: This option prints from the selected tray.

• Bypass Tray: This option prints from the manual-feed tray. The printer prompts you to remove
any other paper from the tray and load the paper that is required for your job.

Note:

• Load the Bypass Tray with the correct size and type of paper for the print job.

• For banner paper, ensure that you select the appropriate paper-size setting, then load
banner paper in the Bypass Tray. For details, refer to Banner Paper.

SSccaalliinngg
Scaling reduces or enlarges the original document to match the selected output paper size.

• For Windows, the scale options are on the Printing Options tab, in the Paper field.

• For Macintosh, the scale options are in the Print window. To view more printing options, click Show
Details.

Note: Not all options described are supported on all printers. Some options apply only to a
specific printer model, configuration, operating system, or print driver type.

The following scaling options are available:

• Fit to New Paper Size: This option scales the document to fit the new paper size.

• Change Document Size: Use this setting to match the paper size selected in your application.
This option does not change the size of the page image printed on the output paper.

• Automatically Scale: This option scales the document to fit the selected Output Paper Size. The
scaling amount appears in the percentage box below the sample image.
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• No Scaling: This option does not change the size of the page image printed on the output paper,
and 100% appears in the percentage box. If the original document size is larger than the output
size, the page image is cropped. If the original document size is smaller than the output size, extra
space appears around the page image.

• Manually Scale: This option scales the document by the amount entered in the percentage box
below the preview image.

PPrriinnttiinngg oonn BBootthh SSiiddeess ooff tthhee PPaappeerr

PPrriinnttiinngg aa 22--SSiiddeedd DDooccuummeenntt
If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The
print driver uses the settings for portrait or landscape orientation from the application for printing the
document.

Note: Ensure that the paper size and weight are supported. For more information, refer to
Supported Paper.

22--SSiiddeedd PPaaggee LLaayyoouutt OOppttiioonnss
You can specify the page layout for 2-sided printing, which determines how the printed pages turn.
These settings override the application page orientation settings.

• 1-Sided Print: This option prints on one side of the media. Use this option when printing on
envelopes, labels, or other media that cannot be printed on both sides.

• 2-Sided Print: This option prints the job on both sides of the paper to allow binding on the long
edge of the paper. The following illustrations show the result for documents with portrait and
landscape orientations, respectively:

• 2-Sided Print, Flip on Short Edge: This option prints on both sides of the paper. The images print
to allow binding on the short edge of the paper. The following illustrations show the result for
documents with portrait and landscape orientations, respectively:

Note: 2–Sided Printing is part of the Earth Smart settings.

To change your default print driver settings, refer to Selecting Printing Options.

XXeerrooxx BBllaacckk aanndd WWhhiittee
You can select printing in color or black and white.
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• Off (use Document Color): Use this option to print in color.

• On: Use this option to print in black and white.

PPrriinntt QQuuaalliittyy
The Windows PostScript print driver and the Macintosh print drivers provide the highest print-quality
modes:

• High Resolution: 1200 x 1200 dpi, 1-bit depth. This mode provides the best overall image quality
for detailed line drawings, such as CAD files. High Resolution is recommended for printing vibrant,
saturated, color prints or photos. Print jobs can take longer to process when printed using High
Resolution mode.

• Enhanced: 600 x 600 dpi, 8-bit depth. This mode is used for better print quality, and is the best
mode to use for business presentations. Enhanced mode takes longer to process than Standard or
Toner Saver.

• Toner Saver: 600 x 600 dpi, 1-bit depth. This mode is used for document preview, and is optimized
for quickest print processing. Toner Saver is useful for draft-quality output.

IImmaaggee OOppttiioonnss
Image options control the way the printer uses color to produce your document. The Windows
PostScript print driver and the Macintosh print drivers provide the widest range of color controls and
corrections on the Image Options tab.

• To locate color options in Windows, in the print driver, click the Image Options tab.

• To locate color options on Macintosh, in the Print window, in the print options list, click Xerox
Features. Within Xerox Features, in the options list, click Color Options.

CCoolloorr CCoorrrreeccttiioonn
Color Correction matches printer colors on PostScript jobs to colors on other devices, such as your
computer screen or a printing press.

Color Correction options:

• Xerox Black and White: This option converts all color in the document to black and white, or
shades of gray.

• Xerox Automatic Color: This option applies the best color correction to text, graphics, and images.
Xerox recommends this setting.

There are more Color Correction options, including Vivid RGB and Commercial.

CCoolloorr bbyy WWoorrddss
Color By Words allows you to adjust colors by building sentences using common phrases describing
how to change colors.

For more information, refer to the help for your print driver.
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CCoolloorr AAddjjuussttmmeennttss
Use Color Adjustments to adjust particular characteristics of the printed color. Characteristics include
lightness, contrast, saturation, and color cast.

Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or driver type.

The following options are available:

• Lightness: The Lightness feature allows you to adjust the overall lightness or darkness of the text
and images in your printed job.

• Contrast: You can use the Contrast feature to adjust the variation between light and dark areas of
the print job.

• Saturation: The Saturation feature allows you to adjust the color strength and the amount of
gray in the color.

• Color Cast: Use the Color Cast settings to adjust the amount of a selected color in the print job
and preserve lightness. The following settings are available:

– The Cyan to Red slider allows you to adjust the color balance between cyan and red. For
example, when you increase the cyan levels, the red levels decrease.

– The Magenta to Green slider allows you to adjust the color balance between magenta and
green. For example, when you increase the magenta levels, the green levels decrease.

– The Yellow to Blue slider allows you to adjust the color balance between yellow and blue. For
example, when you increase the yellow levels, the blue levels decrease.

PPrriinnttiinngg MMuullttiippllee PPaaggeess ttoo aa SSiinnggllee SShheeeett
When printing a multiple-page document, you can print more than one page on a single sheet of
paper.

To print 1, 2, 4, 6, 9, or 16 pages per side, on the Page Layout tab, select Pages Per Sheet.

• To locate Pages Per Sheet in Windows, on the Document Options tab, click Page Layout.

• To locate Pages Per Sheet on Macintosh, in the Print window, in the print options list, click Layout.

To print a border around each page, select Page Borders.

PPrriinnttiinngg BBooookklleettss
With 2-sided printing, you can print a document in the form of a small booklet. You can create
booklets from any paper size that is supported for 2-sided printing.

The print driver automatically reduces each page image and prints four page images per sheet of
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paper, two page images on each side. The pages are printed in the correct order so that you can fold
and staple the pages to create the booklet.

• To locate booklet creation in Windows, on the Document Options tab, click Page Layout.

• To locate booklet creation on Macintosh, in the Print window, in the print options list, click Xerox
Features. Within Xerox Features, in the options list, click Booklet Layout.

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter
and creep.

• Gutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm
(1/72 in.).

• Creep: Specifies how much the page images shift outward in tenths of a point. Shifting
compensates for the thickness of the folded paper, which can cause the page images to shift
outward slightly when folded. You can select a value from zero to 1 point.

Gutter Creep

Note: To print a border around each page, select Page Borders.

UUssiinngg SSppeecciiaall PPaaggeess
The Special Pages options control how covers, inserts, and exception pages are added to your printed
document.

• To locate Special Pages in Windows, on the Document Options tab, click Special Pages.

• To locate Special Pages on Macintosh, in the Print window, in the print options list, click Xerox
Features. Within Xerox Features, in the options list, click Special Pages.

PPrriinnttiinngg CCoovveerr PPaaggeess
A cover page is the first or last page of a document. You can select paper sources for the cover pages
that are different from the source used for the body of a document. For example, you can use your
company letterhead for the first page of a document. You can use heavyweight paper for the first and
last pages of a report. You can use any applicable paper tray as the source for printing cover pages.

In the Covers window, the following options are available:

• No Covers or Disabled: This option does not print cover pages. No cover pages are added to the
document.

• Front Only: This option allows you to add a blank or printed front cover to your job.
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• Back Only: This option allows you to add a blank or printed back cover to your job.

• Front and Back: Same: This option adds a front and back cover to your job, and applies the same
printing and paper settings for both covers.

• Front and Back: Different: This option adds a front and back cover to your job, and allows you to
select different printing and paper settings for each cover.

After you make a selection for printing the cover pages, you can select the paper for the front and
back covers by size, color, or type. You can use blank or pre-printed paper, and you can print side one,
side two, or both sides of the cover pages.

PPrriinnttiinngg IInnsseerrtt PPaaggeess
You can add blank or pre-printed insert pages before page one of each document or after designated
pages within a document. The addition of an insert after designated pages within a document
separates sections, or acts as a marker or placeholder. Ensure that you specify the paper to use for the
insert pages.

In the Inserts window, you can set the location, characteristics, and paper settings for the insert
pages:

• Inserts: This option allows you to select where to place the insert.

• Quantity: Use this option to specify the number of pages to insert at each location.

• Pages: Use this option to specify where to place the inserts within the job. Separate individual
pages or page ranges with commas. Specify pages within a range with a hyphen. For example, to
specify pages 1, 6, 9, 10, and 11, type 1,6,9-11.

• Paper Settings: This option allows you to select the paper size, color, and type to use for the insert
pages. To use the same paper size, color, or type as the main body of the job, select Use Job
Setting.

PPrriinnttiinngg EExxcceeppttiioonn PPaaggeess
Exception pages have different settings from the rest of the pages in the job. You can specify
differences, such as page size, page type, and page color. You can change the side of the paper on
which to print as your job requires. A print job can contain multiple exceptions.

For example, your print job contains 30 pages. You want five pages to print on only one side of a
special paper, and the remainder of the pages printed 2-sided on regular paper. You can use
exception pages to print the job.

In the Exceptions window, you can set the location, characteristics, and paper settings for the
exception pages:

• Pages: Specifies the page or range of pages that use the exception page characteristics. Separate
individual pages or page ranges with commas. Specify pages within a range with a hyphen. For
example, to specify pages 1, 6, 9, 10, and 11, type 1,6,9-11.

• Paper Settings: Allows you to select the paper size, color, and type to use for the exception pages.
To print exception pages on the same paper size, color, or type as the main body of the job, select
Use Job Setting.

• 2-Sided Printing: Allows you to select 2-sided printing options for the exception pages. Available
options are:
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– 1-Sided Print: Prints the exception pages on one side only.

– 2-Sided Print: Prints the exception pages on both sides of the paper and flips the pages on
the long edge. You can bind the job on the long edge of the pages.

– 2-Sided Print, Flip on Short Edge: Prints the exception pages on both sides of the paper and
flips the pages on the short edge. You can bind the job on the short edge of the pages.

– Use Job Setting: Prints the job using the same 2–Sided Printing setting that is selected for the
main body of the job.

Note: Some combinations of 2-sided printing with certain paper types and sizes can produce
unexpected results.

PPrriinnttiinngg AAnnnnoottaattiioonnss ffoorr WWiinnddoowwss
An annotation is special-purpose text or an image that you can print across one or more pages. You
can preview annotations in the Annotations Preview pane.

The annotations setup for your print job appears in the Annotations summary list. From this list, you
can select an annotation to edit or delete.

Note:

• This feature is available only on a Windows computer printing to a network printer.

• Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

To print an annotation:

1. In the print driver, click the Document Options tab.

2. Click the Annotations tab.

3. To add a text annotation, click Add Comment. Enter the text in the field, select the required
settings, then click OK.

4. For a date or time stamp, click Add Time Stamp. Specify the date and time option, select the
required settings, then click OK.

5. To add a picture annotation, click Add Picture. To locate the picture, click the Browse icon. Select
the required settings, then click OK.

170 Xerox® AltaLink® C81XX Series Color Multifunction Printer
User Guide

Printing



6. For each annotation, the following options are available:

• To specify the font, click the Font button.

• For a picture annotation, select the scaling option that specifies the size of the picture in
relation to the original image. Use the arrows to scale the image in increments of 1%.

• To define the angle of the annotation on the page, specify the position option. Or, to rotate
the annotation left or right by increments of 1, use the arrows.

• To define the location of the annotation on the page, specify the position option. Or, to move
the annotation in each direction in increments of 1, use the arrows.

• To adjust the transparency of the annotation, move the slider. To increase transparency, move
the slider to the right, or to decrease transparency, move the slider to the left.

• For Layering, select an option:

– Print in Background: This option prints the annotation behind the text and graphics in
the document.

– Print in Foreground: This option prints the annotation over the text and graphics in the
document.

• For Pages, select the pages to print the annotation:

– Print on All Pages: This option prints the annotation on all pages of your document.

– Print on Page 1 Only: This option prints the annotation only on the first page of the
document.

7. To save the annotation, click the Save Annotation icon.

8. To load a previously saved annotation, click the Load Annotation icon.

9. Click OK.

PPrriinnttiinngg WWaatteerrmmaarrkkss ffoorr WWiinnddoowwss
A watermark is special purpose text that can be printed across one or more pages. For example, you
can add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document
before distribution.

Note:

• This feature is available only on a Windows computer printing to a network printer.

• Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

• Watermarks are not supported for some print drivers when booklet is selected or when more
than one page is printed on a sheet of paper.

To print a watermark:

1. In the print driver, click the Document Options tab.

2. Click theWatermark tab.

3. From the Watermark menu, select the watermark. You can choose from preset watermarks, or
create a customized watermark. You can also manage watermarks from this menu.
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4. Under Text, select an option:
• Text: Enter the text in the field, then specify the font.
• Time Stamp: Specify the date and time options, then specify the font.
• Picture: To locate the picture, click the Browse icon.

5. Specify the scaling angle and position of the watermark.
• Select the scaling option that specifies the size of the picture in relation to the original image.

Use the arrows to scale the image in increments of 1%.
• To define the angle of the image on the page, specify the position option, or to rotate the

image left or right by increments of 1, use the arrows.
• To define the location of the image on the page, specify the position option, or to move the

image in each direction in increments of 1, use the arrows.

6. Under Layering, select how to print the watermark.
• Print in Background prints the watermark behind the text and graphics in the document.
• Blend: This option combines the watermark with the text and graphics in the document. A

blended watermark is translucent, so you can see both the watermark and the document
content.

• Print in Foreground prints the watermark over the text and graphics in the document.

7. Click Pages, then select the pages to print the watermark:
• Print on All Pages prints the watermark on all pages of your document.
• Print on Page 1 Only prints the watermark only on the first page of the document.

8. If you select a picture as a watermark, specify the lightness settings for the image.

9. Click OK.

OOrriieennttaattiioonn
Orientation allows you to select the direction that the page prints.

• To locate orientation options in Windows, on the Document Options tab, click Orientation.

Note: The orientation setting in your application print dialog box can override the orientation
options in the print driver.

• To locate orientation options on Macintosh, in the Print window, click Show Details.

The following options are available:

• Portrait: Orients the paper so that the text and images print across the short dimension of the
paper.

• Landscape: Orients the paper so that the text and images print across the long dimension of the
paper.

• Rotated Landscape: Orients the paper so that the content is rotated 180 degrees and with the
long bottom side up.
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Note: For Macintosh, to print portrait text and images in landscape orientation, clear the Auto
Rotate check box.

AAddvvaanncceedd PPrriinnttiinngg OOppttiioonnss
You can use the Advanced option or tab to set advanced printing options. Advanced printing
selections apply to all jobs that you print with the print driver.

Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

JJoobb IIddeennttiiffiiccaattiioonn
You can use the Job ID feature to change the job identification setting for your print job. You can
print the job identification on a separate banner page or on the pages of your document.

The following options are available:

• Disable Job ID: This option directs the printer not to print a banner page.

• Print ID on a Banner Page: This option prints the job identification on a banner page.

• Print ID in Margins - First Page Only: This option prints the job identification on the first page of
the document in the top-left margin.

• Print ID in Margins - All Pages: This option prints the job identification in the top-left margin on
every page of the document.

PPrriinnttiinngg MMiirrrroorr IImmaaggeess
If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right
when printed.

JJoobb NNoottiiffiiccaattiioonn ffoorr WWiinnddoowwss
You can select to be notified when your job finishes printing. A message appears on your computer
screen with the name of the job and the name of the printer where it was printed.

Note: This feature is only available on a Windows computer that is printing to a network
printer.

The following options are available:

• Notify for Completed Jobs: This option provides a notification when the job has completed.

• Notify for Completed, but Altered Jobs: This option provides a notification on all jobs that
completed with restrictions.

• Notify for Failed or Canceled Jobs: This option provides notification of all jobs that failed to print
or were canceled.
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• Play Alert Tone: This option sounds an alert tone when a notification appears.

DDooccuummeenntt EEnnccrryyppttiioonn ffoorr WWiinnddoowwss PPrriinntt JJoobbss
You can select encryption for your print job. The print file is encrypted before it is transmitted to the
printer. The print file is decrypted before it is printed.

This feature is available only when Document Encryption is set to Manually Encrypt Documents in the
printer properties of the printer. For details, refer to Setting Encryption Defaults in Windows.

Note: This feature is available on a Windows computer that is printing to a network printer. It
applies to the PostScript and PCL print drivers.

Setting Encryption Defaults in Windows
1. Navigate to the list of printers on your computer:

• For Windows Server 2008 and later, click Start→Settings→Printers.
• For Windows 7, click Start→Devices and Printers.
• For Windows 8, click Start→Control Panel→Devices and Printers.
• For Windows 10, click the Windows Start→Settings→Devices→Printers & Scanners.

Note: If the Control Panel icon does not appear on the desktop, right-click the desktop,
then select Personalize. Select Control Panel Home→Devices and Printers.

2. For your printer, select Printing properties:
• For Windows Server 2008 or later, Windows 7, or Windows 8, right-click the icon for your

printer, then click Printer properties.
• For Windows 10, click the icon for your printer, then clickManage→Printer properties.

3. In the Printer Properties dialog box, click the Administration tab.

4. For Configurations, click Document Encryption, then select an option:
• Disabled: This option disables encryption for all documents that you send to the printer.
• Encrypt All Documents: This option encrypts all documents that you send to the printer.
• Manually Encrypt Documents: This option allows you to set encryption for specific jobs that

you send to the printer.

Note:Manually Encrypt Documents is the default printer setting.

5. Click Apply.

6. To save the settings, click OK.
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Using Custom Paper Sizes
You can print on custom paper sizes that are within the minimum and maximum size range supported
by the printer. For details, refer to Supported Paper.

DDeeffiinniinngg CCuussttoomm PPaappeerr SSiizzeess
To print on custom paper sizes, define the custom width and length of the paper in the print driver
software and on the printer control panel. When setting the paper size, ensure that you specify the
same size as the paper in the tray. Setting the wrong size can cause a printer error. Print driver
settings override control panel settings when you print using the print driver software on your
computer.

Note: To print using long media or banner paper, select the appropriate banner paper size, or
define a new custom paper size.

CCrreeaattiinngg aanndd SSaavviinngg CCuussttoomm PPaappeerr SSiizzeess iinn tthhee PPrriinntt DDrriivveerr
Custom-size paper settings are saved in the print driver and are available for you to select in all your
applications.

Use the custom-size paper settings to define a custom paper size for long media or banner paper.

For details on supported paper sizes for each tray, refer to Supported Paper.

For further details about creating and saving custom paper sizes in the print driver, click the Help (?)
button in the bottom-left corner of the printer settings window.

Creating and Saving Custom Sizes for the Windows V3 Print Driver
1. In the print driver, click the Printing Options tab.

2. For Paper, click the arrow, then select Other Size→Advanced Paper Size→Output Paper
Size→New.

3. In the New Custom Paper Size window, enter the height and width of the new size.

4. To specify the units of measurement, at the bottom of the window, clickMeasurements, then
select Inches orMillimeters.

5. To save, in the Name field, type a title for the new size, then click OK.

Creating and Saving Custom Sizes for the Windows V4 Print Driver
1. From Windows Control Panel, select Devices and Printers.

2. Select the printer, then click Print server properties.

3. On the Forms tab, for Create a new form, click the check box.

4. For Form name, type a name for the new paper size.
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5. In the Form description (measurements) area, enter the settings:
• For Units, selectMetric or English.
• For Paper size, enter measurements for Width and Height.
• For Printer area margins, enter measurements for Left, Right, Top, and Bottom.

Note: Ensure that the measurements that you specify are within the supported ranges for
the device.

6. Click OK.

The new paper size is added to the paper size list.

Creating and Saving Custom Sizes for Macintosh
1. In the application, click File→Print.

2. Click Paper Size, then selectManage Custom Sizes.

3. To add a new size, in the Manage Paper Sizes window, click the plus sign ( +).

4. Double-click Untitled, then type a name for the new custom size.

5. Enter the height and width of the new custom size.

6. Click the arrow for the Non-Printable Area field, then select the printer from the list. Or, for User
Defined margins, set the top, bottom, right, and left margins.

7. To save the settings, click OK.

DDeeffiinniinngg aa CCuussttoomm PPaappeerr SSiizzee aatt tthhee CCoonnttrrooll PPaanneell
You can print custom-size paper from Tray 5. If Trays 1 and 2 are set to Fully Adjustable mode, you
can print custom-size paper from Trays 1 and 2. Custom-size paper settings are saved in the print
driver and are available for you to select in all your applications.

Note: To configure the tray settings for Fully Adjustable or Dedicated mode, refer to
Configuring Paper Tray Settings.

1. Open the paper tray, then load the custom-size paper.

2. Close the tray.

3. At the control panel, to define the new paper size, touch Size, then touch Custom.

4. In the Custom Paper Size window, enter the height and width of the new paper size, then touch
OK.

5. To confirm the settings, touch Confirm.

PPrriinnttiinngg oonn CCuussttoomm--SSiizzee PPaappeerr
Note: Before you print on custom-size paper, define the custom width and length of the paper
in the print driver software and on the printer control panel. For more information, refer to
Defining Custom Paper Sizes.
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PPrriinnttiinngg oonn CCuussttoomm--SSiizzee PPaappeerr ffrroomm tthhee WWiinnddoowwss VV33 PPrriinntt DDrriivveerr
Note: Before you print on custom-size paper, define the custom size in the Printer Properties.
For details, refer to Creating and Saving Custom Sizes for the Windows V3 Print Driver.

1. Load the custom-size paper in the tray.

2. In the application, click File→Print, then select your printer.

3. In the Print dialog box, click Printer Properties.

4. On the Printing Options tab, from the Paper list, select the required custom paper size and type.

5. Select any other required options, then click OK.

6. In the Print dialog box, click Print.

PPrriinnttiinngg oonn CCuussttoomm--SSiizzee PPaappeerr ffrroomm tthhee WWiinnddoowwss VV44 PPrriinntt DDrriivveerr
Note: Before you print on custom-size paper, define and save the custom paper size as a Form.
For details, refer to Creating and Saving Custom Sizes for the Windows V4 Print Driver.

1. Load the custom-size paper in the tray.

2. In the application, click File→Print, then select your printer.

3. In the Print dialog box, click Printer Properties.

4. On the Printing Options tab, from the Paper list, select Other Size.

5. To select a custom paper size, select Fit to New Paper Size, then select the custom paper size.

6. Select any other required options, then click OK.

7. In the Print dialog box, click Print.

PPrriinnttiinngg oonn CCuussttoomm--SSiizzee PPaappeerr ffrroomm MMaacciinnttoosshh
1. Load the custom-size paper. For details, refer to Loading Paper.

2. In the application, click File→Print.

3. From the Paper Size list, select the custom paper size.

4. Click Print.
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Print From
PPrriinnttiinngg FFrroomm aa UUSSBB FFllaasshh DDrriivvee
You can print single or multiple files stored on a USB Flash drive. The USB port is on the front of the
printer.

Note: Only USB Flash drives formatted to the typical FAT32 file system are supported.

To print from a USB Flash drive:

1. Insert the USB Flash drive into the USB port on the printer.

2. At the USB Drive Detected screen, touch Print from USB.

Note: If the Print from USB feature does not appear, enable the feature, or contact your
system administrator. For details, refer to the System Administrator Guide at www.xerox.
com/office/ALC81XXdocs.

3. To select a file for printing, browse to the file, then touch the check box. If multiple files require
printing, browse to each file, then select the check box for each file.

4. Touch OK.

A list of files selected for printing appears.

5. To remove files from the printing list:
• To remove a single file, touch the file, then select Remove. To confirm removal, touch Remove.
• To remove all the files, touch a file, then select Remove All. To confirm removal, touch

Remove All.

6. Adjust the feature settings as needed.

7. Touch Print.

8. When you are finished, remove the USB Flash drive.

9. To return to the Home screen, press the Home button.

PPrriinnttiinngg ffrroomm SSaavveedd JJoobbss
To print from saved jobs:

1. At the control panel, press the Home button, then touch Print From.

2. Touch Saved Jobs, then touch the name of the folder that contains the saved job.

3. Touch the name of the saved job that you want to print.

4. Select the options for paper supply, quantity, 2-sided printing, and finishing.

5. Touch Print.

Note: To print a private saved job, at the Passcode Required screen, enter the passcode,
then touch OK.

6. To print another saved job, touch the current job name, then touch Remove. Touch Add
Document, touch Saved Jobs, then navigate to the job required.

7. To return to the Home screen, press the Home button.
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PPrriinnttiinngg ffrroomm aa MMaaiillbbooxx
The print from mailbox feature allows you to print a file that is stored in a folder on the printer hard
drive.

To print from a mailbox:

1. At the control panel, press the Home button, then touch Print From.

2. SelectMailboxes, then touch the name of the folder that contains the document.

Note: If Mailboxes does not appear, enable the feature or contact the system
administrator. For details, refer to the System Administrator Guide at www.xerox.com/
office/ALC81XXdocs.

3. Touch the name of the document that you want to print.

4. Select the options for paper supply, quantity, 2-sided printing, and finishing.

5. Touch Print.

6. To select another job in the mailbox, touch the current job name, then touch Remove. Touch Add
Document, touchMailboxes, then navigate to the job required.

7. To return to the Home screen, press the Home button.

PPrriinnttiinngg ffrroomm tthhee EEmmbbeeddddeedd WWeebb SSeerrvveerr
You can print various file types, such as .txt, .pdf, .ps, and .pcl files directly from the Embedded Web
Server without the need of another application or the print driver. You can store files on a local
computer hard drive, mass storage device, or network drive.

To print from the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

Note: For details about obtaining the IP address of your printer, refer to Finding the IP
Address of Your Printer.

2. In the Embedded Web Server, click the Print tab.

3. To select the file from a local network or remote location, for File Name, click Browse. Select the
file, then click Open.

4. For Printing, select the required options for the job.
• Normal Print prints a job immediately.
• Secure Print prints a job after you enter your passcode at the printer control panel.
• Sample Set, or proof print, prints one copy of a multiple-copy print job and holds the

remaining copies at the printer.
• Save Job for Reprint saves a print job in a folder on the print server for future printing. You

can specify a job name and folder.
• Delay Print prints a job at a specified time up to 24 hours from the original job submission.

5. If accounting is enabled, enter your User ID and account information.

6. Click Submit Job.

Note: To ensure that the job was sent to the queue, wait for the job submission confirmation
message to appear before you close this page.
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Paper and Media Overview
The printer has five paper trays:

• Tray 1 is an adjustable paper tray for loading a range of paper sizes.

• For the 2-Tray configuration, Trays 2, 3, and 4 are adjustable paper trays that are similar to Tray 1.

• For the Tandem Tray configuration, Tray 2 is an adjustable paper tray, and Trays 3 and 4 are high-
capacity trays that can hold A4, Letter, JIS B5, and Executive size paper.

• Tray 5 is the Bypass Tray, designed for loading small amounts of special paper.

• Tray 6 is an optional high-capacity paper tray that holds A4, Letter, JIS B5, or Executive size paper.

The optional Envelope Tray can replace Tray 1. For more information, refer to the Hardware Install
and Setup Instructions that are included with the Envelope Tray kit.

The printer can use various media types, such as plain, recycled, or colored paper, letterhead, pre-
printed paper, cardstock, labels, transparencies, and envelopes. Ensure that you use the correct media
for the tray that you are loading. You can load all types of media in Tray 5, excluding labels. For
details on supported paper types and weights, refer to Supported Paper Types and Weights.

WARNING: Printing labels from the following trays can cause misfeeds and other print
problems:

• Tray 5 - Bypass Tray

• Tray 6 - High Capacity Feeder

Labels inside each tray show the correct orientation for loading certain types of media. The MAX label
shows the maximum fill line for the tray.
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Supported Paper
Your printer is designed to use various paper and other media types. To ensure the best print quality
and to avoid jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

RReeccoommmmeennddeedd MMeeddiiaa
A list of paper and media recommended for your printer is available at:

• www.xerox.com/rmlna Recommended Media List (United States)

• www.xerox.com/rmleu Recommended Media List (Europe)

OOrrddeerriinngg PPaappeerr
To order paper, transparencies, or other media, contact your local reseller or go to www.xerox.com/
office/supplies.

GGeenneerraall PPaappeerr LLooaaddiinngg GGuuiiddeelliinneess
• Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.

• Adjust the paper guides to fit the paper size.

• Fan paper before loading it in the paper tray.

• If excessive jams occur, use paper or other approved media from a new package.

• Use only recommended Xerox® transparencies. Print quality could vary with other transparencies.

• Do not print on label media once a label has been removed from a sheet.

• Use only paper envelopes. Print envelopes 1-sided only.

PPaappeerr TThhaatt CCaann DDaammaaggee YYoouurr PPrriinntteerr
Some paper and other media types can cause poor output quality, increased paper jams, or damage
your printer. Do not use the following:

• Rough or porous paper

• Inkjet paper

• Non-laser glossy or coated paper

• Paper that has been photocopied

• Paper that has been folded or wrinkled

• Paper with cutouts or perforations

• Stapled paper

• Envelopes with windows, metal clasps, side seams, or adhesives with release strips

• Padded envelopes

• Plastic media
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Caution: The Xerox Warranty or Service Agreement does not cover damage caused by using
unsupported paper or specialty media. For more information, contact your local Xerox
representative.

PPaappeerr SSttoorraaggee GGuuiiddeelliinneess
Storing your paper and other media properly contributes to optimum print quality.

• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from
ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly
damaging to paper.

• Reduce the exposure of paper to strong lights for long periods of time.

• Maintain constant temperatures and relative humidity.

• Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to
collect moisture.

• Store paper flat, either on pallets, cartons, shelves, or in cabinets.

• Avoid food or drinks in the area where paper is stored or handled.

• Do not open sealed packages of paper until you are ready to load them into the printer. Leave
stored paper in the original packaging. The paper wrapper protects the paper from moisture loss
or gain.

• Some special media is packaged inside resealable plastic bags. Store the media inside the bag
until you are ready to use it. Keep unused media in the bag and reseal it for protection.

SSuuppppoorrtteedd PPaappeerr TTyyppeess aanndd WWeeiigghhttss

Trays Paper Types Weights

Trays 1–4 Lightweight 52–63 g/m²

Plain

Hole Punched

64–90 g/m²

Letterhead

Recycled

Bond

Pre-Printed

Custom Types 1–6

64–105 g/m²

Lightweight Cardstock

Lightweight Glossy Cardstock

106–169 g/m²

Labels 106–176 g/m²

Cardstock 170–256 g/m²
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Trays Paper Types Weights

Glossy Cardstock

Heavyweight Cardstock

Heavyweight Cardstock Reloaded

Heavyweight Glossy Cardstock

Heavyweight Glossy Cardstock
Reloaded

Custom Type 7

257–300 g/m²

Transparencies

Tray 6 – High Capacity Feeder Lightweight 52–63 g/m²

Plain

Hole Punched

64–90 g/m²

Letterhead

Recycled

Bond

Pre-Printed

Custom Types 1–6

64–105 g/m²

Lightweight Cardstock

Lightweight Glossy Cardstock

106–169 g/m²

Cardstock

Glossy Cardstock

170–256 g/m²

Heavyweight Cardstock

Heavyweight Cardstock Reloaded

Heavyweight Glossy Cardstock

Heavyweight Glossy Cardstock
Reloaded

Custom Type 7

257–300 g/m²

Transparencies

Tray 5 – Bypass Tray Lightweight 52–63 g/m²

Plain 64–90 g/m²
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Trays Paper Types Weights

Hole Punched

Letterhead

Recycled

Bond

Pre-Printed

Custom Types 1–6

64–105 g/m²

Lightweight Cardstock

Lightweight Glossy Cardstock

106–169 g/m²

Cardstock

Glossy Cardstock

170–256 g/m²

Heavyweight Cardstock

Heavyweight Cardstock Reloaded

Heavyweight Glossy Cardstock

Heavyweight Glossy Cardstock
Reloaded

Custom Type 7

257–300 g/m²

Transparencies

Envelopes 75–90 g/m²

Envelope Tray Envelopes 75–90 g/m²

Note: Pre-cut tabs are not supported.
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SSuuppppoorrtteedd SSttaannddaarrdd PPaappeerr SSiizzeess

Tray European Standard Sizes
North American Standard
Sizes

Tray 1 A6 (105 x 148 mm, 4.1 x 5.8 in.)

A5 (148 x 210 mm, 5.8 x 8.3 in.)

A4 (210 x 297 mm, 8.3 x 11.7 in.)

A3 (297 x 420 mm, 11.7 x 16.5 in.)

B6 (176 x 125 mm, 6.9 x 4.9 in.)

B5 (176 x 250 mm, 6.9 x 9.8 in.)

B4 (250 x 353 mm, 9.8 x 13.9 in.)

JIS B6 (128 x 182 mm, 5.0 x 7.2
in.)

JIS B5 (182 x 257 mm, 7.2 x 10.1
in.)

JIS B4 (257 x 364 mm, 10.1 x 14.3
in.)

215 x 315 (215 x 315 mm, 8.5 x
12.4 in.)

Statement (140 x 216 mm, 5.5 x
8.5 in.)

Executive (184 x 267 mm, 7.25 x
10.5 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

US Folio (216 x 330 mm, 8.5 x 13
in.)

Legal (216 x 356 mm, 8.5 x 14 in.)

Tabloid (279 x 432 mm, 11 x 17
in.)

Postcard (102 x 152 mm, 4 x 6 in.)

5 x 7 (127 x 178 mm, 5 x 7 in.)

8 x 10 (203 x 254 mm, 8 x 10 in.)

8.5 x 13.4 (216 x 340 mm, 8.5 x
13.4 in.)

Tray 2

Trays 3 and 4 of the 2-Tray
Module

A6 (105 x 148 mm, 4.1 x 5.8 in.)

A5 (148 x 210 mm, 5.8 x 8.3 in.)

A4 (210 x 297 mm, 8.3 x 11.7 in.)

A3 (297 x 420 mm, 11.7 x 16.5 in.)

B6 (176 x 125 mm, 6.9 x 4.9 in.)

B5 (176 x 250 mm, 6.9 x 9.8 in.)

B4 (250 x 353 mm, 9.8 x 13.9 in.)

JIS B6 (128 x 182 mm, 5.0 x 7.2
in.)

JIS B5 (182 x 257 mm, 7.2 x 10.1
in.)

JIS B4 (257 x 364 mm, 10.1 x 14.3
in.)

215 x 315 (215 x 315 mm, 8.5 x
12.4 in.)

SRA3 (320 x 450 mm, 12.6 x 17.7
in.)

Statement (140 x 216 mm, 5.5 x
8.5 in.)

Executive (184 x 267 mm, 7.25 x
10.5 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

US Folio (216 x 330 mm, 8.5 x 13
in.)

Legal (216 x 356 mm, 8.5 x 14 in.)

Tabloid (279 x 432 mm, 11 x 17
in.)

Postcard (102 x 152 mm, 4 x 6 in.)

5 x 7 (127 x 178 mm, 5 x 7 in.)

8 x 10 (203 x 254 mm, 8 x 10 in.)

8.5 x 13.4 (216 x 340 mm, 8.5 x
13.4 in.)

12 x 18 (305 x 457 mm, 12 x 18
in.)

Trays 3 and 4 of the Tandem Tray
Module

Tray 6 - High Capacity Feeder

A4 (210 x 297 mm, 8.3 x 11.7 in.)

JIS B5 (182 x 257 mm, 7.2 x 10.1
in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

Executive (184 x 267 mm, 7.25 x
10.5 in.)
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Tray European Standard Sizes
North American Standard
Sizes

Tray 5 - Bypass Tray A6 (105 x 148 mm, 4.1 x 5.8 in.)

A5 (148 x 210 mm, 5.8 x 8.3 in.)

A4 (210 x 297 mm, 8.3 x 11.7 in.)

A3 (297 x 420 mm, 11.7 x 16.5 in.)

B6 (125 x 176 mm, 4.9 x 6.9 in.)

B5 (176 x 250 mm, 6.9 x 9.8 in.)

B4 (250 x 353 mm, 9.8 x 13.9 in.)

JIS B6 (128 x 182 mm, 5.0 x 7.2
in.)

JIS B5 (182 x 257 mm, 7.2 x 10.1
in.)

JIS B4 (257 x 364 mm, 10.1 x 14.3
in.)

SRA3 (320 x 450 mm, 12.6 x 17.7
in.)

215 x 315 (215 x 315 mm, 8.5 x
12.4 in.)

DL envelope (110 x 220 mm, 4.33
x 8.66 in.)

C6 envelope (114 x 162 mm, 4.5 x
6.38 in.)

C5 envelope (162 x 229 mm, 6.4 x
9 in.)

C4 envelope (229 x 324 mm, 9 x
12.8 in.)

Postcard (89 x 140 mm, 3.5 x 5.5
in.)

Postcard (102 x 152 mm, 4 x 6 in.)

5 x 7 (127 x 178 mm, 5 x 7 in.)

Statement (140 x 216 mm, 5.5 x
8.5 in.)

Executive (184 x 267 mm, 7.25 x
10.5 in.)

8 x 10 (203 x 254 mm, 8 x 10 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

9 x 11 (229 x 279 mm, 9 x 11 in.)

US Folio (216 x 330 mm, 8.5 x 13
in.)

8.5 x 13.4 (216 x 340 mm, 8.5 x
13.4 in.)

Legal (216 x 356 mm, 8.5 x 14 in.)

Tabloid (279 x 432 mm, 11 x 17
in.)

12 x 18 (305 x 457 mm, 12 x 18
in.)

12 x 19 (305 x 483 mm, 12 x 19
in.)

Envelope (152 x 228 mm, 6 x 9 in.)

Envelope (228 x 305 mm, 9 x 12
in.)

Monarch envelope (98 x 190 mm,
3.9 x 7.5 in.)

No. 6 3/4 Envelope (3.6 x 6.5 in.)

No. 9 envelope (98 x 225 mm, 3.9
x 8.9 in.)

No. 10 envelope (105 x 241 mm,
4.1 x 9.5 in.)

Envelope Tray DL envelope (110 x 220 mm, 4.33
x 8.66 in.)

C6 envelope (114 x 162 mm, 4.5 x
6.38 in.)

C5 envelope (162 x 229 mm, 6.4 x
9 in.)

Envelope (152 x 228 mm, 6 x 9 in.)

Envelope (228 x 305 mm, 9 x 12
in.)

Monarch envelope (98 x 190 mm,
3.9 x 7.5 in.)

No. 6 3/4 Envelope (92 x 165 mm,
3.6 x 6.5 in.)
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Tray European Standard Sizes
North American Standard
Sizes

C4 envelope (229 x 324 mm, 9 x
12.8 in.)

No. 9 envelope (98 x 225 mm, 3.9
x 8.9 in.)

No. 10 envelope (105 x 241 mm,
4.1 x 9.5 in.)

SSuuppppoorrtteedd PPaappeerr SSiizzeess aanndd WWeeiigghhttss ffoorr 22--SSiiddeedd
PPrriinnttiinngg

European Standard Sizes North American Standard Sizes

A5 (148 x 210 mm, 5.8 x 8.3 in.)

A4 (210 x 297 mm, 8.3 x 11.7 in.)

A3 (297 x 420 mm, 11.7 x 16.5 in.)

B5 (176 x 250 mm, 6.9 x 9.8 in.)

B4 (250 x 353 mm, 9.8 x 13.9 in.)

JIS B6 (128 x 182 mm, 5.0 x 7.2 in.)

JIS B5 (182 x 257 mm, 7.2 x 10.1 in.)

JIS B4 (257 x 364 mm, 10.1 x 14.3 in.)

SRA3 (320 x 450 mm, 12.6 x 17.7 in.)

215 x 315 (215 x 315 mm, 8.5 x 12.4 in.)

Statement (140x216 mm, 5.5 x 8.5 in.)

Executive (184 x 267 mm, 7.25 x 10.5 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

US Folio (216 x 330 mm, 8.5 x 13 in.)

Legal (216 x 356 mm, 8.5 x 14 in.)

Tabloid (279 x 432 mm, 11 x 17 in.)

8 x 10 (203 x 254 mm, 8 x 10 in.)

12 x 18 (305 x 457 mm, 12 x 18 in.)

12 x 19 (305 x 483 mm, 12 x 19 in.)

In addition to the standard sizes, you can use custom-size paper within the following ranges for
2-sided printing:

• Minimum size: 128 x 140 mm (5 x 5.5 in.)

• Maximum size: 320 x 483 mm (12.6 x 19 in.)

Paper weights from 60–300 g/m² are supported for 2-sided printing.

Note:

• Do not use transparencies, envelopes, labels, lightweight paper, or reloaded paper for
2-sided printing.

• For 2-sided printing, paper weights above 220 g/m² can cause misfeeds and paper jams.
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SSuuppppoorrtteedd PPaappeerr SSiizzeess ffoorr tthhee EEnnvveellooppee TTrraayy

European Standard Sizes North American Standard Sizes

DL (110 x 220 mm, 4.33 x 8.66 in.)

C6 (114 x 162 mm, 4.5 x 6.38 in.)

C5 (162 x 229 mm, 6.4 x 9 in.)

Envelope (152 x 228 mm, 6 x 9 in.)

Monarch (98 x 190 mm, 3.9 x 7.5 in.)

No. 9 (98 x 225 mm, 3.9 x 8.9 in.)

No. 10 (105 x 241 mm, 4.1 x 9.5 in.)

SSuuppppoorrtteedd CCuussttoomm PPaappeerr SSiizzeess

Tray Paper Sizes

Tray 1 Minimum: 100 x 148 mm (3.9 x 5.8 in.)

Maximum: 297 x 432 mm (11.7 x 17 in.)

Tray 2

Trays 3 and 4 of the 2-Tray Module

Minimum: 100 x 148 mm (3.9 x 5.8 in.)

Maximum: 320 x 457 mm (12.5 x 18 in.)

Trays 3 and 4 of the Tandem Tray Module Standard sizes only:

A4 (210 x 297 mm, 8.3 x 11.7 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

JIS B5 (182 x 257 mm, 7.2 x 10.1 in.)

Executive (184 x 267 mm, 7.25 x 10.5 in.)

Tray 5 - Bypass Tray Minimum: 89 x 98 mm (3.5 x 3.9 in.)

Maximum: 320 x 483 mm (12.6 x 19 in.)

Tray 5 - Bypass Tray, banner paper Minimum: 89 x 483 mm (3.5 x 19 in.)

Maximum: 320 x 1321 mm (12.6 x 52 in.)

Tray 6 - High Capacity Feeder Standard sizes only:

A4 (210 x 297 mm, 8.3 x 11.7 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

JIS B5 (182 x 257 mm, 7.2 x 10.1 in.)

Executive (184 x 267 mm, 7.25 x 10.5 in.)

Envelope Tray Minimum: 90 x 98 mm (3.5 x 3.9 in.)

Maximum: 241 x 372 mm (9.5 x 14.6 in.)
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Configuring Paper Tray Settings

CCoonnffiigguurriinngg DDeeddiiccaatteedd PPaappeerr TTrraayyss
The system administrator can set trays to Fully Adjustable mode or Dedicated mode. When a paper
tray is set to Fully Adjustable mode, you can change paper settings each time that you load the tray.
When a paper tray is set to Dedicated mode, the control panel prompts you to load a specific paper
size, type, and color.

Your printer can have three high-capacity paper trays installed, depending on the configuration.

• High-capacity trays are configured as Fully Adjustable trays.

• Trays 3 and 4 in the Tandem Module, and High-Capacity Tray 6 hold A4-size (210 x 297 mm),
Letter-size (8.5 x 11 in.), JIS B5-size (182 x 257 mm), or Executive-size (7.25 x 10.5 in.) paper.

• High-capacity trays are designed to hold larger amounts of paper for fewer printing interruptions.

Note: To configure tray settings, refer to the System Administrator Guide at www.xerox.com/
office/ALC81XXdocs.

CCoonnffiigguurriinngg PPaappeerr SSiizzee CCoonnffiirrmmaattiioonn
The system administrator can configure the paper size confirmation prompt that appears at the
control panel. For adjustable paper trays, when you load paper of the same size as the paper that was
loaded previously in the tray, a confirmation prompt appears at the device control panel:

• Always Show: This option shows the paper confirmation prompt at the control panel until the
user dismisses it.

• Delayed Confirmation: This option shows the paper confirmation prompt for a specified time. At
the end of the specified time, the prompt closes, which confirms the paper that is loaded. While
the prompt appears on the control panel touch screen, you can confirm any change to the paper
type, color, and size.

• Auto Confirmation: This option confirms automatically the paper type, color, and size without
showing a prompt.

Note: To configure the paper size confirmation prompt, refer to the System Administrator
Guide at www.xerox.com/office/ALC81XXdocs.
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CCoonnffiigguurriinngg TTrraayyss 33 aanndd 44 ooff tthhee TTaannddeemm TTrraayy
MMoodduullee
Trays 3 and 4 in the Tandem Tray Module are high-capacity paper trays. Configure Trays 3 and 4 to
support the paper in use. For details on supported paper sizes, refer to Supported Paper.

To configure Trays 3 and 4 in the Tandem Tray Module:

Note: Before you make any tray adjustments, compare the paper size to the current Tray 3 and
4 configurations. If the paper size matches the tray configuration, no tray adjustment is
needed.

1. Remove any paper from the tray.

2. Pinch the guide lock on the front paper guide, then slide the paper guide to the required paper
size.

3. To lock the paper guides into place, release the guide lock.

Note: The paper guides lock into place only at the designated standard paper sizes.
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CCoonnffiigguurriinngg TTrraayy 66
Tray 6 is a high-capacity tray. You can configure Tray 6 to support the paper size that you need. For
details on supported paper sizes, refer to Supported Paper.

To configure Tray 6:

Note: Before you make any tray adjustments, compare the paper size to the current Tray 6
configuration. If the paper size matches the tray configuration, no tray adjustment is needed.

1. At the high capacity feeder, squeeze the handle, and pull out Tray 6 until it stops.

2. Open the side gate. Remove the screw that holds the spacer plate at the back of the tray, then lift
the spacer plate out of the tray. Repeat the procedure for the spacer plate at the front of the
tray.
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3. For the rear spacer plate, place the tabs at the bottom of the plate into the slots that correspond
with the correct paper size. Slide down the spacer plate, then engage the peg on the top of the
tray with the matching hole in the spacer plate. To secure the spacer plate, install the screw.
Repeat the procedure for the spacer plate at the front of the tray.

4. On the top of the side gate, lift the pin, then guide it into the required paper size in the slot. To
lock the side gate into place, release the pin.

5. Load paper, close the side gate, then close the tray.

6. At the control panel, select the correct type and color.

7. To confirm the settings, touch Confirm.

For information about loading paper in Tray 6, refer to Loading Paper in Tray 6.
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CChhaannggiinngg PPaappeerr SSiizzee,, TTyyppee,, aanndd CCoolloorr
When a paper tray is set to Fully Adjustable mode, you can change paper settings each time that you
load the tray. When you close the tray, the control panel prompts you to set the paper size, type, and
color of paper loaded.

When a paper tray is set to Dedicated mode, the control panel prompts you to load a specific paper
size, type, and color. If you move the guides to load a different paper size, the control panel displays
an error message.

To configure the tray settings for Fully Adjustable or Dedicated mode, refer to Configuring Paper Tray
Settings.

To set the paper size, type, or color when a tray is set to Fully Adjustable:

1. Open the paper tray, then load the required paper.

2. Close the tray.

3. At the control panel, select the correct paper size, type, and color:
• To select a new paper size, touch Size.
• To select a new paper type, touch Type.
• To select a new paper color, touch Color.

4. To confirm the settings, touch Confirm.

To set the paper size, type, or color when a tray is set to Dedicated, refer to Configuring Dedicated
Paper Trays.
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Loading Paper

LLooaaddiinngg PPaappeerr iinn TTrraayyss 11––44
For configurations with the 2–Tray Module, use the same method to load paper in both Trays 1 and 2
and Trays 3 and 4. For instructions on how to load paper in Trays 3 and 4 when they are part of the
Tandem Tray Module, refer to Loading Paper in Trays 3 and 4 of the Tandem Tray Module.

The system administrator can set Trays 1–4 to Fully Adjustable mode or Dedicated mode. Each time a
tray is opened and closed, the paper settings appear on the control panel.

• When trays are configured as Fully Adjustable, you can confirm or change the media settings. The
paper guides automatically detect the size of paper that is loaded.

• When trays are configured as Dedicated, the control panel displays the media settings for the
tray. A warning message appears on the control panel when the wrong media is loaded in the
tray, or when the paper guides are set incorrectly.

Note: Only the system administrator can change the media settings for a dedicated tray. For
details on how to configure tray settings, refer to Configuring Paper Tray Settings.

When the paper in the tray is in short supply, or when a tray is empty, a warning message appears on
the control panel.

To load paper in Trays 1–4:

1. Pull out the tray until it stops.

2. Remove any paper that is a different size or type.

3. To move out the length or width paper guides, pinch the guide locks, then slide out the length or
width paper guides.
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4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
The procedure separates any sheets that are stuck together and reduces the possibility of jams.

Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are
ready to use it.

5. Load the paper in the tray. Do one of the following:
• For long-edge feed:

• Insert letterhead and pre-printed paper face down with the top edge toward the front.

• Load hole-punched paper with the holes to the left.

Note: Do not load the paper above the maximum fill line. Overfilling the tray can cause
paper jams.

• For short-edge feed:

• Insert letterhead and pre-printed paper face down with the top edge toward the left.

• Load hole-punched paper with the holes to the back.

Note: Use short-edge feed for custom-size paper and special media.
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6. To adjust the length and width guides to fit the paper, pinch the guide locks, then slide the paper
guides in until they touch the paper.

7. Slide the tray back into the printer.

8. At the control panel, select the correct paper size, type, and color.
• If letterhead paper is loaded in the printer, for type, select Letterhead.
• If pre-printed paper is loaded in the printer, for type, select Pre-printed.

9. To confirm the settings, touch Confirm.

Note: To change the paper settings when the tray is set to Dedicated mode, refer to
Configuring Dedicated Paper Trays.
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AAddjjuussttiinngg tthhee PPaappeerr GGuuiiddeess iinn tthhee 552200--SShheeeett
AAddjjuussttaabbllee TTrraayyss
You can adjust the paper guides in Trays 1–4 to accommodate standard or custom paper sizes. In the
standard position, the guides move into the supported standard paper settings. In the custom
position, the guides move in 1-mm (0.04 in.) increments.

To move the paper guides from the standard to the custom paper-size position:

1. Pull out the tray until it stops.

2. Remove any paper from the tray, pinch the guide levers, and move the guides outward until they
stop.

3. To move out the paper-length guide, pinch the guide lever and slide the guide outward.
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4. To move out the paper-width guide, pinch the guide lever and slide the guide outward.

5. Load the custom-size paper in the tray.

6. To engage the fine-adjustment block, pinch the levers and slide the guides inward. The paper
guides move in increments of 1mm.
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LLooaaddiinngg PPaappeerr iinn TTrraayyss 33 aanndd 44 ooff tthhee TTaannddeemm TTrraayy
MMoodduullee
The control panel displays a warning message when the paper in the tray is in short supply, or when a
tray is empty.

To change the paper size in Trays 3 and 4, refer to Configuring Trays 3 and 4 of the Tandem Tray
Module.

To load the paper in Trays 3 and 4 of the Tandem Tray Module:

1. Pull out the tray until it stops. Wait for the tray to lower and stop.

2. Fan the edges of the paper before you load it into the paper trays. The procedure separates any
sheets of paper that are stuck together and reduces the possibility of paper jams.

Note: To avoid paper jams and misfeeds, do not remove the packaging from the paper
until you are ready to use it.
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3. Stack the paper against the left-rear corner of the tray.
• Insert letterhead and pre-printed paper face down with the top edge toward the front of the

tray.
• Load hole-punched paper with the holes to the left.

Note: Do not load the paper above the maximum fill line. Overfilling the tray can cause
paper jams.

4. Slide the tray back into the printer.

5. At the control panel, select the correct paper type and color.
• If letterhead paper is loaded in the printer, for type, select Letterhead.
• If pre-printed paper is loaded in the printer, for type, select Pre-printed.

6. To confirm the settings, touch Confirm.
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LLooaaddiinngg PPaappeerr iinn tthhee BByyppaassss TTrraayy
The Bypass Tray supports the widest variety of media types. The tray is intended primarily for small-
quantity jobs that use special media.

To load paper in the Bypass Tray:

1. Open the Bypass Tray. If the tray is loaded with paper, remove any paper that is a different size
or type.

Note: For larger paper sizes, pull out the extension tray.

2. Move the width guides to the edges of the tray.

3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
The procedure separates any sheets that are stuck together and reduces the possibility of jams.

Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are
ready to use it.
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4. Load the paper in the tray.
• For long-edge feed printing:

• Load letterhead and pre-printed paper face up with the top edge toward the front.

• Load hole-punched paper with the holes to the right.

• For short-edge feed printing:

• Load letterhead and pre-printed paper face up with the top edge to the right.

• Load hole-punched paper with the holes toward the rear.

Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams.

5. Adjust the width guides until they touch the edges of the paper.

6. At the control panel, select the correct paper size, type, and color.
• If letterhead paper is loaded in the printer, for type, select Letterhead.
• If pre-printed paper is loaded in the printer, for type, select Pre-printed.

7. To confirm the settings, touch Confirm.

204 Xerox® AltaLink® C81XX Series Color Multifunction Printer
User Guide

Paper and Media



LLooaaddiinngg PPaappeerr iinn TTrraayy 66
The control panel displays a warning message when the paper in the tray is in short supply, or when
the tray is empty.

To change the paper size in Tray 6, refer to Configuring Tray 6.

To load paper in Tray 6:

1. At the high capacity feeder, squeeze the handle, and pull out Tray 6 until it stops.

2. Open the side gate, then wait for the tray to lower and stop.

3. The control panel displays the paper tray settings. Ensure that you load the correct paper type
into the tray.

Note: Do not load custom-size paper into Tray 6.

4. Before you load the paper into the trays, fan the edges of the paper. The procedure separates
any sheets of paper that are stuck together and reduces the possibility of paper jams.

Note: To avoid paper jams and misfeeds, do not remove paper from the packaging until
necessary.
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5. Load the paper against the right side of the tray.
• Place letterhead or pre-printed paper face up with the top edge toward the front of the tray.
• Place hole-punched paper with the holes toward the right side of the tray.

Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams.

6. Close the side gate, then close Tray 6.

7. At the control panel, select the correct type and color.
• If letterhead paper is loaded in the printer, for type, select Letterhead.
• If pre-printed paper is loaded in the printer, for type, select Pre-printed.

8. To confirm the settings, touch Confirm.
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Printing on Special Paper
To order paper, transparencies, or other media, contact your local reseller or go to www.xerox.com/
office/supplies.

For reference:

www.xerox.com/rmlna : Recommended Media List (United States)

www.xerox.com/rmleu : Recommended Media List (Europe)

EEnnvveellooppeess
You can print envelopes from Tray 5. When the optional Envelope Tray is installed, you can print
envelopes from Tray 1.

GGuuiiddeelliinneess ffoorr PPrriinnttiinngg EEnnvveellooppeess
• Use only paper envelopes.

• Do not use envelopes with windows or metal clasps.

• Print quality depends on the quality and construction of the envelopes. If you do not get the
desired results, try another envelope brand.

• Maintain constant temperatures and relative humidity.

• Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect
print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or
during printing.

• Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book
on top of the envelopes.

• In the print driver software, select Envelope as the paper type.

• Do not use padded envelopes. Use envelopes that lie flat on a surface.

• Do not use envelopes with heat-activated glue.

• Do not use envelopes with press-and-seal flaps.
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LLooaaddiinngg EEnnvveellooppeess iinn tthhee BByyppaassss TTrraayy
For supported envelope sizes, refer to Supported Paper.

To load envelopes in the Bypass Tray:

1. Open the Bypass Tray.

2. Move the width guides to the edges of the tray.

Note: If you do not load envelopes in the Bypass Tray right after they are removed from
the packaging, they can bulge. To avoid jams, flatten the envelopes.
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3. Load envelopes in the tray.
• For envelopes with the flap on a long edge, load envelopes face down with the flaps closed,

and flaps toward the right.

• For envelopes with a self-seal flap on a short edge, load envelopes face down with the flaps
closed, and flaps toward the right.

• For envelopes with a non-adhesive flap on a short edge, load envelopes face down with the
flaps open, and flaps toward the left.

Note: For envelopes to print correctly, when you load envelopes with the flaps open, in the
print driver, set the orientation as needed. To flip the images, in the print driver, select
Rotate Image 180 Degrees.

4. At the control panel, select the correct paper size, type, and color. Ensure that the paper type is
set to Envelope.

5. To confirm the settings, touch Confirm.
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LLooaaddiinngg tthhee EEnnvveellooppee TTrraayy
You can use the optional Envelope Tray in place of Tray 1. The Envelope Tray is a dedicated tray. For
supported envelope sizes, refer to Supported Paper.

Note: For information on installing the optional Envelope Tray, refer to the Hardware Install
and Setup Instructions that are included with the Envelope Tray kit.

To load the Envelope Tray:

1. Pull out the Envelope Tray until it stops.

2. Load the envelopes in the tray, face up with the flaps closed, and flaps toward the left.

Note: For 6 3/4 Envelopes and short-edge feed custom envelope sizes, load envelopes with
the flaps closed, and flaps toward the front.

3. Adjust the paper guides so that they rest lightly against the edges of the envelopes. Ensure that
the maximum fill line is visible or that there are no more than 50 envelopes loaded in the tray.
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4. Close the tray.

5. At the control panel, select the correct paper size, type, and color. Ensure that the paper type is
set to Envelope.

6. To confirm the settings, touch Confirm.

LLaabbeellss
You can print labels from the following trays only:

• Trays 1–4

WARNING: Printing labels from the following trays can cause misfeeds and other print
problems:

• Tray 5 - Bypass Tray

• Tray 6 - High Capacity Feeder

GGuuiiddeelliinneess ffoorr PPrriinnttiinngg LLaabbeellss
• Use labels designed for laser printing.

• Do not use vinyl labels.

• Do not feed a sheet of labels through the printer more than once.

• Do not use dry gum labels.

• Print only on one side of the sheet of labels. Use full sheet labels only.

• Store unused labels flat in their original packaging. Leave the sheets of labels inside the original
packaging until ready to use. Return any unused sheets of labels to the original packaging and
reseal it.

• Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions.
Storing them in extreme conditions can cause print-quality problems or cause them to jam in the
printer.

• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and
jam in the printer.

• In the print driver software, select Label as the paper type.

• Before loading labels, remove all other paper from the tray.
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Caution: Do not use any sheet where labels are missing, curled, or pulled away from the
backing sheet. It could damage the printer.

LLooaaddiinngg LLaabbeellss
Note: Load labels only in trays 1–4.

1. Pull out the tray until it stops.

2. Ensure that the paper guides are set in the correct position for the size of labels you are loading.

3. Remove any paper that is a different size or type.

4. To move out the length or width paper guide, release the guide lock, then slide out the length or
width paper guide.
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5. Load the labels in the tray.
• For long-edge feed, insert labels face up with the top edge toward the front.

• For short-edge feed, insert labels face up with the top edge toward the right.

Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams.

6. Adjust the length and width paper guides to fit the labels.

7. Slide the tray back into the printer.
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8. At the control panel, select the correct paper size, type, and color. Ensure that the paper type is
set to Labels.

Note: To change the paper settings when the tray is set to Dedicated mode, refer to
Configuring Dedicated Paper Trays.

9. To confirm the settings, touch Confirm.

10. To return to the Home screen, press the Home button.

BBaannnneerr PPaappeerr
You can print on banner paper from the Bypass Tray only. Once the banner paper is loaded, use the
Custom Paper Size option to specify the banner paper size.

To print on long media or banner paper, use the printer driver custom-size paper settings to define a
custom paper size. For details, refer to Defining Custom Paper Sizes.

Note: To aid with feeding banner paper into the Bypass Tray, you can install an optional Long
Sheet Feed Kit. For information, refer to the Hardware Install and Setup Instructions that are
included with the Long Sheet Feed Kit.

LLooaaddiinngg BBaannnneerr PPaappeerr iinn tthhee BByyppaassss TTrraayy
1. Open the Bypass Tray, then pull out the extension tray. Remove any paper that is a different size

or type.

2. Move the width guides to the edges of the tray.
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3. Load the banner paper in the tray. Load the paper with the short edge leading into the printer.

Note: To aid with feeding banner paper into the bypass tray, you can align a flat surface
with the edge of the tray.

4. Adjust the width guides until they touch the edges of the paper.

5. At the control panel, select the correct paper size, type, and color.

a. To define the paper size, touch Size, then touch Custom. In the Custom Paper Size window,
enter the width and length of the banner paper, then touch OK.

b. To define the paper type, touch Type, then select the correct paper type.

c. To define the paper color, touch Color, then select the correct paper color.

6. To confirm the settings, touch Confirm.

7. To return to the Home screen, press the Home button.

Note: As the paper feeds into the printer, support the paper with your hands.

To prevent paper jams, feed one sheet of paper at a time.
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LLooaaddiinngg BBaannnneerr PPaappeerr UUssiinngg tthhee LLoonngg SShheeeett FFeeeedd EExxtteennssiioonn
You can use the optional Long Sheet Feed Extension to aid with loading banner paper into the Bypass
Tray.

To load banner paper using the Long Sheet Feed Extension:

1. Open the Long Sheet Feed Extension guides. Remove any paper that is a different size or type.

2. Move the Bypass Tray width guides to the edges of the tray.

3. Load banner paper in the tray. Load paper onto the rear Long Sheet Feed Extension guide with
the short edge leading into the printer. Ensure that the leading edge feeds underneath the front
guide.

4. Carefully roll the remaining length of the banner paper into the Long Sheet Feed Extension
guides. Ensure that the trailing edge rests against the front guide.
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5. Adjust the Bypass Tray width guides until they touch the edges of the paper.

6. At the control panel, select the correct paper size, type, and color.

a. To define the paper size, touch Size, then touch Custom. In the Custom Paper Size window,
enter the width and length of the banner paper, then touch OK.

b. To define the paper type, touch Type, then select the correct paper type.

c. To define the paper color, touch Color, then select the correct paper color.

7. To confirm the settings, touch Confirm.

8. To return to the Home screen, press the Home button.

GGlloossssyy MMeeddiiaa
You can print glossy paper, up to 300 g/m2, from any tray. For Tray 5 and Tray 6, load the paper with
the glossy side or print side down, for Trays 1–4, load the paper with the glossy side or print side up.

Note: For best results, load Glossy Cardstock, and Glossy Cardstock Reloaded paper into Tray 5.

GGuuiiddeelliinneess ffoorr PPrriinnttiinngg oonn GGlloossssyy PPaappeerr
• Do not open sealed packages of glossy paper until you are ready to load them into the printer.

• Leave glossy paper in the original wrapper, and leave the packages in the shipping carton until
ready to use.

• Remove all other paper from the tray before loading glossy paper.

• Load only the amount of glossy paper that you are planning to use. Do not leave glossy paper in
the tray when you are finished printing. Reinsert unused paper in the original wrapper and seal.

• Rotate paper frequently. Long periods of storage in extreme conditions can cause glossy paper to
curl and jam in the printer.

• In the print driver software, select the desired glossy paper type or select the tray loaded with the
desired paper.

LLooaaddiinngg GGlloossss PPaappeerr iinn TTrraayy 55
1. Before you load glossy paper, remove all other paper from the tray.

2. Load only the amount of paper you plan to use.

3. Load the paper with the glossy side or print side down.

4. At the control panel, select the correct paper size, type, and color:
• Ensure that the paper type is set to Glossy. To select a new paper type, touch Type.
• To select a new paper size, touch Size.
• To select a new paper color, touch Color.

5. To confirm the settings, touch Confirm.

TTrraannssppaarreenncciieess
Transparencies can be printed from trays 1–5. For best results, use only recommended Xerox®
transparencies.
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Caution: The Xerox Warranty or Service Agreement does not cover damage caused by using
unsupported paper or specialty media. For more information, contact your local Xerox
representative.

GGuuiiddeelliinneess ffoorr PPrriinnttiinngg oonn TTrraannssppaarreenncciieess
• Before you load transparencies in the tray, remove all paper.

• Handle transparencies by the edges using both hands. Fingerprints or creases can cause poor print
quality.

• Do not load more than 20 transparencies. Overloading the tray can cause the printer to jam.

• For clear or non-strip transparencies:

– Load transparencies face up into Trays 1–4.

– Load transparencies face down into Tray 5.

• For striped transparencies:

– Load transparencies into Trays 1–4 with the strip face down on the right trailing edge.

– Load transparencies into Tray 5 with the strip face up on the left trailing edge.

• Do not fan transparencies.

• After you load transparencies, on the control panel, change the paper type to Transparency.

• In the print driver software, for the paper type, select Transparency.
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General Precautions
WARNING:

• Internal parts of the printer can be hot. Use caution when doors and covers are open.

• Keep all cleaning materials out of the reach of children.

• Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays
contain explosive mixtures and are not suitable for use in electrical applications. Use of
pressurized spray cleaners increases the risk of fire and explosion.

• Do not remove the covers or guards that are fastened with screws. You cannot maintain or
service any parts that are behind these covers and guards. Do not attempt any
maintenance procedure that is not described in the documentation supplied with your
printer.

Caution:

• When cleaning your printer do not use organic or strong chemical solvents or aerosol
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only
as directed in this documentation.

• Do not place anything on top of the printer.

• Do not leave the covers and doors open for any length of time, especially in well-lighted
places. Light exposure can damage the drum cartridges.

• Do not open covers and doors during printing.

• Do not tilt the printer while it is in use.

• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause
the print quality to deteriorate.

• Ensure that any parts removed during cleaning are replaced before you plug in the printer.
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Cleaning the Printer

CClleeaanniinngg tthhee PPrriinntteerr EExxtteerriioorr
Regular cleaning keeps the touch screen, control panel, and exterior areas of the printer free from
dust and dirt.

To clean the printer exterior:

1. To avoid activating buttons and menus when cleaning the printer, press the Power/Wake button,
then touch Sleep.

2. To remove fingerprints and smudges, clean the touch screen and control panel with a soft, lint-
free cloth.

Note: There is a lint-free cloth stored in a compartment on the document feeder.
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3. To return the printer to Ready mode, press the Power/Wake button.

4. Use a soft, lint-free cloth to clean the outside of the output tray, paper trays, and other exterior
areas of your printer.

CClleeaanniinngg tthhee SSccaannnneerr
To ensure optimum print quality, clean the document glass regularly. Cleaning helps avoid output
with streaks, smears, and other marks that transfer from the glass while scanning documents.

Note: For best results, use Xerox® Glass Cleaner to remove marks and streaks.

1. Slightly dampen a soft, lint-free cloth with water.

Note: There is a lint-free cloth stored in a compartment on the document feeder.

2. Remove any paper or other media from the output tray.

3. Open the document cover.

4. Wipe the surfaces of the document glass and CVT glass until the surfaces are clean and dry.
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5. Wipe the white underside of the document cover until it is clean and dry.

6. Close the document cover.
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CClleeaanniinngg tthhee DDooccuummeenntt FFeeeedd RRoolllleerrss
Dirt on the document feed rollers can cause paper jams or deteriorate print quality. For best
performance, clean the document feed rollers once a month.

1. Lift the lever and open the top cover of the document feeder.

2. While turning the rollers, wipe the rollers with a clean, lint-free cloth moistened with water.

Note: There is a lint-free cloth stored in a compartment on the document feeder.

Caution: Do not use alcohol or chemical cleaners on the document feed rollers.

3. Close the document feeder top cover. If available, close the document feeder left cover.
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CClleeaanniinngg tthhee SSeeccoonndd--SSiiddee SSccaannnniinngg LLeennss AAsssseemmbbllyy
The second-side scanning lens assembly allows you to make 2-sided scans and copies with a single
pass of the original document. The assembly is on the left side of the document cover and includes a
mirrored glass strip, a metal strip, a white-plastic strip, and rollers.

Note: It is recommended that you clean all parts of the second-side scanning lens assembly
regularly.

To clean the second-side scanning lens assembly:

1. To access the second-side scanning lens assembly, on the left side of the document cover, lower
the lever.

2. To separate the left end of the document cover from the lens assembly, continue to lower the
lever.
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3. Using a soft, lint-free cloth moistened with water, wipe the mirrored glass, metal strip, both sides
of the white-plastic strip, and the rollers. If dirt is difficult to remove, moisten the cloth with a
small amount of neutral detergent, then wipe the parts dry with a dry, soft cloth.

Caution: To prevent damage to the film around the glass, do not press heavily on the
mirrored glass.

4. Return the document cover to the original position, and ensure that the lever is locked in place. If
you touch the document cover, before you close the document feeder, clean the cover.
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CClleeaanniinngg tthhee PPrriinntteerr IInntteerriioorr

CClleeaanniinngg tthhee PPrriinntthheeaadd LLeennsseess
The printer is constructed with four printhead lenses. The printhead lenses require regular cleaning to
maintain print quality. Clean the printhead lens every time the associated drum cartridge is replaced,
or if print quality starts to degrade. For example, if prints have voids or light streaks through one or
more colors, use the following instructions to clean the LED lenses:

WARNING: If you accidentally get toner on your clothes, lightly dust them off as best as you
can. If some toner remains on your clothes, use cool water, not hot, to rinse off the toner. If
toner gets on your skin, wash it off with cool water and a mild soap. If you get toner in your
eyes, wash it out immediately with cool water and consult a doctor.

Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front door of the printer.

2. Remove the waste toner transport unit:

a. To unlock the waste toner transport unit, rotate the locking lever 45 degrees
counterclockwise.
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b. To release the waste toner transport unit, press both orange tabs as shown, then pull out the
unit from the printer.

c. Place the removed waste toner transport unit on a level surface, with the openings facing up.

Caution: To avoid toner spills, do not lay the waste toner transport unit face down, or
on its side.
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3. Remove the printhead LED lens-cleaning rod from inside the front door.

4. For the first printhead, slowly push the cleaning rod into the printhead LED lens cleaning slot until
it stops, then pull out the rod. Repeat this action two more times.

5. Repeat step 4 for each printhead LED lens.

6. Return the cleaning rod to its original location.

7. To insert the waste toner transport unit:
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a. Position the waste toner transport unit as shown.

b. Press the waste toner transport unit toward the printer, until both ends click into place.
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c. To lock the waste toner transport unit, rotate the locking lever 45 degrees clockwise.

8. Close the printer front door.
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Supplies

CCoonnssuummaabblleess
Consumable supplies are printer supplies that become depleted during the operation of the printer.
Consumable supplies for this printer include the following supplies:

• Genuine Xerox® Toner Cartridges in Cyan, Magenta, Yellow, and Black.

• Staple Cartridges and Staple Refills for the Optional Integrated Office Finisher.

• Staple Cartridges and Staple Refills for the Optional Office Finisher or the Office Finisher with
Booklet Maker.

• Staple Cartridges and Staple Refills for the Optional Business Ready Finisher or the Business Ready
Finisher with Booklet Maker.

Note:

• Each consumable includes installation instructions. To replace consumables, refer
to the instructions included with the consumable supply.

• Only install new toner cartridges in your printer. If a used toner cartridge is
installed, then the toner remaining amount displayed can be inaccurate.

• To ensure print quality, the toner cartridge is designed to cease functioning at a
predetermined point.

Caution: Use of toner other than genuine Xerox®Toner can affect print quality and printer
reliability. Xerox® Toner is the only toner designed and manufactured under strict quality
controls by Xerox for specific use with this printer.

RRoouuttiinnee MMaaiinntteennaannccee IItteemmss
Routine maintenance items are printer parts that have a limited life and require periodic replacement.
Replacements can be parts or kits. Routine maintenance items are typically customer-replaceable
parts.

Note: Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:

• Waste Container

• Drum Cartridges

• Transfer Belt Cleaner

• Second Bias Transfer Roller

• Fan Filter

• Hole-Punch Waste Container
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OOrrddeerriinngg SSuupppplliieess

WWhheenn ttoo OOrrddeerr SSuupppplliieess
A warning appears on the control panel when supplies near the replacement time. Verify that you
have replacements on hand. To avoid interruptions to your printing, order these items when the
messages first appear on the control panel. An error message appears on the control panel when
supplies require replacement.

Order supplies from your local reseller or go to www.xerox.com/office/supplies.

Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty or Service
Agreement do not cover damage, malfunction, or degradation of performance caused by use
of non-Xerox supplies, or the use of Xerox supplies not specified for this printer.

SSuuppppllyy SSttaattuuss
You can check the status and percentage of life remaining for your printer supplies at the control
panel or from the Embedded Web Server. When printer supplies near their replacement time, warning
alerts appear on the control panel.

You can customize the alerts that appear on the control panel and configure email alert notifications
using the Embedded Web Server.

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System
Administrator Guide at www.xerox.com/office/ALC81XXdocs.

To check the supplies status at the control panel:

1. At the printer control panel, press the Home button.

2. To view status information for the printer supplies, touch Device→Supplies.

3. To view details about a specific toner cartridge, including the part number for reordering, touch
Cyan,Magenta, Yellow, or Black.

4. To return to the Supplies screen, touch X.

5. To view more details, touch Other Supplies. Scroll through the list, then select an option.

6. To return to the Supplies screen, touch X.

7. To print the Supplies Report, touch Print Supplies Report.

8. To return to the Device screen, touch X.

TToonneerr CCaarrttrriiddggeess
WARNING:

• When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid
contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust.

• Keep toner cartridges out of the reach of children. If a child accidentally swallows toner,
have the child spit out the toner, and rinse out their mouth with water. Consult a physician
immediately.
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WARNING: Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove
spills. Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large
volume of toner, contact your local Xerox representative.

WARNING: Never throw a toner cartridge into an open flame. Remaining toner in the cartridge
can catch fire and cause burn injuries or an explosion.
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RReeppllaacciinngg tthhee TToonneerr CCaarrttrriiddggeess
When it is time to replace a toner cartridge, the printer displays a message on the control panel.

Note: Each toner cartridge includes installation instructions.

To replace a toner cartridge:

Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front cover of the printer.

2. Firmly grip the cartridge handle, then pull the toner cartridge straight out of the printer.
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3. Remove the new toner cartridge from the packaging. Tilt the cartridge up and down, then left
and right 10 times.

4. Hold the new toner cartridge with the arrow facing up, then push the cartridge in slowly until it
stops.
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5. Push gently on the toner cartridge to ensure that it is seated.

6. Close the printer front cover.
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WWaassttee CCoonnttaaiinneerr

RReeppllaacciinngg tthhee WWaassttee CCoonnttaaiinneerr
When it is time to replace the waste container, a message appears on the control panel.

When you replace the waste container, clean the printhead lenses. For details, refer to Cleaning the
Printhead Lenses.

Caution: Spread paper on the floor to catch possible toner spills.

WARNING: If you spill any toner in the printer, wipe it up using a moist cloth. Never use a
vacuum cleaner to remove spilled toner. Sparks inside the vacuum cleaner can cause a fire or
explosion.

WARNING: If you accidentally get toner on your clothes, lightly dust them off as best as you
can. If some toner remains on your clothes, use cool water, not hot, to rinse off the toner. If
toner gets on your skin, wash it off with cool water and a mild soap. If you get toner in your
eyes, wash it out immediately with cool water and consult a doctor.

Note: Each waste container includes installation instructions.

To replace the waste container:

Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front cover of the printer.

2. Remove the new waste container from the packaging. Retain the packaging.
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3. Pull the used waste container out slowly while supporting it with your other hand.

4. Place the used waste container in the plastic bag, then seal the bag firmly using the zipper.

5. Place the used waste container in the empty box.
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6. Hold the left side of the new waste container and slide it into the printer until it clicks.

7. Clean the printhead lenses. For details, refer to Cleaning the Printhead Lenses.

8. Close the printer front cover.
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DDrruumm CCaarrttrriiddggeess

RReeppllaacciinngg tthhee DDrruumm CCaarrttrriiddggeess
When it is time to replace the drum cartridge, a message appears on the control panel.

Note: Each drum cartridge includes installation instructions.

To replace a drum cartridge:

Caution: Do not perform this procedure when the printer is copying or printing.

Caution: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent
lighting. Do not touch or scratch the surface of the drum.

1. Open the front cover of the printer.

2. Remove the waste toner transport unit:

a. To unlock the waste toner transport unit, rotate the locking lever 45 degrees
counterclockwise.

Xerox® AltaLink® C81XX Series Color Multifunction Printer
User Guide

241

Maintenance



b. To release the waste toner transport unit, press both orange tabs as shown, then pull out the
unit from the printer.

c. Place the removed waste toner transport unit on a level surface, with the openings facing up.

Caution: To avoid toner spills, do not lay the waste toner transport unit face down, or
on its side.
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3. To unlock the drum cartridge, turn the orange lever to the right.

4. Grip the orange handle of the drum cartridge as shown, then pull the drum cartridge straight out
of the printer. Place the used drum cartridge in the plastic bag, then place the bag in the box.

WARNING: Do not touch any toner that adheres to the drum cartridge.

5. Remove the packing material from the end of the new drum cartridge.
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6. Rest the new cartridge, along with its black plastic protective shield, in the cartridge slot. Load the
cartridge in the direction of the arrow on the top of the shield.

7. With the guides inserted in the slot, remove the black paper sheet. Remove the tape from the top
of the cartridge shield.

8. Hold the shield, then use the orange handle to push the cartridge into the printer.

9. Continue to push the orange handle until it stops.
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10. Carefully remove the protective shield.

11. To lock the drum cartridge, turn the orange lever to the left.

12. To insert the waste toner transport unit:

a. Position the waste toner transport unit as shown.
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b. Press the waste toner transport unit toward the printer, until both ends click into place.

c. To lock the waste toner transport unit, rotate the locking lever 45 degrees clockwise.

13. Close the printer front door.

14. Dispose of the protective shield and tape as normal office waste.
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RReeppllaacciinngg tthhee TTrraannssffeerr BBeelltt CClleeaanneerr
When it is time to replace the transfer belt cleaner, a message appears on the control panel.

Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front cover of the printer.

2. Remove the waste toner transport unit:

a. To unlock the waste toner transport unit, rotate the locking lever 45 degrees
counterclockwise.
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b. To release the waste toner transport unit, press both orange tabs as shown, then pull out the
unit from the printer.

c. Place the removed waste toner transport unit on a level surface, with the openings facing up.

Caution: To avoid toner spills, do not lay the waste toner transport unit face down, or
on its side.
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3. To unlock the belt cleaner, turn the orange lever to the left. Pull the transfer belt cleaner straight
out of the printer.

Caution: Do not touch any toner adhering to the transfer belt cleaner. Do not tilt the
transfer belt cleaner, toner can spill.

4. Remove the new transfer belt cleaner from the packaging, then remove the protective cover from
new transfer belt cleaner. Retain the packaging.

Caution: Do not touch the surface of the transfer belt cleaner. This action can cause image
quality to deteriorate.

5. Place the used transfer belt cleaner in the packaging.
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6. Support the new transfer belt cleaner with your left hand and slide it straight into the opening
until it stops.

7. Push the belt cleaner until it clicks into place, then to lock the belt cleaner, turn the orange lever
to the right.

8. To insert the waste toner transport unit:

a. Position the waste toner transport unit as shown.
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b. Press the waste toner transport unit toward the printer, until both ends click into place.

c. To lock the waste toner transport unit, rotate the locking lever 45 degrees clockwise.

9. Close the printer front cover.
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SSeeccoonndd BBiiaass TTrraannssffeerr RRoolllleerr

RReeppllaacciinngg tthhee SSeeccoonndd BBiiaass TTrraannssffeerr RRoolllleerr
When the second bias transfer roller needs to be replaced, a message appears on the control panel.

1. Remove paper from the left tray, then fold up the tray.

2. To open Door A, lift the release lever, then open Door A.

WARNING: The area around the fuser can be hot. To avoid injury, use caution.

Caution: Do not touch the transfer belt. Touching the belt can reduce image quality or
damage the transfer belt. Do not touch the transfer roller. Touching the roller can reduce
image quality.

3. Remove the new transfer roller from the packaging. Retain the packaging.
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4. To release the used transfer roller from the printer, pinch the orange levers at each end of the
transfer roller, as shown.

5. Lift the used transfer roller out of the printer.

Note: Do not touch any toner that adheres to the transfer roller.

6. Place the used transfer roller in the plastic bag.
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7. Place the new transfer roller in the printer as shown. Press down until the transfer roller clicks into
place.

8. Remove the protective cover from the transfer roller, then close Door A.

FFaann FFiilltteerr

RReeppllaacciinngg tthhee FFaann FFiilltteerr
When it is time to replace the fan filter, the printer displays a message on the control panel.

1. Remove the new fan filter from the packaging. Retain the packaging.

2. To remove the fan filter cover, press down on the R9 cover release tab, then lift the cover away
from the printer.
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3. To remove the fan filter, grasp the orange tab and pull it toward you. Pull the fan filter out of the
printer.

Caution:When you replace the fan filter, be careful not to spill any toner residue. If any
toner spills, avoid contact with clothes, skin, eyes, and mouth.

4. Place the used fan filter in the plastic bag. Dispose as normal office waste.

5. To insert the new fan filter, grasp the orange tab, then push the fan filter into the slot until it
stops.

6. Replace the fan filter cover.

7. To confirm that you replaced the fan filter, when the confirmation message appears, touch Yes.

Note: If the confirmation message does not appear, to generate the message, open, then
close, the front door of the printer.
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SSttaappllee CCaarrttrriiddggeess aanndd SSttaappllee RReeffiillllss
When a staple cartridge is empty, a message appears on the control panel.

RReeppllaacciinngg SSttaapplleess iinn tthhee IInntteeggrraatteedd OOffffiiccee FFiinniisshheerr
Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the finisher front door.

2. To remove the staple cartridge, grasp the orange handle, then pull it firmly toward you.

3. Check inside the finisher for any loose staples and remove them.

4. Pinch both sides of the staple pack and remove the staple pack from the cartridge.
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5. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into
the cartridge.

6. Grasp the new staple cartridge by the orange handle, then insert the cartridge into the stapler
until it clicks.

7. Close the finisher front door.
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RReeppllaacciinngg SSttaapplleess iinn tthhee OOffffiiccee FFiinniisshheerr

Replacing Staples in the Main Stapler of the Office Finisher

Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the finisher front door.

2. Reach into the finisher cabinet and pull the stapler toward you until it stops.

3. Push the stapler assembly to the right, as shown.

4. To remove the staple cartridge, grasp the orange handle, then pull it firmly toward you.
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5. Pinch both sides of the staple pack and remove the staple pack from the cartridge.

6. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into
the cartridge.

7. Grasp the new staple cartridge by the orange handle, then insert the cartridge into the stapler
assembly until it clicks.

8. Close the finisher front door.
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Replacing Staples in the Booklet Maker of the Office Finisher

WARNING: Do not perform this procedure while the printer is printing.

1. Open the finisher side cover.

2. If the staple cartridges are not visible, grip the vertical panels at the left and right of the opening
and slide the panels to the center.

3. Hold the tabs on both sides of the staple cartridge and pull the cartridge out of the finisher.
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4. Hold the tabs on both sides of the new staple cartridge and insert the cartridge into the original
position in the finisher.

Note: If you have trouble inserting the cartridge, ensure that the staples are positioned
correctly in the cartridge.

Note: The booklet maker uses two staple cartridges. Booklet stapling requires that both
staple cartridges contain staples.

5. Repeat the procedure for the other staple cartridge.

6. Close the finisher side cover.
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RReeppllaacciinngg SSttaapplleess iinn tthhee BBuussiinneessss RReeaaddyy FFiinniisshheerr

Replacing Staples in the Main Stapler of the Business Ready Finisher

Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front door of the Business Ready finisher.

2. Grasp the stapler assembly lever R1, then move the lever to the right.

3. To remove the staple cartridge, grasp the orange handle, then pull it firmly toward you.
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4. Pinch both sides of the staple pack and remove the staple pack from the cartridge.

5. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into
the cartridge.

6. Grasp the new staple cartridge by the orange handle, then insert the cartridge into the stapler
assembly until the staple cartridge clicks into place.

7. Return the stapler assembly to its original position, then close the finisher door.
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Replacing Staples in the Booklet Maker of the Business Ready Finisher

Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front door of the Business Ready Finisher.

2. Grasp the booklet maker handle and pull the unit toward you until the staple cartridges appear
on the top edge of the device.

3. To remove a staple cartridge from the booklet maker, push down on the staple cartridge handle,
as shown, then pull the cartridge out and up.

4. Turn over the staple cartridge.
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5. To remove the staple pack from the staple cartridge, press in the green tabs and pull back the
handle, then lift out the staple pack.

6. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into
the cartridge.

7. To close the staple cartridge, push back the cartridge handle until it clicks.
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8. To return the staple cartridge to the booklet maker, insert the staple cartridge and push up on the
cartridge handle as shown.

9. Return the booklet maker to its original position, then close the finisher door.
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Replacing Staples in the Convenience Stapler
1. Lift the lever at the rear of the convenience stapler, then gently rotate the staple head toward

you.

2. Grip the staple cartridge and pull it out of the stapler head.

3. Unpack the new staple cartridge. Remove any partial strips and any staple strips that are not flat.

4. Install the new staple cartridge in the convenience stapler. The staple cartridge clicks into place.

5. Release the lever at the front of the convenience stapler, then gently rotate the staple head away
from you.

EEmmppttyyiinngg tthhee HHoollee PPuunncchh WWaassttee CCoonnttaaiinneerr
A message appears on the control panel when the hole punch waste container is full.
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EEmmppttyyiinngg tthhee HHoollee PPuunncchh WWaassttee CCoonnttaaiinneerr iinn tthhee OOffffiiccee FFiinniisshheerr
Caution: Do not perform this procedure when the printer is copying or printing.

1. Lift the finisher transport top cover, then open the front transport cover.

2. Pull out the hole-punch waste container.

3. Empty the container.
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4. Insert the container all the way into the finisher.

5. Close the finisher front transport cover, then close the top cover.

Xerox® AltaLink® C81XX Series Color Multifunction Printer
User Guide

269

Maintenance



EEmmppttyyiinngg tthhee HHoollee PPuunncchh WWaassttee CCoonnttaaiinneerr iinn tthhee BBuussiinneessss RReeaaddyy
FFiinniisshheerr

Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front door of the Business Ready Finisher.

2. Remove the hole punch waste container from its slot near the top left of the finisher.

Note:

• When you remove the hole punch waste container, wait 10 seconds before you reinsert
it into the printer. The hole punch counter resets after 10 seconds.

• If you remove the hole punch waste container before the device instructs you to, empty
the container before you reinsert it into the finisher.

3. Empty the container.
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4. Insert the container all the way into the finisher.

5. Close the front door of the finisher.

RReeccyycclliinngg SSuupppplliieess
For information on Xerox® supplies recycling programs, go to www.xerox.com/gwa .

Supplies include a prepaid return label. Please use it to return used components in their original boxes
for recycling.

RReesseettttiinngg SSuuppppllyy LLiiffee CCoouunntteerrss
You must reset the supply life counters when you replace some supplies.

1. At the printer control panel, press the Home button.

2. Touch the Log In button, enter the system administrator login information, then touch Done. For
details, refer to the System Administrator Guide at www.xerox.com/office/ALC81XXdocs.

3. Touch Device→Tools→Device Settings→Supplies.

4. Touch Supply Counter Reset.

5. To select an item to reset, touch the supply item in the list, then touch Reset Counter.

6. On the confirmation screen, touch Reset.

7. To return to the Tools screen, touch X, then touch X again.

8. To return to the Home screen, press the Home button.

9. Touch the Log In button, then touch Logout.
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Managing the Printer

VViieewwiinngg tthhee MMeetteerr RReeaaddiinngg
The Billing/Usage menu displays the total number of impressions that the printer generated or
printed during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of
paper. For example, a sheet of paper that is printed on two sides counts as two impressions.

Note: If you provide regular billing information for your device, you can use the Remote
Services Upload feature to simplify the process. You can enable Remote Services to send billing
meter readings to Xerox automatically so that you do not have to collect the readings
manually. Refer to the System Administrator Guide for further information.

To view the billing information for your printer:

1. At the printer control panel, press the Home button.

2. Touch Device→Billing/Usage.

3. To view more details, touch Usage Counters, then select an option.

4. After viewing the usage readings, to return to the Device screen touch X, then touch X again.

5. To return to the Home screen, press the Home button.

PPrriinnttiinngg tthhee BBiilllliinngg SSuummmmaarryy RReeppoorrtt
The Billing Summary Report provides information about the device and a detailed listing of the billing
meters and sheet counts.

To print the Billing Summary Report:

1. At the printer control panel, press the Home button.

2. Touch Device→Information Pages.

3. Touch Billing Summary, then touch Print.

4. To return to the Home screen, press the Home button.
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Moving the Printer
• Always power off the printer and wait for the printer to shut down. To power off the printer, verify

that there are no jobs in the queue, then press the secondary power switch. After the touch screen
goes dark, wait 10 seconds, then power off the main power switch. For details, refer to Power
Options.

• Disconnect the power cord from the back of the printer.

• To avoid spilling toner, keep the printer level.

Note:When moving the printer over a long distance, to prevent toner from spilling, remove the
drum cartridges and toner cartridges. Pack the printer inside a box.

Caution: Failure to repackage the printer properly for shipment can result in damage not
covered by the Xerox® Warranty or Service Agreement. The Xerox® Warranty or Service
Agreement do not cover damage to the printer caused by improper moving.
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General Troubleshooting
This section contains procedures to help you locate and resolve problems. Resolve some problems by
simply restarting the printer.

RReessttaarrttiinngg tthhee PPrriinntteerr
The printer has two power switches. The main power switch, located behind the front door, controls
the main power to the printer. The secondary power switch is the Power/Wake button on the control
panel. The Power/Wake button controls power to the printer electronic components, and when
powered off, initiates a software-controlled shutdown. The preferred method to power on and off the
printer is to use the Power/Wake button.

To operate the printer, power on both switches:

1. Power on the main power switch.

2. At the control panel, press the Power/Wake button.

3. To restart the printer:

a. At the control panel, press the Power/Wake button, then touch Restart. A message appears
on the control panel that warns you that the printer is restarting.

b. If the printer does not restart after several minutes, open the front door, then power off the
main power switch. To restart the printer, power on the main switch, then press the Power/
Wake button on the control panel.

c. Close the front door.

If restarting the printer does not resolve the issue, see the table in this chapter that best describes the
problem.
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PPrriinntteerr HHaass TTwwoo PPoowweerr SSwwiittcchheess
Probable Causes Solutions

The printer has two power switches and one is not
powered on.

Power off the printer.

• Press the Power/Wake button on the control
panel.

• Open the front door and power off the main
power switch.

Power on the printer.

• Open the front door, then power on the main
power switch.

• At the printer control panel, press the Power/
Wake button. For details, refer to Power Options.

PPrriinntteerr DDooeess NNoott PPoowweerr OOnn
Probable Causes Solutions

The power switch is not switched on. • Open the front door and check that the main
power switch is in the On position.

• At the printer control panel, press the Power/
Wake button. For details, refer to Power Options.

The power cord is not plugged into the outlet
correctly.

Power off the printer, then plug the power cord into
the outlet securely. Use the bracket provided with the
printer to secure the power cord in place.

Something is wrong with the outlet connected to the
printer.

• Plug another electrical appliance into the outlet
and check if it operates properly.

• Try a different outlet.

The printer is connected to an outlet with a voltage
or frequency that does not match the printer
specifications.

Use a power source with the specifications listed in
the Electrical Specifications.

Caution: Plug the three-wire cord with grounding prong directly into a grounded AC outlet. Do
not use a power strip. If necessary, contact a licensed electrician to install a properly grounded
outlet.
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PPrriinntteerr RReesseettss oorr PPoowweerrss OOffff FFrreeqquueennttllyy

Probable Causes Solutions

The power cord is not plugged into the outlet
correctly.

Power off the printer. Confirm that the power cord is
plugged in correctly to the printer and the outlet,
then power on the printer.

A system error occurred. Power off the printer, then power on again. If the
error persists, contact your Xerox representative.

The printer is connected to an uninterruptible power
supply (UPS), extension cord, or power strip.

Only use an extension cord designed to handle the
electrical current capacity of the printer. For details,
refer to Electrical Specifications.

A network configuration problem exists. Unplug the network cable. If the problem is not
resolved, contact your system administrator to
reconfigure your network installation.

The printer is connected to an outlet with a voltage
or frequency that does not match the printer
specifications.

Use a power source with the specifications listed in
Electrical Specifications.

PPrriinntteerr DDooeess NNoott PPrriinntt
Probable Causes Solutions

The printer is in Power Saver mode. On the control panel, press the Power/Wake button.

The printer has an error. If the Status LED is blinking amber, to clear the error,
follow the instructions on the control panel. If the
error persists, contact your Xerox representative.

The printer is out of paper. Load paper into the tray.

A toner cartridge is empty. Replace the empty toner cartridge.

A drum cartridge has reached end of life. Replace the drum cartridge.

No control panel indicators are lighted. Power off the printer, confirm that the power cord is
plugged in correctly to the printer and the outlet,
then power on the printer. If the error persists,
contact your Xerox representative.

The printer is busy. • If the Status LED is flashing blue, a previous print
job could be the problem.
1 At your computer, use the printer properties to

delete all print jobs in the print queue.
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Probable Causes Solutions

2 At the control panel, touch Jobs, then delete
all pending print jobs.

• Load the paper in the tray.
• If the Status LED does not flash once after you

send a print job, check the connection between
the printer and the computer. Power off the
printer, then power on.

The printer cable is disconnected. If the Status LED does not flash once after you send
a print job, check the connection between the printer
and the computer.

There is a wireless or network connectivity issue. To test the printer, print an Information Page, such as
the Configuration Report. If the page prints, there
could be a wireless or network connectivity issue.

Contact your system administrator or refer to the
System Administrator Guide at www.xerox.com/
office/ALC81XXdocs.

Incorrect print driver. Check that you have the latest print driver installed.
For details, go to www.xerox.com/office/
ALC81XXsupport.

PPrriinnttiinngg TTaakkeess TToooo LLoonngg

Probable Causes Solutions

The printer is set to print on a paper type that
requires slower printing.

Certain paper types, like heavyweight paper and
transparencies, take more time to print. Ensure that
the print driver and control panel are set to the
proper paper type.

The printer is in Power Saver mode. Wait. It takes time for printing to start after the
printer exits Power Saver mode.

The way the printer was installed on the network
could be an issue.

• Determine if a print spooler or a computer sharing
the printer is buffering all print jobs and then
spooling them to the printer. Spooling can slow
print speeds.

• To test the speed of the printer, print multiple
copies of an information page, such as a demo
page. If the page prints at the rated speed of the
printer, there could be a network or printer
installation issue. For additional help, contact the
system administrator.

The job is complex. Wait. No action needed.
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DDooccuummeenntt FFaaiillss ttoo PPrriinntt
Probable Causes Solutions

Selected tray has wrong paper size loaded, or paper
type or color is not available.

To view the Job Status for a failed print on the touch
screen:

1 At the printer control panel, press the Home
button.

2 Touch Jobs.
3 From the jobs list, touch the held job name. The

resources required for the job appear on the
control panel.

4 Do one of the following:
• To print the job, replenish the resources

required. The job resumes automatically when
the required resources are available. If the job
does not print automatically, touch Resume.

• To choose an alternative paper source to
enable the job to print, touch Print On
Alternate Paper. Select a paper tray, then
touch OK.

• To delete the print job, touch Delete. At the
prompt, touch Delete.

Note: The Print On Alternate Paper
option is enabled using the
Embedded Web Server.

5 To return to the Home screen, press the Home
button.

Incorrect network settings. To reset network settings, contact your system
administrator or refer to the System Administrator
Guide at www.xerox.com/office/ALC81XXdocs.
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Probable Causes Solutions

The way the printer was installed on the network
could be an issue.

• Ensure that the printer is connected to the
network.

• Determine if a print spooler or a computer sharing
the printer is buffering all print jobs and then
spooling them to the printer. Spooling can slow
print speeds.

• To test the printer, print an information page,
such as the Configuration Report. If the page
prints, there could be a network or printer
installation issue. For help, contact the system
administrator.

Application and print driver have conflicting tray
selections.

For details, see Document Prints from Wrong Tray.

DDooccuummeenntt PPrriinnttss ffrroomm WWrroonngg TTrraayy

Probable Causes Solutions

Application and print driver have conflicting tray
selections.

1 Check the tray selected in the print driver.
2 Access the page setup or printer settings of the

application from which you are printing.
3 Set the paper source to match the tray selected in

the print driver or set the paper source to
Automatically Select.

4 Check that you have the latest print driver
installed. For details, go to www.xerox.com/office/
ALC81XXsupport.

Note: To have the print driver select the tray,
set the tray used as the paper source to Auto
Selection Enabled.

PPrriinntteerr iiss MMaakkiinngg UUnnuussuuaall NNooiisseess

Probable Causes Solutions

One of the trays is not installed correctly. Open and close the tray from which you are printing.

There is an obstruction or debris inside the printer. Power off the printer and remove the obstruction or
debris. If you cannot remove the obstruction, contact
your Xerox® service representative.

The printer beeps at each touch on the control panel. Check the Alerts setting. For details, refer to the
System Administrator Guide at www.xerox.com/
office/ALC81XXdocs.
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AAuuttoommaattiicc 22--SSiiddeedd PPrriinnttiinngg PPrroobblleemmss

Probable Causes Solutions

Unsupported or incorrect paper. Ensure that you are using the correct paper. Do not
use transparencies, envelopes, labels, or reloaded
paper for automatic 2-sided printing. For details, see
Supported Paper.

Incorrect setting. On the print driver Printing Options tab, select 2-
Sided Print.

DDaattee aanndd TTiimmee AArree IInnccoorrrreecctt
Probable Causes Solutions

The Date and Time Setup is set to Manual (NTP
Disabled).

To change the Date and Time to Automatic, in the
Embedded Web Server, enable NTP. For details, refer
to the System Administrator Guide at www.xerox.
com/office/ALC81XXdocs.

The time zone, date, or time is set incorrectly. Set the time zone, date, and time manually. For
details, refer to the System Administrator Guide at
www.xerox.com/office/ALC81XXdocs.

SSccaannnneerr EErrrroorrss
Probable Causes Solutions

Scanner is not communicating. Power off the printer, and check the scanner cable.
Wait two minutes and power on the printer again.

If the problem is not resolved, contact your Xerox®
service representative.
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Paper Jams

LLooccaattiinngg PPaappeerr JJaammss
WARNING: Parts that are near the fuser are hot. To prevent personal injury, never touch an
area that has a Caution label. Power off the printer immediately, then wait 40 minutes for the
fuser to cool. After the printer has cooled, try to remove the jammed paper. If the error on the
control panel remains, contact your Xerox representative.

Caution: Do not attempt to clear any paper jams using tools or instruments. This action can
damage the printer permanently.

The following illustration shows where paper jams can occur along the paper path:

1. Door B

2. Tray 5

3. Door A

4. Left Tray

5. Duplex Automatic Document Feeder

6. Document Output Tray

7. Finisher Areas

8. Paper Trays 1–4
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MMiinniimmiizziinngg PPaappeerr JJaammss
The printer is designed to function with minimal paper jams using Xerox supported paper. Other
paper types can cause jams. If supported paper is jamming frequently in one area, clean that area of
the paper path. To avoid damage, always remove jammed paper carefully without tearing it. Try to
remove the paper in the same direction it normally moves through the printer. Even a small piece of
paper left in the printer can cause a jam. Do not reload paper that has jammed.

The following can cause paper jams:

• Selecting the incorrect paper type in the print driver.

• Using damaged paper.

• Using unsupported paper.

• Loading paper incorrectly.

• Overfilling the tray.

• Adjusting the paper guides improperly.

Most jams can be prevented by following a simple set of rules:

• Use only supported paper. For details, refer to Supported Paper.

• Follow proper paper handling and loading techniques.

• Always use clean, undamaged paper.

• Avoid paper that is curled, torn, moist, creased, or folded.

• To separate the sheets before loading into the tray, fan the paper.

• Observe the paper tray fill line; never overfill the tray.

• Remove transparencies from the output tray immediately after printing.

• Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted
can cause poor print quality, misfeeds, skewed prints, and printer damage.

• After loading the trays, select the correct paper type and size on the control panel.

• When printing, select the correct type and size in the print driver.

• Store paper in a dry location.

• Use only Xerox paper and transparencies designed for the printer.

Avoid the following:

• Polyester coated paper that is designed especially for inkjet printers.

• Highly glossy or coated paper.

• Paper that is folded, wrinkled, or excessively curled.

• Fanning transparencies before loading in the paper tray.

• Loading more than one type, size, or weight of paper in a tray at the same time.

• Loading hole punched paper or paper with folded corners or staples in the document feeder.

• Overfilling the paper trays.

• Allowing the output tray to overfill.

• Allowing the output tray to fill with more than a few transparencies.
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CClleeaarriinngg PPaappeerr JJaammss
To clear jams, watch the video and follow the instructions on the control panel. To resolve the error
that appears on the control panel, remove all paper from the areas shown. If the error does not clear,
check the jam areas again to ensure that all paper has been removed. Ensure that all levers, covers,
and doors have been closed correctly.

To avoid damage, always remove jammed paper carefully without tearing it. Try to remove the paper
in the same direction it normally moves through the printer. Even a small piece of paper left in the
printer can cause a jam. Do not reload paper that has jammed.

Note: Do not touch the printed side of the paper when removing it. The printed side of
jammed pages could smudge, and the toner could stick to your hands. Avoid spilling any toner
inside the printer.

WARNING: If you accidentally get toner on your clothes, lightly dust them off as best as you
can. If some toner remains on your clothes, use cool water, not hot, to rinse off the toner. If
toner gets on your skin, wash it off with cool water and a mild soap. If you get toner in your
eyes, wash it out immediately with cool water and consult a doctor.

CClleeaarriinngg JJaammss iinn tthhee DDooccuummeenntt FFeeeeddeerr
1. Lift the lever and open the top cover of the document feeder.

2. If the original document is not caught in the entry to the document feeder, pull the document
straight out in the direction shown.
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3. Clear the document feeder area. The instructions vary depending on your printer model:
• If the message on the control panel instructs you to turn the green wheel, turn the wheel in

the direction shown. Turning the green wheel moves the original document out of the feeder.
Remove the jammed document in the direction shown, then close the document feeder top
cover.

• If the message on the control panel instructs you to clear the document feeder left cover
area, remove the jammed original document in the direction shown. Close the document
feeder top cover, then close the document feeder left cover.

4. Lift the document feeder, then remove the original document from the document glass.
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5. To access the second-side scanning lens assembly, on the left side of the document cover, lower
the lever. Remove the original document in the direction shown.

6. If the original document is not visible when the document feeder is opened, close the document
feeder. Lift the document feeder tray, then remove the jammed paper.

7. Lower the document feeder tray.

8. If the original document is not wrinkled or torn, load document into the feeder again, following
the instructions on the control panel.

Note: After clearing a document-feeder jam, reload the entire document, including the pages
that are scanned already. The printer skips the scanned pages automatically, then scans the
remaining pages.

Caution: Torn, wrinkled, or folded original documents can cause jams and damage the printer.
To copy torn, wrinkled, or folded original documents, use the document glass.
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CClleeaarriinngg JJaammss aatt TTrraayyss 11––44
1. Before you remove any tray from the printer, view the paper jam message on the control panel.

Remove the jam that is shown on the control panel, then remove other paper jams.

2. Pull out the tray until it stops.

3. Remove the paper from the tray.

4. If the paper is torn, remove the tray completely, then check inside the printer for torn pieces of
paper.

5. Reload the tray with undamaged paper, then push the tray in until it stops.

6. At the control panel, if a prompt appears, select the correct paper size, type, and color.
• To select a new paper size, touch Size.
• To select a new paper type, touch Type.
• To select a new paper color, touch Color.
• To confirm the settings, touch Confirm.

Note: If a prompt does not appear, and you have changed the paper size, type, or color,
update the Required Paper Policies. For details, refer to the System Administrator Guide at
www.xerox.com/office/ALC81XXdocs.

7. To return to the Home screen, press the Home button.

288 Xerox® AltaLink® C81XX Series Color Multifunction Printer
User Guide

Troubleshooting

https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC81XX&PgName=Man


CClleeaarriinngg JJaammss aatt TTrraayy 55 ((BByyppaassss TTrraayy))
1. Remove the jammed paper from the tray. Ensure that the paper feed entrance where the tray

connects to the printer is clear.

2. If the paper is torn, check inside the printer for torn pieces of paper.

3. Fan the paper that you removed and ensure that all four corners of the paper are aligned.

4. Insert the paper into tray 5 with the printing side face down. Ensure that the leading edge of the
paper touches the paper feed entrance.

5. At the control panel, select the correct paper size, type, and color:
• To select a new paper size, touch Size.
• To select a new paper type, touch Type.
• To select a new paper color, touch Color.

6. To confirm the settings, touch Confirm.
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CClleeaarriinngg JJaammss aatt TTrraayy 66
To resolve the error that appears on the control panel, follow the instructions provided and remove all
paper from the Tray 6 area.

1. Pull Tray 6 away from the side of the printer until the tray stops.

2. Remove any jammed paper from the side of the tray.

3. Open the top cover, lift the inner cover, then remove any jammed paper in the direction shown.

4. Close the top cover, then push the tray back toward the printer, until it locks into position.
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5. At the high capacity feeder, squeeze the handle, and pull out Tray 6 until it stops.

6. Remove the damaged paper from the tray.

7. Reload the tray with undamaged paper, close the side gate, then close the tray.

8. At the control panel, select the correct type and color.
• To select a new paper type, touch Type.
• To select a new paper color, touch Color.

9. To confirm the settings, touch Confirm.
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CClleeaarriinngg JJaammss aatt DDoooorr AA
1. Remove paper from the left tray, then close the tray.

2. Lift the release lever for door A, then open door A as shown.

WARNING: To avoid injury, use caution. The area around the fuser can be hot.

Caution: Do not touch the transfer belt. Touching the belt can reduce image quality or
damage the transfer belt. Do not touch the transfer roller. Touching the roller can reduce
image quality.
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3. Remove the jammed paper.

4. If paper is jammed on the inside of door A, lift handle A3, then remove the jammed paper.
Return handle A3 to the original position.

5. If paper is jammed in the fuser, remove the jammed paper from areas A1 and A2.

a. To open the paper guide, pull handle A1 toward you.
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b. Remove any jammed paper in area A1.

c. Return handle A1 to the original position.

d. To open the paper guide, lift handle A2.
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e. Remove any jammed paper in area A2.

Note: If the paper is torn, remove all torn pieces of jammed paper from the printer.

f. To close the paper guide, push down handle A2, then push in the handle until the paper
guide clicks into place.
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6. If the paper is jammed at the exit to the center output tray, pull the jammed paper in the
direction shown.

Note: Toner can adhere to the transfer roller. The toner that does adhere to the transfer
roller does not affect print quality.

7. To close door A, push up the door until it clicks into place.
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CClleeaarriinngg JJaammss aatt DDoooorr BB
1. To open door B, lift the release lever and open door B.

2. Remove the jammed paper from the door B upper and lower areas.

Note:

• If the paper is torn, remove all torn pieces of paper from the printer.

• If the paper is inaccessible, refer to Clearing Jams at Door A.

3. For paper that is jammed in the paper tray, open the tray and remove the paper.

4. To close door B, push up the door until it clicks into place.

TTrroouubblleesshhoooottiinngg PPaappeerr JJaammss

MMuullttiippllee SShheeeettss PPuulllleedd TTooggeetthheerr

Probable Causes Solutions

The paper tray is too full. Remove some of the paper. Do not load paper past
fill line.

The edges of the paper are not even. Remove the paper, align the edges, and then reload
it.
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Probable Causes Solutions

The paper is moist from humidity. Remove the paper from the tray, and replace it with
new dry paper.

Too much static electricity is present. • Try a new ream of paper.
• Do not fan transparencies before loading in tray.

Using unsupported paper. Use only Xerox approved paper. For details, refer to
Supported Paper.

Humidity is too high for coated paper. Feed paper one sheet at a time.

JJaammss iinn tthhee DDooccuummeenntt FFeeeeddeerr

Probable Causes Solutions

Unsupported paper of the wrong size, thickness, or
type.

Use only Xerox-approved paper. For details, see
Supported Paper.

Originals are torn, previously stapled, bent, or folded. Ensure that the originals are not torn, bent, or folded.
If previously stapled, remove all staples and separate
the sheets by fanning them.

The documents loaded in the document feeder
exceed the maximum capacity allowed.

Place fewer documents in the document feeder.

Improperly adjusted document feeder guides. Adjust the paper guides to fit snugly against the
paper loaded in the document feeder.
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PPaappeerr MMiissffeeeeddss aanndd PPaappeerr SSiizzee JJaammss

Probable Causes Solutions

The paper is not correctly positioned in the tray. • Remove the misfed paper and reposition it
properly in the tray.

• Adjust the paper guides in the tray to match the
size of the paper.

The paper tray is too full. Remove some of the paper. Do not load paper past
the fill line.

The paper guides are not correctly adjusted to the
paper size.

1 Remove the paper.
2 Adjust the paper guides in the tray to match the

size of the paper.
3 Replace the paper.

The tray contains warped or wrinkled paper. Remove the paper, smooth it out, and reload it. If it
still misfeeds, do not use that paper.

The paper is moist from humidity. Remove the moist paper and replace it with new, dry
paper.

Using paper of the wrong size, thickness, or type. Use only Xerox approved paper. For details, refer to
Supported Paper.

LLaabbeell aanndd EEnnvveellooppee MMiissffeeeeddss

Probable Causes Solutions

The label sheet is facing the wrong way in the tray. Load label sheets according to the instructions from
the manufacturer.

• Load labels face up in trays 1–4.

Note: Do not load labels in tray 5.

Envelopes are loaded in the wrong tray. Use tray 5 to print envelopes.
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Probable Causes Solutions

Envelopes are loaded incorrectly in tray 5. To load envelopes in tray 5:

• For envelopes with the flap on a long edge, load
envelopes face down with the flaps closed, and
the flaps toward the right.

• For envelopes with a self-seal flap on a short
edge, load envelopes face down with the flaps
closed, and the flaps toward the right.

• For envelopes with a non-adhesive flap on a short
edge, load envelopes face down with the flaps
open, and the flaps toward the left.

• Load C4 and custom-size envelopes longer than
320 mm (12.6 in.) short-edge feed, with the flaps
closed, and the flaps toward the right. For custom-
size envelopes, define a custom size on the
control panel.

Envelopes are loaded incorrectly in the envelope tray. To load the envelope tray:

• For envelopes with the flap on a long edge, load
envelopes face up, with the flaps closed, and the
flaps on the left side of the tray.

• For 6 3/4 envelopes, and short-edge feed custom
envelope sizes, load envelopes with the flaps
closed, and the flaps toward the front.

PPaappeerr JJaamm MMeessssaaggee SSttaayyss OOnn

Probable Causes Solutions

Some paper remains jammed in the printer. Recheck the media path and make sure that you
have removed all of the jammed paper.

One of the printer doors is open. Check the doors on the printer. Close any door that is
open.

Note: Check for, and remove, torn pieces of paper in the paper path.
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JJaammss DDuurriinngg AAuuttoommaattiicc 22--SSiiddeedd PPrriinnttiinngg

Probable Causes Solutions

Using paper of the wrong size, thickness, or type. Use paper of the correct size, thickness, or type. For
details, see Supported Paper.

Paper type is set incorrectly in the print driver. Ensure that the paper type is set correctly in the
driver and that the paper is loaded in the correct tray.
For details, see Supported Paper.

Paper is loaded in the wrong tray. Ensure that paper is loaded into the correct tray. For
details, refer to Supported Paper.

Tray is loaded with mixed paper. Load the tray with only one type and size of paper.

CClleeaarriinngg FFiinniisshheerr JJaammss

CClleeaarriinngg JJaammss iinn tthhee IInntteeggrraatteedd OOffffiiccee FFiinniisshheerr
1. Open the finisher front door.

2. Carefully remove the jammed paper.

Note: If the paper is torn, remove all torn pieces of jammed paper from the printer.
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3. Rotate the green knob in the direction shown, then carefully remove the jammed paper.

4. Close the finisher front door.
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CClleeaarriinngg JJaammss iinn tthhee OOffffiiccee FFiinniisshheerr

Clearing Jams Under the Office Finisher Top Cover
1. Pull up the lever on the top cover, then open the top cover.

2. Remove the jammed paper.

Note: If the paper is torn, remove all torn pieces of the jammed paper from the finisher.

3. Close the top cover of the finisher.

Xerox® AltaLink® C81XX Series Color Multifunction Printer
User Guide

303

Troubleshooting



Clearing Jams in the Office Finisher Transport
1. To open the transport cover, lift the handle of the center tray straight up.

2. Remove the jammed paper.

Note: If the paper is torn, remove all torn pieces of the jammed paper from the finisher.

3. Close the transport cover.
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CClleeaarriinngg JJaammss iinn tthhee BBuussiinneessss RReeaaddyy FFiinniisshheerr

Clearing Jams in the Center Tray
1. If the paper is jammed at the exit to the center output tray, pull the paper in the direction shown.

2. Open, then close, the finisher transport cover.
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Clearing Jams in the Finisher Transport
1. Open the finisher transport cover.

2. Remove the jammed paper.

Note: If the paper is torn, remove all torn pieces from the finisher.

3. Close the finisher transport cover.
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Clearing Jams at Area 3a in the Business Ready Finisher
1. If the jammed paper is visible at the output tray exit, pull out the jammed paper in the direction

shown.

2. Open the front door of the Business Ready Finisher.

3. Lift handle 3a, then carefully remove the jammed paper.

Note: If the paper is torn, remove all torn pieces of the jammed paper from the finisher.
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4. Return handle 3a to the original position.

5. Close the front door of the Business Ready Finisher.

Clearing Jams at Area 3c in the Business Ready Finisher
1. Open the front door of the Business Ready Finisher.

2. Move lever 3c to the left.
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3. Carefully remove the jammed paper.

Note:

• If the paper is torn, remove all torn pieces of paper from the finisher.

• If the paper is inaccessible, or if the control panel prompts you, to release the jammed
paper, rotate knob 3b in the direction shown.

4. Return lever 3c to the original position.

5. Close the front door of the Business Ready finisher.
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Clearing Jams at Area 3d in the Business Ready Finisher
1. Open the front door of the Business Ready Finisher.

2. Move lever 3d to the right.

3. Carefully remove the jammed paper.

Note: If the paper is torn, remove all torn pieces of the jammed paper from the finisher.

4. Return lever 3d to the original position, then close the front door of the Business Ready Finisher.
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Clearing Jams at Area 4 in the Business Ready Finisher
1. Open the front door of the Business Ready Finisher.

2. Grasp the handle, then pull out the booklet maker until it stops.
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3. Rotate knob 4 in either direction as shown, then carefully remove the paper.

Note: If the paper is torn, remove all torn pieces of the jammed paper from the finisher.

4. Return the booklet maker to its original position, then close the finisher door.
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Clearing Jams in the Booklet Tray
1. Open the front door of the Business Ready Finisher.

2. To release the jammed paper, rotate knob 4 in the direction shown.

3. To remove the paper, pull the paper in the direction shown.

Note: If the paper is torn, remove all torn pieces of the jammed paper from the finisher.

4. Close the front door of the Business Ready Finisher.
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CClleeaarriinngg JJaammss iinn tthhee TTrrii--FFoolldd MMoodduullee

Clearing Jams at Area 2a in the Tri-Fold Module
1. Open the front door of the tri-fold module.

2. Lift handle 2a, then carefully remove the jammed paper.

Note: If the paper is torn, remove all torn pieces of paper from the folder.

3. Return handle 2a to the original position.

4. Close the front door of the tri-fold module.
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Clearing Jams at Area 2b in the Tri-Fold Module
1. Open the front door of the tri-fold module.

2. Move lever 2b to the left, then remove the jammed paper.

Note: If the paper is torn, remove all torn pieces of paper from the folder.

3. Return lever 2b to the original position.

4. Close the front door of the tri-fold module.
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Clearing Jams at Area 2e in the Tri-Fold Module
1. Open the front door of the tri-fold module.

2. Open the folder tray, move lever 2e to the right, then carefully remove the paper.

Note: If the paper is torn, remove all torn pieces of paper from the folder.

3. Return lever 2e to the original position, then close the folder tray.

4. Close the front door of the tri-fold module.
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Clearing Jams at Area 2f in the Tri-Fold Module
1. Open the front door of the tri-fold module.

2. Open the folder tray, move lever 2f to the right, then carefully remove the paper.

Note: If the paper is torn, remove all torn pieces of paper from the folder.

3. Return lever 2f to its original position, then close the folder tray.

4. Close the front door of the tri-fold module.
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Clearing Jams at Area 2g in the Tri-Fold Module
1. Open the front door of the tri-fold module.

2. Open the folder tray, move lever 2g to the right, then carefully remove the paper.

Note: If the paper is torn, remove all torn pieces of paper from the folder.

3. Return lever 2g to the original position, then close the folder tray.

4. Close the front door of the tri-fold module.
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CClleeaarriinngg SSttaappllee JJaammss

Clearing Staple Jams in the Integrated Office Finisher
1. Open the finisher front door.

2. To remove the staple cartridge, grasp the orange handle, then pull it firmly toward you.

3. Check inside the finisher for any loose staples, then remove the staples.

4. To remove the staple cartridge, and open the clamp, pull the clamp in the direction shown.
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5. Remove the jammed staples, then push the clamp in the direction shown until the clamp clicks
into the locked position.

WARNING: The points of the jammed staples are sharp. Remove the jammed staples
carefully.

6. Grasp the staple cartridge handle, then insert the cartridge into the stapler until the cartridge
clicks into position.

7. Close the finisher front door.
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Clearing Staple Jams in the Office Finisher

WARNING: Do not perform this procedure while the printer is printing.

1. Open the finisher front door.

2. Pull the stapler assembly toward you until it stops.

3. Push the stapler assembly to the right, as shown.

4. To remove the staple cartridge, grasp the orange handle, then pull the handle toward you.

5. Check inside the finisher for any loose staples, then remove the staples.
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6. To open the staple cartridge clamp, pull the clamp in the direction shown.

7. Remove the jammed staples, then push the clamp in the direction shown until the clamp clicks
into the locked position.

WARNING: The points of the jammed staples are sharp. Remove the jammed staples
carefully.

8. Grasp the orange handle, then insert the cartridge into the stapler assembly until the cartridge
clicks into place.

9. Close the finisher front door.
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Clearing Booklet Staple Jams in the Office Finisher

WARNING: Do not perform this procedure while the printer is printing.

1. Open the finisher side cover.

2. If the staple cartridges are not visible, grip the vertical panels at the left and right of the opening
and slide the panels to the center.

3. Hold the tabs on both sides of the staple cartridge and pull the cartridge out of the finisher.
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4. To remove the jammed staples, pull the staples in the direction shown.

WARNING: The points of the jammed staples are sharp. Remove the jammed staples
carefully.

5. Hold the tabs on both sides of the staple cartridge and insert the cartridge into the original
position in the finisher.

Note: If you have trouble inserting the cartridge, ensure that the staples are positioned
correctly in the cartridge.

Note: The booklet maker uses two staple cartridges. Booklet stapling requires that both
staple cartridges contain staples.

6. Repeat the procedure for the other staple cartridge.

7. Close the finisher side cover.
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Clearing Main Staple Jams in the Business Ready Finisher
1. Open the front door of the Business Ready Finisher.

2. Grasp the stapler assembly lever R1, then move the lever to the right.

3. To remove the staple cartridge, grasp the orange handle, then pull it firmly toward you.
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4. To open the staple cartridge clamp, pull the clamp in the direction shown.

5. Remove the jammed staples, then push the clamp in the direction shown until the clamp clicks
into the locked position.

WARNING: The points of the jammed staples are sharp. Remove the jammed staples
carefully.

6. Grasp the staple cartridge by the orange handle, then insert the cartridge into the stapler
assembly until the staple cartridge clicks into place.

7. Return the stapler assembly to the original position, then close the finisher door.
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Clearing Staple Jams in the Business Ready Finisher Booklet Maker
1. Open the front door of the Business Ready Finisher.

2. Grasp the green handle, then pull out the booklet maker until it stops.

3. To remove a staple cartridge from the booklet maker, push down on the staple cartridge handle,
as shown, then pull the cartridge out and up.

4. Turn over the staple cartridge.
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5. To remove the staple pack from the staple cartridge, press in the green tabs and pull back the
handle, then lift out the staple pack.

Note: If you do not see the staple jam, remove the staple case.

6. To remove the staple case, press the rear of the case as shown. Remove the jammed staples, then
return the staple case to the original position.

Note: If you cannot see the staple jam, open the staple cartridge clamp.

7. To open the staple cartridge clamp, pull the clamp firmly in the direction shown.

WARNING: The points of the jammed staples are sharp. Remove the jammed staples
carefully.
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8. Remove the jammed staples, then push the clamp in the direction shown until the clamp clicks
into the locked position.

9. To return the staple cartridge to the booklet maker, insert the staple cartridge, then push up on
the cartridge handle as shown.

10. Return the booklet maker to the original position, then close the finisher door.
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CClleeaarriinngg HHoollee PPuunncchh JJaammss

Clearing Hole-Punch Jams in the Office Finisher
If the printer stops printing and reports a hole-punch jam, empty the hole-punch waste container. For
details, refer to Emptying the Hole Punch Waste Container.

After emptying the hole-punch waste container, locate and remove any paper jams.
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Print, Copy, and Scan Problems

IIddeennttiiffyyiinngg PPrriinntt,, CCooppyy,, aanndd SSccaann PPrroobblleemmss
Problems with the output quality of your printer can be a print-related, copy-related, or scan-related
problem. A quick test can help you to identify where a problem exists.

To identify if a problem is print-related or scan-related, do the following:

1. Print the Getting Started guide:

a. At the printer control panel, press the Home button.

b. Touch Device, then touch Information Pages.

c. Touch Getting Started, then touch Print.

d. To return to the Home screen, press the Home button.

2. Check the quality of the printed output.

3. If the print quality appears poor, the problem is print-related. For possible solutions, refer to Print-
Quality Problems and Solutions.

4. If the print quality meets your requirements, the problem is likely to be scanner-related.

a. Copy the Getting Started guide that you have printed.

b. Check the quality of the copy output.

c. For any symptom of poor scan quality, refer to Copy and Scan Problems.

PPrriinntt--QQuuaalliittyy PPrroobblleemmss
Your printer is designed to produce consistently high-quality prints. If you observe print-quality
problems, use the information in this section to troubleshoot the problem. For more information, go
to www.xerox.com/office/ALC81XXsupport.

Caution: The Xerox Warranty or Service Agreement does not cover damage caused by using
unsupported paper or specialty media. For more information, contact your local Xerox
representative.

Note:

• To ensure consistent print quality, the toner, print, and drum cartridges for many devices are
designed to cease functioning at a predetermined point.

• Grayscale images printed with the composite black setting increment the color pages
counter, because color consumables are used. Composite black is the default setting on
most printers.

CCoonnttrroolllliinngg PPrriinntt QQuuaalliittyy
Various factors can affect the quality of the output of your printer. For consistent and optimum print
quality, use paper designed for your printer, and correctly set the Print-Quality Mode and Color
Adjustments. Follow the guidelines in this section to maintain optimum print quality from your
printer.
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Temperature and humidity affect the quality of the printed output. For details, see Environmental
Specifications.

PPaappeerr aanndd MMeeddiiaa
Your printer is designed to use various paper and other media types. Follow the guidelines in this
section for the best print quality and to avoid jams:

• Use only Xerox approved paper. For details, refer to Supported Paper.

• Use only dry, undamaged paper.

Caution: Some paper and other media types can cause poor output quality, increased
paper jams, or damage your printer. Do not use the following:

• Rough or porous paper

• Inkjet paper

• Non-laser glossy or coated paper

• Paper that has been photocopied

• Paper that has been folded or wrinkled

• Paper with cutouts or perforations

• Stapled paper

• Envelopes with windows, metal clasps, side seams, or adhesives with release strips

• Padded envelopes

• Plastic media

• Iron-on transfer paper

• Ensure the paper type selected in your print driver matches the paper type on which you are
printing.

• If you have the same size paper loaded in more than one tray, ensure that the proper tray is
selected in the print driver.

• Do not load more than one type, size, or weight of paper in the tray at a time.

• Store your paper and other media properly for optimum print quality. For details, refer to Paper
Storage Guidelines.

PPrriinntt--QQuuaalliittyy MMooddeess
Select the correct print-quality setting for your print job from the print driver. For instructions on
setting the print quality, see Printing. To control the print quality:

• Use the print-quality settings in the print driver to control print quality. If the print quality is not
suitable, adjust the print-quality setting to an higher level.

• Use only Xerox approved paper. For details, refer to Supported Paper.

CCoolloorr CCoorrrreeccttiioonnss aanndd CCoolloorr AAddjjuussttmmeennttss
For best printing results of mixed text, graphics, and images on a range of supported paper, set the
Color Correction feature to Xerox Automatic Color. For instructions on setting the Color Correction

332 Xerox® AltaLink® C81XX Series Color Multifunction Printer
User Guide

Troubleshooting



feature, refer to Image Options. Follow these guidelines to control color corrections and color
adjustments:

• For best results on most paper, ensure that the color correction option in the print driver is set to
the recommended setting Xerox Automatic Color.

• To produce more vivid results, select a mode of color correction. For example, when printing
graphics in which the sky does not look blue enough, for a more vibrant blue sky, select Vivid
Color.

• To match the color output to another output device, select a custom Color Correction option.

• To apply different color corrections to text, graphics, and images, select Custom Automatic Color.
The Custom Automatic Color feature provides custom color corrections using color systems such
as RGB color, CMYK color, spot color, or CIE color.

• To adjust particular characteristics of the printed color, such as lightness, contrast, saturation, and
color casts, select Color Adjustments.

• To minimize color differences between side 1 and side 2 printed output, perform the Color
Matching procedure. For details, refer to Performing the Color-Matching Procedure.

Performing the Color-Matching Procedure
1. At the printer control panel, press the Home button.

2. Touch Device.

3. Touch Tools.

4. Touch Troubleshooting→Calibration→Color Matching→Next.

5. To run the color-matching procedure, follow the onscreen instructions.

SSoollvviinngg PPrriinntt--QQuuaalliittyy PPrroobblleemmss
Your printer is designed to produce high-quality prints consistently. If you observe print-quality
problems, use the information in this section to troubleshoot the problem. For more information, go
to www.xerox.com/office/ALC81XXsupport.

Caution: The Xerox Warranty or Service Agreement does not cover damage caused by using
unsupported paper or specialty media. For more information, contact your local Xerox
representative.

Note: To enhance the print quality, the toner cartridges, print cartridges, and drum cartridges
for many models are designed to cease functioning at a predetermined point.

Printing the Troubleshooting Print-Quality Pages
1. At the printer control panel, press the Home button.

2. Touch Device.

3. Touch Information Pages.

4. To print procedures on resolving print-quality problems, touch Troubleshooting Print Quality
Page, then touch Print.

5. Compare your print-quality problems to the examples on the pages.
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Eliminating the Paper or Media as the Problem
Damaged or unsupported paper or media can cause print-quality problems even when the printer,
application, and print driver are working perfectly. Use the following guidelines to eliminate the paper
as the source of the print-quality problem:

• Make sure that the printer supports the paper or media.

• Make sure that the printer is loaded with undamaged, dry paper.

• If the condition of the paper or media is in doubt, replace it with new paper or media.

• Make sure that you have the proper tray selected in the print driver and from the control panel.

• Make sure that you have the correct paper type selected in the print driver and in the control
panel of the printer.

Isolating the Problem to the Printer or to the Application
When you are sure that the paper is supported and in good condition, use the following steps to
isolate the problem:

1. From the control panel of the printer, print the pages for Diagnosing Print Quality. For details, see
Printing the Troubleshooting Print-Quality Pages.

• If the pages printed properly, the printer is working properly and the print-quality problem is
an application, print driver, or print server problem.

• If the pages still have print-quality problems, the problem is in the printer.

2. If the pages printed properly, see Troubleshooting Print-Quality Problems in the Application, Print
Driver, or Print Server.

3. If the pages still had print-quality issues, or did not print, see Troubleshooting Print-Quality
Problems in the Printer .

Troubleshooting Print-Quality Problems in the Application, Print Driver, or Print Server
If the printer is printing properly from the control panel but you still have print-quality problems, the
application, print driver, or print server could be the cause.

To isolate the problem:

1. Print a similar document from another application and look for the same print-quality problems.

2. If the document has the same print-quality problem, it is probably a print driver or print server
problem. Check the print driver used for the print job.

a. Navigate to the list of printers on your computer:

• For Windows Server 2008 and later, click Start→Settings→Printers.

• For Windows 7, click Start→Devices and Printers.

• For Windows 8, click Start→Control Panel→Devices and Printers.

• For Windows 10, click theWindows Start→Settings→Devices→Printers & Scanners.
Scroll to Related settings, then click Devices and printers.

Note: If you are using a custom Start Menu application, it can change the navigation
path to your list of printers.

b. Right-click on the name of the printer.
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c. From the drop-down list, select Properties.

• Ensure that the model name in the middle of the driver matches the model name of the
printer.

• If the names do not match, install the proper print driver for the printer.

3. If the print driver is correct, to set the Print Quality Mode and Color Correction, refer to Printing
Features.
• Set the Print-Quality mode to Standard or Enhanced.
• Set the Color Correction to Xerox® Automatic Color.

4. If the problem persists, delete then reinstall the print driver.

5. If the document printed without a print-quality problem, the application is probably the cause.
Restart your printer, restart the application, then print the document again. For more information,
see Power Options.

6. If the problem still persists, ensure that you are not printing through a print server. If the problem
persists, for online support information, go to www.xerox.com/office/ALC81XXsupport.

Troubleshooting Print-Quality Problems in the Printer
If you have print-quality problems when printing a Demo Page or the Configuration Report from the
control panel, the problem is in the printer.

To find the source of the problem:

1. At the control panel, print the Troubleshooting Print-Quality Pages. For details, see Printing the
Troubleshooting Print-Quality Pages.

2. If the prints are too light to see print details, verify the following:
• The printer is loaded with undamaged, dry supported paper.
• The toner levels of one or more of the toner cartridges is not too low.

3. If the pages are printed with a solid color, one or more of the drum cartridges could be defective.
Correct the problem before continuing.

4. If the colors of the pages do not match your expectations, run the control panel Print Calibration.

5. Compare the print-quality problems in your document to each of the examples in the
Troubleshooting Print-Quality Pages.

If you find a match in the Troubleshooting Print-Quality Pages, look in the Solutions column for the
action to take to resolve the problem.

If the problem persists, for online support information, go to www.xerox.com/office/ALC81XXsupport.

Performing the Print Calibration Procedure
1. At the printer control panel, press the Home button.

2. Touch Device.

3. Touch Tools.

4. Touch Troubleshooting→Calibration→Print Calibration→Next.

5. Follow the onscreen instructions to run the Print Calibration procedure.
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Print-Quality Problems and Solutions
Use the following table to find solutions to print-quality problems.

Note: At the printer control panel, press the Home button. Touch Device→Information
Pages→Troubleshooting Print Quality Page→Print.

Problem Solution

Smears, Smudges, and Streaks

Dark or light marks appear on your output.

Run a print job consisting of several blank pages
through the printer to remove toner accumulated on
the fuser.

If the problem persists, print the test pages to help
determine which component is causing the image-
quality problem.

• If the defect occurs in one color only, replace the
corresponding imaging unit.

• If the defect occurs in all colors and is visible on
all the test pages, replace the fuser.

Repeating Spots or Lines

Spot or lines appear at regular intervals on the prints.

1 To identify the part of the printer that is causing
the problem, print the Repeating Defects page. At
the control panel, press the Home button, then
touch
Device→Tools→Troubleshooting→Support
Pages→Repeating Defects Page→Print.

2 To identify the part responsible for the repeating
spots or lines, follow the instructions on the
Repeating Defects page.

3 To correct the problem, replace the printer part
identified on the Repeating Defects page.

Colors Look Wrong

Colors are off or look drastically wrong.

1 Verify that the printer is on a solid, level, and flat
surface.

2 Perform the Print Calibration procedure. At the
control panel, press the Home button, then touch
Device→Tools→Troubleshooting→Calibra-
tion→Print Calibration→Next, then follow the
instructions.

Colors Too Light or Too Dark

The print or color density is too light, missing, or the
background is foggy.

1 Verify that the paper you are using is the correct
type for the printer and is loaded properly. For
details, see Supported Paper.

2 Verify that the paper loaded in the tray matches
the paper type selected at the control panel and
in the print driver.

3 To print procedures on resolving print-quality
problems, at the control panel, press the Home
button. Touch Device→Information
Pages→Troubleshooting Print Quality
Page→Print.
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Problem Solution

If the Color Reference page looks correct, the
printer is printing properly. Your application or
incorrect settings in the print driver can be
causing the print-quality problems.

4 If the Color Reference page did not print correctly,
perform the Print Calibration procedure. At the
control panel, press the Home button, then touch
Device→Tools→Troubleshooting→Calibra-
tion→Print Calibration→Next, then follow the
instructions.

Vertical White Lines or Streaks - One Color

Lines or streaks appear in one color of your output.

1 Print the test pages to identify the affected color.
2 To clean the printhead lenses for the affected

color, pull out the cleaning rod until it stops, then
move it all the way in. Repeat three more times.
Then repeat this procedure for each affected
color. For details, see Cleaning the Printhead
Lenses.

Note: To print procedures on resolving print-
quality problems, at the control panel, press
the Home button, then touch
Device→Information
Pages→Troubleshooting Print Quality
Page→Print.

Toner Missing or Easy to Rub Off

Toner appears to be missing from the print or is easy
to rub off.

1 Verify that the paper you are using is the correct
type for the printer and is loaded properly. For
details, see Supported Paper.

2 Perform the Print Calibration procedure. At the
control panel, press the Home button, then touch
Device→Tools→Troubleshooting→Calibra-
tion→Print Calibration→Next, then follow the
instructions.

3 At the control panel, select a heavier paper.

Note: Papers from lightest to heaviest are:

• For uncoated paper: Plain, Lightweight
Cardstock, Cardstock, and Heavyweight
Cardstock

• For coated paper: Lightweight Glossy
Cardstock, Glossy Cardstock, and
Heavyweight Glossy Cardstock.

CCooppyy aanndd SSccaann PPrroobblleemmss
Your printer is designed to produce consistently high-quality scans and copies. If you observe quality
problems, use the information in this section to troubleshoot the problem. For more information, go
to www.xerox.com/office/ALC81XXsupport.
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Caution: The Xerox Warranty or Service Agreement does not cover damage caused by using
unsupported paper or specialty media. For more information, contact your local Xerox
representative.

CCooppyy aanndd SSccaann PPrroobblleemmss aanndd SSoolluuttiioonnss
If the copy or scan quality is poor, refer to the following table:

Symptoms Solutions

Lines or streaks only present in copies made from the
document feeder.

There is debris on the document glass. During
scanning, the paper from the document feeder
passes over the debris, which creates lines or streaks.
Clean all glass surfaces with a lint-free cloth.

Spots present in copies made from the document
glass.

There is debris on the document glass. When
scanning, the debris creates a spot on the image.
Clean all glass surfaces with a lint-free cloth.

The reverse side of the original document shows on
the copy or scan.

Enable Background Suppression.

The image is too light or too dark. Adjust the Lighten/Darken or Contrast settings.

Colors are inaccurate. Copy: Adjust the Color Balance settings.

Scan: Verify that the correct Original Type is set.

If the problem persists, for online support information, go to www.xerox.com/office/ALC81XXsupport.

PPeerrffoorrmmiinngg tthhee CCooppyy CCaalliibbrraattiioonn PPrroocceedduurree
To optimize copy job quality, perform the Copy Calibration procedure.

1. At the printer control panel, press the Home button.

2. Touch Device.

3. Touch Tools.

4. Touch Troubleshooting→Calibration→Copy Calibration→Next.

5. To run the Copy Calibration procedure, follow the onscreen instructions.
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Fax Problems
If your printer cannot send and receive faxes, ensure that the printer is connected to an approved
analog telephone line. The fax machine cannot send or receive faxes when it is connected directly to
a digital telephone line without the use of an analog filter.

Note: If the fax connection is poor, transmit the fax at a lower rate. For the Starting Rate,
select Forced (4800 bps).

PPrroobblleemmss SSeennddiinngg FFaaxxeess

Symptoms Probable Causes Solutions

The document is not feeding
properly through the document
feeder.

The document is too thick, too
thin, or too small.

Use the document glass.

The document is scanned at an
angle.

The document feeder width guides
are not adjusted to fit the width of
the document.

Adjust the document feeder width
guides so that they fit against the
document.

The fax received by the recipient is
blurry.

The document is positioned
incorrectly.

Position the document correctly.

The document glass is dirty. Clean the document glass.

The text in the document is too
light.

Adjust the resolution. Adjust the
contrast.

There is a problem with the
telephone connection.

Verify that the telephone line is
working, then send the fax again.

There is a problem with one of the
fax machines.

Make a copy to verify that the
printer can make clean copies and
prints. If the copy prints correctly,
have the recipient verify that their
fax machine is operating correctly.

The fax received by the recipient is
blank.

The document was loaded
incorrectly.

If using the document feeder,
place the original document face
up.

If using the document glass, place
the original document face down.

Fax was not transmitted. The fax number is wrong. Verify the fax number.

The telephone line is connected
incorrectly.

Verify the telephone line
connection. If the telephone line is
disconnected, connect it.
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Symptoms Probable Causes Solutions

There is a problem with the fax
machine of the recipient.

Contact the recipient.

The fax feature is not installed or
is not enabled.

Ensure that the fax feature is
installed and enabled.

Server fax is enabled. Ensure that server fax is disabled.

An access number is required to
connect to an outside line.

If the printer is connected to a
PBX system, it could be necessary
to enter a number to access the
outside telephone line.

The fax number needs a pause
between the prefix for an outside
line and the telephone number.

To insert a pause, touch the Dial
Pause button. A comma ( ,)
appears in the corresponding
location.

If the problem persists, for online support information, go to www.xerox.com/office/ALC81XXsupport.

PPrroobblleemmss RReecceeiivviinngg FFaaxxeess

Symptoms Probable Causes Solutions

The fax received by the recipient is
blank.

There is a problem with the
telephone connection or with the
fax machine of the sender.

Verify that the printer can make
clean copies. If it can, have the
sender fax the document again.

The sender loaded the pages
incorrectly.

Contact the sender.

The printer answers the call but
does not print the fax.

The memory is full. To increase available memory,
delete stored jobs and wait for the
existing jobs to complete.

The received fax size is reduced in
size.

The paper supply in the printer
does not match the document size
sent.

Confirm the original size of the
documents, then load the
appropriate paper size in the
printer.

Faxes are not received
automatically.

The printer is set to receive faxes
manually.

Set the printer to receive faxes
automatically.

The memory is full. If the printer is out of paper, faxes
and print jobs can deplete the
printer of memory. Load paper
and print the jobs stored in the
memory.
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Symptoms Probable Causes Solutions

The telephone line is connected
incorrectly.

Verify the telephone line
connection. If the telephone line is
disconnected, connect it.

There is a problem with the fax
machine of the sender.

Make a copy to verify that the
printer can make clean copies and
prints. If the copy prints correctly,
have the recipient verify that their
fax machine is operating correctly.

If the problem persists, for online support information, go to www.xerox.com/office/ALC81XXsupport.

PPrriinnttiinngg FFaaxx RReeppoorrttss
You can print the following fax reports from the printer control panel:

• Activity Report

• Protocol Report

• Fax Address Book Report

• Options Report

• Pending Jobs Report

For instructions on how to print fax reports, refer to the System Administrator Guide at www.xerox.
com/office/ALC81XXdocs.
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Getting Help
Xerox provides several automatic diagnostic utilities to help you maintain productivity and print
quality.

VViieewwiinngg EErrrroorr aanndd AAlleerrtt MMeessssaaggeess oonn tthhee CCoonnttrrooll
PPaanneell
When an error or warning condition occurs, the printer alerts you of the problem. A message appears
on the control panel and the LED status light on the control panel flashes amber or red. Alerts inform
you about printer conditions, such as low supplies or open doors that require your attention. Error
messages warn you about printer conditions that prevent the printer from printing or degrade
printing performance. If more than one condition occurs, only one appears on the control panel.

To view a complete list of active error and alert messages:

1. At the printer control panel, press the Home button.

2. Touch Device.

3. Touch Notifications.

4. Touch Faults & Alerts, Alerts, or Faults.

5. To view details, touch a fault or alert.

6. To exit the Notifications screen, touch X.

7. To return to the Home screen, press the Home button.

VViieewwiinngg tthhee EErrrroorr HHiissttoorryy oonn tthhee CCoonnttrrooll PPaanneell
When errors occur on the device, they are logged into an error history file by date, time, and
associated fault code. You can use this list to identify trends and resolve problems.

To view the error history:

1. At the printer control panel, press the Home button.

2. Touch Device.

3. Touch Notifications.

4. Touch Fault History.

5. To exit, touch X.

6. To exit the Notifications screen, touch X.

7. To return to the Home screen, press the Home button.

TThhee EEmmbbeeddddeedd WWeebb SSeerrvveerr
The Embedded Web Server is the administration and configuration software that is installed in the
printer. It allows System Administrators to modify network and system settings on the printer
remotely using a Web browser.

You can check the status of the printer, monitor paper and supply levels, and submit and track print
jobs. All these functions can be accessed from the convenience of your computer.
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The Embedded Web Server requires:

• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux
environments.

• TCP/IP and HTTP enabled in the printer.

• A network-connected computer with a Web browser that supports JavaScript.

OOnnlliinnee SSuuppppoorrtt AAssssiissttaanntt
The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help
to solve your printer problems. You can find solutions for print-quality problems, paper jams, software
installation issues, and more.

To access the Online Support Assistant, go to www.xerox.com/office/ALC81XXsupport.

IInnffoorrmmaattiioonn PPaaggeess
Your printer has a set of information pages that you can print. These pages include configuration and
font information, demonstration pages, and more.

To print an information page, select an option, then touch Print.

The following Information Pages are available:

Name Description

Configuration Report The Configuration Report provides printer
information including the serial number, installed
options, network settings, port setup, tray
information, and more.

Billing Summary The Billing Summary Report provides information
about the device and a detailed listing of the billing
meters and sheet counts.

Getting Started The Getting Started guide provides an overview of
the key features of the printer.

Troubleshooting Print Quality Page The Troubleshooting Print Quality Page provides a list
of common print-quality problems and tips to help
solve them.

Supplies Usage Page The Supplies Usage Page provides coverage
information and part numbers for reordering
supplies.

Graphics Demo Page Print this page to check the quality of graphics.

Xerox® AltaLink® C81XX Series Color Multifunction Printer
User Guide

343

Troubleshooting

https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC81XX&PgName=Tech


Name Description

PCL Font List The PCL Font List provides a printout of all PCL fonts
that are available on the printer.

PostScript Font List The PostScript Font List provides a printout of all
PostScript fonts that are available on the printer.

MMoorree IInnffoorrmmaattiioonn
You can obtain more information about your printer from these sources:

Resource Location

Installation Guide Packaged with the printer.

Getting Started guide Print from the control panel. For details, refer to
Information Pages.

Other documentation for your printer www.xerox.com/office/ALC81XXdocs

Recommended Media List United States: www.xerox.com/rmlna

European Union: www.xerox.com/rmleu

Technical support information for your printer,
including online technical support, Online Support
Assistant, and print driver downloads.

www.xerox.com/office/ALC81XXsupport

Information Pages Print from the control panel. For details, refer to
Information Pages.

Embedded Web Server information In the Embedded Web Server, click Help.

Order supplies for your printer www.xerox.com/office/supplies

A resource for tools and information, including
interactive tutorials, printing templates, helpful tips,
and customized features to meet your individual
needs.

www.xerox.com/office/businessresourcecenter

Local sales and Technical Customer Support www.xerox.com/office/worldcontacts

Printer registration www.xerox.com/register

Xerox® Direct online store www.direct.xerox.com/
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LLooccaattiinngg tthhee SSeerriiaall NNuummbbeerr
When you order supplies or contact Xerox for assistance, you need the serial number of your device.
You can obtain the serial number in several ways. To locate the serial number, print the Configuration
Report. You can view the serial number on the control panel or on the Embedded Web Server home
page. The serial number is printed on a label that is affixed to the printer. To view the label, open the
left side door.

For details on how to print the Configuration Report, refer to Information Pages.

To view the serial number on the control panel:

1. At the printer control panel, press the Home button.

2. Touch Device.

3. Touch About.

The model, serial number, and software version is displayed.

4. To return to the Home screen, press the Home button.
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Printer Configurations and Options

SSttaannddaarrdd FFeeaattuurreess
The printer provides the following features:

• Copy, Print, Email, Scan, Internet Fax, and Server Fax

• Scan to USB and Print from USB mass storage devices

• Workflow Scanning with Scan to Mailbox, Scan to Network, and Scan to Home

• 1–Touch Apps for Copy, Email, Scan To, Fax, Single Touch and Scan

• Searchable PDF, Single or Multiple-Page PDF or XPS, or TIFF, Encrypted or Password-Protected
PDF, and Linearized PDF, PDF, or A file formats

• Copy speed of up to 70 ppm for color or black and white on A4 (210 x 297 mm) or Letter (8.5 x 11
in.) paper

• 1200 x 1200 dpi imaging and copying quality

• Copy document sizes up to A3 (297 x 420 mm) or Letter (11 x 17 in.)

• Print document size, with short-edge feed, up to SRA3 or Letter (12 x 19 in.)

• Automatic 2-sided printing

• Duplex Automatic Document Feeder

• Color touch screen control panel

• Smart proximity sensor

• Trays 1–2 each with 520-sheet capacities

• Tray 5 (Bypass Tray) with 100-sheet capacity

• Two-Tray module (Trays 3–4) each with 520-sheet capacities

• High Capacity Tandem Tray (Trays 3–4) with total 2000 A4 or Letter sheet capacity

• 8-GByte DDR3 System Memory for C8170, and 4-GByte DDR3 System Memory for Xerox®
AltaLink® C8155, AltaLink® C8145, AltaLink® C8135, and AltaLink® C8130

• Internal 128-GByte solid state drive (SSD)

• Ethernet 10/100/1000Base-TX

• High-Speed USB 2.0 direct print

• Adobe PostScript and PCL fonts and support

• Xerox® Mobile Express Driver, Xerox® Global Print Driver, and Xerox® Pull Print Driver support

• Automated supplies replenishment and management using Xerox® MeterAssistant®, Xerox®
SuppliesAssistant®, and MaintenanceAssistant

• Remote driver installation

• Remote control panel and configuration cloning

• Bonjour device discovery

• Xerox® Standard Accounting
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• Encrypted Secure Print, Secure Fax, Secure Scan, and Secure Email

• McAfee data security

• Xerox® Extensible Interface Platform

• Xerox® Earth Smart Driver settings

• Embedded Web Server

• Xerox® CentreWare ® Web

• Email alerts

• Support for mobile printing, mobile printing connectivity, and mobile apps

• Xerox® App Gallery supported

• Xerox® Copier Assistant

• NFC printing

• Support for Mopria

• Support for AirPrint

• Support for Google Cloud Print™

OOppttiioonnss aanndd UUppggrraaddeess
• Integrated Office Finisher

• Office Finisher

• Booklet Maker and Creaser for Office Finisher

• Hole Punch for Office Finisher

• Business Ready Finisher with a 2–3, 2–4, or Swedish Hole Punch

• Business Ready Booklet Maker Finisher with a 2–3, 2–4, or Swedish Hole Punch

• Tri-Fold Module for Business Ready Finisher or Business Ready Booklet Maker Finisher

• Envelope Tray

• Long Sheet Feed Kit

• High Capacity Feeder (Tray 6) with up to a 3000-sheet capacity

• Convenience Stapler and Work Surface

• One-Line and Dual-Line Fax Kits

• Fax forward to Email or SMB software

• EFI™ Fiery® Network Server

• Xerox Secure Access Unified ID System

• CAC and PIV Card Reader Enablement Kit

• Xerox® Network Accounting Enablement

• Xerox® Dual Band Wireless Kit

• Wi-Fi Direct with optional Wireless Network Adapter

• Foreign Device Interface (FDI)
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• Hard Disk Drive with Image Overwrite Kit, AES 256-bit Encryption that is FIPS 140-2 compliant,
SHA-256 Hash Message Authentication

• McAfee Integrity Control Enablement Kit and McAfee enhanced security features

• RFID Card Reader Kit

• SIPRNet Enablement Kit

• Bluetooth Kit

• Support for AirPrint® with iBeacon

• Software for Unicode print

• Xerox® Scan to PC Desktop® Professional software

Note: For AirPrint® with iBeacon, the optional Bluetooth Kit is required.

FFiinniisshhiinngg OOppttiioonnss

Output Device Capacity Sizes Weights
Finishing
Options

Left Tray 100 sheets All supported sizes

For information on
supported sizes,
refer to Supported
Paper.

All supported
weights

For information on
supported weights,
refer to Supported
Paper.

Not Applicable

Center Trays 250 sheets All supported sizes

For information on
supported sizes,
refer to Supported
Paper.

All supported
weights

For information on
supported weights,
refer to Supported
Paper.

Not Applicable

Integrated Office
Finisher

Stacking:

500 sheets A4,
Letter

250 sheets A3,
Tabloid

89 x 98–297 x 432
mm

3.5 x 3.85–11 x 17
in.

52–256 g/m² Single and dual
stapling:

50 sheets A4, Letter

30 sheets of 80 g/
m² Legal, B4, A3,
Tabloid

Office Finisher Stacking:

2000 sheets
unstapled,

100 sets or 1000
sheets single-
stapled

148 x 148–297 x
432 mm

5.8 x 5.8–11 x 17
in.

52–256 g/m² Multiple-position
single and dual
stapling: 50 sheets

Hole Punch:
Optional 2–3 , 2–4,
or Swedish 4–hole
hole Punch
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Output Device Capacity Sizes Weights
Finishing
Options

75 sets or 750
sheets dual-stapled

Office Finisher with
Booklet Maker

Stacking:

2000 sheets
unstapled,

100 sets or 1000
sheets single-
stapled

75 sets or 750
sheets dual-stapled

148 x 148–297 x
432 mm

5.8 x 5.8–11 x 17
in.

52–256 g/m² Multiple-position
single and dual
stapling: 50 sheets

Hole Punch:
Optional 2–3, 2–4,
or Swedish 4–hole
hole punch

Stacking Tray: 50
sets or 600 sheets

A4 SEF (Short-Edge
Feed), Letter SEF,
B4 SEF, Legal SEF,
A3 SEF, Tabloid SEF

Saddle stapling: 2–
15 sheets of 64–
105 g/m²

Score or Crease: 1–
15 sheets
unstapled

Business Ready
Finisher

Top Tray: 500
sheets

Top Right Tray: 98
x 148–320 x 483
mm

3.85 x 5.8–12.6 x
19 in.

Stacking: 203 x
320–320 x 483
mm

8 x 12.6–12.6 x 19
in.

Stapling: 182 x
203–297 x 432
mm

7.2 x 8–11.7 x 17
in.

52–300 g/m² Single-position and
multiple-position
stapling: 50 sheets

Hole punch:
Optional 2–3, 2–4,
or Swedish 4-Hole
Punch

Stacking:

3000 sheets
unstapled,

200 sets single-
position stapled or

100 sets multiple-
position stapled
sheets, dual-stapled

Business Ready
Finisher with
Booklet Maker

Top Tray: 500
sheets

Top Right Tray: 98
x 148–320 x 483
mm

3.85 x 5.8–12.6 x
19 in.

Stacking: 203 x
320–320 x 483
mm

8 x 12.6–12.6 x 19
in.

52–300 g/m² Single-position and
multiple-position
stapling: 50 sheets

Hole Punch:
Optional 2–3, 2–4,
or Swedish 4-hole
punch
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Output Device Capacity Sizes Weights
Finishing
Options

Stapling: 182 x
203–297 x 432
mm

7.2 x 8–11.7 x 17
in.

Stacking:

1500 sheets
unstapled

200 sets single-
position, dual, or 4-
position stapled

100 stapled sets A3
or Tabloid

Tri-Fold Module 40 sheets C-Fold, Z-Fold: A4,
Letter SEF

Z-Half Fold: A3,
Tabloid

64–105 g/m² C-Fold, Z-Fold, and
Z-Half Fold

Convenience
Stapler

NA Any supported size

For information on
supported sizes,
refer to Supported
Paper.

Any supported
weight

For information on
supported weights,
refer to Supported
Paper.

50 sheets

Note: Sheet quantities for tray capacities and finishing options are based on 80 g/m².
Quantities are reduced for heavier media and must be within the specified weight range.
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Physical Specifications

BBaassee CCoonnffiigguurraattiioonn

• Width: 66.8 cm (26.3 in.)

• Depth:

– C8130 / C8135 / C8145 / C8155: 72.3 cm (28.5 in.)

– *C8170: 79.3 cm (31.2 in.)

• Height:

– C8130 / C8135 / C8145 / C8155: 114.7 cm (45.1 in.)

– *C8170: 117.3 cm (46.2 in.)

• Weight: <160 Kg (353 lb.)
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CCoonnffiigguurraattiioonn wwiitthh IInntteeggrraatteedd OOffffiiccee FFiinniisshheerr

• Width: 66.8 cm (26.3 in.)

• Depth:

– C8130 / C8135 / C8145 / C8155: 72.3 cm (28.5 in.)

– *C8170: 79.3 cm (31.2 in.)

• Height:

– C8130 / C8135 / C8145 / C8155: 114.7 cm (45.1 in.)

– *C8170: 117.3 cm (46.2 in.)

• Weight: <171.1 Kg (377.2 lb.)

CCoonnffiigguurraattiioonn wwiitthh HHiigghh CCaappaacciittyy FFeeeeddeerr

• Width: 109.6 cm (43.15 in.)

• Depth:
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– C8130 / C8135 / C8145 / C8155: 72.3 cm (28.5 in.)

– *C8170: 79.3 cm (31.2 in.)

• Height:

– C8130 / C8135 / C8145 / C8155: 114.7 cm (45.1 in.)

– *C8170: 117.3 cm (46.2 in.)

• Weight: 191 Kg (421.1 lb.)

CCoonnffiigguurraattiioonn wwiitthh OOffffiiccee FFiinniisshheerr

• Width: 125.5 cm (49.4 in.)

• Depth:

– C8130 / C8135 / C8145 / C8155: 72.3 cm (28.5 in.)

– *C8170: 79.3 cm (31.2 in.)

• Height:

– C8130 / C8135 / C8145 / C8155: 114.7 cm (45.1 in.)

– *C8170: 117.3 cm (46.2 in.)

• Weight: <187 Kg (412.3 lb.)

CCoonnffiigguurraattiioonn wwiitthh OOffffiiccee FFiinniisshheerr wwiitthh BBooookklleett
MMaakkeerr
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• Width: 125.5 cm (49.4 in.)

• Depth:

– C8130 / C8135 / C8145 / C8155: 72.3 cm (28.5 in.)

– *C8170: 79.3 cm (31.2 in.)

• Height:

– C8130 / C8135 / C8145 / C8155: 114.7 cm (45.1 in.)

– *C8170: 117.3 cm (46.2 in.)

• Weight: <197 Kg (434.3 lb.)

CCoonnffiigguurraattiioonn wwiitthh HHiigghh CCaappaacciittyy FFeeeeddeerr aanndd OOffffiiccee
FFiinniisshheerr wwiitthh BBooookklleett MMaakkeerr

• Width: 168.3 cm (66.3 in)

• Depth:

– C8130 / C8135 / C8145 / C8155: 72.3 cm (28.5 in.)

– *C8170: 79.3 cm (31.2 in.)

• Height:

– C8130 / C8135 / C8145 / C8155: 114.7 cm (45.1 in.)

– *C8170: 117.3 cm (46.2 in.)

• Weight: 228 Kg (502.7 lb.)
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CCoonnffiigguurraattiioonn wwiitthh BBuussiinneessss RReeaaddyy FFiinniisshheerr,, BBooookklleett
MMaakkeerr,, aanndd TTrrii--FFoolldd MMoodduullee

• Width: 167.5 cm (65.9 in.)

• Depth:

– C8130 / C8135 / C8145 / C8155: 72.3 cm (28.5 in.)

– *C8170: 79.3 cm (31.2 in.)

• Height:

– C8130 / C8135 / C8145 / C8155: 114.7 cm (45.1 in.)

– *C8170: 117.3 cm (46.2 in.)

• Weight: <255.1 Kg (562.4 lb.)

CCoonnffiigguurraattiioonn wwiitthh HHiigghh CCaappaacciittyy FFeeeeddeerr aanndd
BBuussiinneessss RReeaaddyy FFiinniisshheerr,, BBooookklleett MMaakkeerr,, aanndd TTrrii--FFoolldd
MMoodduullee

• Width: 148.2 cm (58.3 in.)

• Depth:
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– C8130 / C8135 / C8145 / C8155: 72.3 cm (28.5 in.)

– *C8170: 79.3 cm (31.2 in.)

• Height:

– C8130 / C8135 / C8145 / C8155: 114.7 cm (45.1 in.)

– *C8170: 117.3 cm (46.2 in.)

• Weight: 286.1 Kg (630.7 lb.)
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Clearance Requirements

BBaassee CCoonnffiigguurraattiioonn

Installation Space

• Width: 133.9 cm (52.7 in.)

• Depth:

– C8130 / C8135 / C8145 / C8155: 168.9 cm (66.5 in.)

– *C8170: 175.9 cm (69.3 in.)

• Height:

– C8130 / C8135 / C8145 / C8155: 154.5 cm (60.8 in.)

– *C8170: 155.6 cm (61.2 in.)

Clearance

• Front: 40 cm (15.7 in.)

• Rear: 10 cm (3.9 in.)

• Left: 57.9 cm (22.8 in.)

• Right: 10 cm (3.9 in.)
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CCoonnffiigguurraattiioonn wwiitthh IInntteeggrraatteedd OOffffiiccee FFiinniisshheerr

Installation Space

• Width: 145.7 cm (57.4 in.)

• Depth:

– C8130 / C8135 / C8145 / C8155: 168.9 cm (66.5 in.)

– *C8170: 175.9 cm (69.3 in.)

• Height:

– C8130 / C8135 / C8145 / C8155: 154.5 cm (60.8 in.)

– *C8170: 155.6 cm (61.2 in.)

Clearance

• Front: 40 cm (15.7 in.)

• Rear: 10 cm (3.9 in.)

• Left: 57.9 cm (22.8 in.)

• Right: 21.8 cm (8.6 in.)
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CCoonnffiigguurraattiioonn wwiitthh HHiigghh CCaappaacciittyy FFeeeeddeerr

Installation Space

• Width: 246.6 cm (97 in.)

• Depth:

– C8130 / C8135 / C8145 / C8155: 168.9 cm (66.5 in.)

– *C8170: 175.9 cm (69.3 in.)

• Height:

– C8130 / C8135 / C8145 / C8155: 154.5 cm (60.8 in.)

– *C8170: 155.6 cm (61.2 in.)

Clearance

• Front: 40 cm (15.7 in.)

• Rear: 10 cm (3.9 in.)

• Left: 25 cm (9.8 in.)

• Right: 10 cm (3.9 in.)
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CCoonnffiigguurraattiioonn wwiitthh OOffffiiccee FFiinniisshheerr wwiitthh BBooookklleett
MMaakkeerr

Installation Space

• Width: 195.7 cm (77 in.)

• Depth:

– C8130 / C8135 / C8145 / C8155: 168.9 cm (66.5 in.)

– *C8170: 175.9 cm (69.3 in.)

• Height:

– C8130 / C8135 / C8145 / C8155: 154.5 cm (60.8 in.)

– *C8170: 155.6 cm (61.2 in.)

Clearance

• Front: 40 cm (15.7 in.)

• Rear: 10 cm (3.9 in.)

• Left: 57.9 cm (22.8 in.)

• Right: 5 cm (2 in.)
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CCoonnffiigguurraattiioonn wwiitthh HHiigghh CCaappaacciittyy FFeeeeddeerr aanndd OOffffiiccee
FFiinniisshheerr wwiitthh BBooookklleett MMaakkeerr

Installation Space

• Width: 198.3 cm (78 in.)

• Depth:

– C8130 / C8135 / C8145 / C8155: 168.9 cm (66.5 in.)

– *C8170: 175.9 cm (69.3 in.)

• Height:

– C8130 / C8135 / C8145 / C8155: 154.5 cm (60.8 in.)

– *C8170: 155.6 cm (61.2 in.)

Clearance

• Front: 40 cm (15.7 in.)

• Rear: 10 cm (3.9 in.)

• Left: 25 cm (9.8 in.)

• Right: 5 cm (2 in.)
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CCoonnffiigguurraattiioonn wwiitthh BBuussiinneessss RReeaaddyy FFiinniisshheerr,, BBooookklleett
MMaakkeerr,, aanndd TTrrii--FFoolldd MMoodduullee

Installation Space

• Width: 244 cm (96 in.)

• Depth:

– C8130 / C8135 / C8145 / C8155: 168.9 cm (66.5 in.)

– *C8170: 175.9 cm (69.3 in.)

• Height:

– C8130 / C8135 / C8145 / C8155: 154.5 cm (60.8 in.)

– *C8170: 155.6 cm (61.2 in.)

Clearance

• Front: 40 cm (15.7 in.)

• Rear: 10 cm (3.9 in.)

• Left: 57.9 cm (22.8 in.)

• Right: 8 cm (3.1 in.)
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CCoonnffiigguurraattiioonn wwiitthh HHiigghh CCaappaacciittyy FFeeeeddeerr aanndd
BBuussiinneessss RReeaaddyy FFiinniisshheerr,, BBooookklleett MMaakkeerr,, aanndd TTrrii--FFoolldd
MMoodduullee

Installation Space

• Width: 246.6 cm (52.7 in.)

• Depth:

– C8130 / C8135 / C8145 / C8155: 168.9 cm (66.5 in.)

– *C8170: 175.9 cm (69.3 in.)

• Height:

– C8130 / C8135 / C8145 / C8155: 154.5 cm (60.8 in.)

– *C8170: 155.6 cm (61.2 in.)

Clearance

• Front: 40 cm (15.7 in.)

• Rear: 10 cm (3.9 in.)

• Left: 25 cm (9.8 in.)

• Right: 8 cm (3.1 in.)
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Environmental Specifications

TTeemmppeerraattuurree
Operating: 10–28°C (50–83°F)

RReellaattiivvee HHuummiiddiittyy
Operating: 15% to 85% (non-condensing)

EElleevvaattiioonn
For optimum performance, use the printer at elevations below 2500 m (8200 ft.).
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Electrical Specifications
Speed Power Supply Voltage Frequency Current Required

30–55 prints per minute 110–127 VAC +/-10% 50 Hz +/- 3 Hz

60 Hz +/- 3 Hz

12 A

220–240 VAC +/-10% 50 Hz +/- 3 Hz

60 Hz +/- 3 Hz

8 A

70 prints per minute 110–127 VAC +/-10% 50 Hz +/- 3 Hz

60 Hz +/- 3 Hz

16 A

220–240 VAC +/-10% 50 Hz +/- 3 Hz

60 Hz +/- 3 Hz

10 A
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Performance Specifications

PPrriinnttiinngg RReessoolluuttiioonn
Maximum Resolution: 1200 x 2400 dpi

PPrriinntt SSppeeeedd
Xerox reports speeds for continuous printing using long-edge feed on A4 (210 x 297 mm, 8.27 x 11.69
in.) or Letter (216 x 279 mm, 8.5 x 11 in.) Bond 60–105 g/m² (18–28 lb.) paper from any tray except
for tray 5.

Several factors affect print speed:

• Paper orientation: For faster print speeds, you can load paper long-edge feed.

• Paper size: Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes share the fastest print speed.

• Paper weight: Lightweight prints faster than heavier paper, such as Cardstock and Labels.

• Paper type: Plain prints faster than Glossy.

You can achieve maximum print speed when you print on Plain, Letter/A4 paper, using long-edge
feed. The slowest print speed is approximately 10 ppm when you print on envelopes or media 150
mm wide or less.
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Environmental, Health, and Safety Contact
Information
For more information on Environment, Health, and Safety in relation to this Xerox product and
supplies, contact:

• United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)

• Europe: EHS-Europe@xerox.com

For product safety information in the United States and Canada, go to www.xerox.com/environment.

For product safety information in Europe, go to www.xerox.com/msds.
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B
Regulatory Information
This appendix contains:

• Basic Regulations ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 372
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Basic Regulations
Xerox has tested this printer to electromagnetic emission and immunity standards. These standards
are designed to mitigate interference caused or received by this printer in a typical office
environment.

UUnniitteedd SSttaatteess FFCCCC RReegguullaattiioonnss
This equipment is tested and found to comply with the limits for a Class A digital device, pursuant to
Part 15 and Part 18 of the FCC Rules. These limits are designed to provide a reasonable protection
against harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate a radio frequency energy. If the equipment is not
installed and used in accordance with these instructions, it can cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause harmful
interference. Users are required to correct the interference at their own expense.

If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference with one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit that is different from where the receiver is
connected.

• Consult the dealer or an experienced radio or TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user
to operate this equipment.

WARNING: To ensure compliance with Part 15 and Part 18 of the FCC rules, use shielded
interface cables.

XXeerrooxx®® AAllttaaLLiinnkk®® BB88110000 aanndd CC88110000 SSeerriieess PPrriinntteerrss
Xerox® AltaLink® B8100 and C8100 series printers comply with Part 15 of the FCC rules. Operation is
subject to the following two conditions:

• The devices are not used to cause harmful interference.

• The devices must accept any interference received, including any interference that can cause an
undesired operation.

Responsible party: Xerox Corporation

Address: 800 Phillips Road, Webster, NY 14580

Internet contact information: www.xerox.com

CCaannaaddaa
This Class A digital apparatus complies with Canadian ICES-003 and ICES-001.

Cet appareil numérique de la classe A est conforme à la norme NMB-003 et NMB-001 du Canada.

372 Xerox® AltaLink® C81XX Series Color Multifunction Printer
User Guide

Regulatory Information

https://www.xerox.com


EEccooLLooggoo CCeerrttiiffiieedd ttoo OOffffiiccee MMaacchhiinneess CCCCDD--003355

This product is certified to the EcoLogo standard for office printers, meeting all the
requirements for reduced environmental impact. As part of achieving certification,
Xerox Corporation has proven that this product meets the EcoLogo criteria for energy
efficiency. Certified copier, printer, multifunctional device, and fax products must
meet criteria such as reduced chemical emissions, and demonstrate compatibility with
recycled supplies. EcoLogo was established in 1988 to help consumers find products
and services with reduced environmental impacts. EcoLogo is a voluntary, multiple-
attribute, and lifecycle-based environmental certification. This certification indicates
that a product has undergone rigorous scientific testing, exhaustive auditing, or both,
to prove its compliance with stringent, third-party, environmental-performance
standards.

CCeerrttiiffiiccaattiioonnss iinn EEuurrooppee

The CE mark applied to this product symbolizes a declaration of conformity by Xerox
with the following applicable Directives of the European Union as of the date
indicated:
• April 16, 2014: Radio Equipment Directive 2014/53/EU

Xerox declares that the radio equipment models Xerox® AltaLink® B8100 and C8100 are in
compliance with Directive 2014/53/EU. The full text of the EU declaration of conformity can be found
at the following Internet address for the Xerox® AltaLink® B8100 Multifunction Printer and the
Xerox® AltaLink® C8100 Color Multifunction Printer: www.xerox.com/msds

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or
for the environment.

WARNING:

• Changes or modifications to this equipment not specifically approved by the Xerox
Corporation can void the user authority to operate this equipment.

• External radiation from Industrial, Scientific, and Medical (ISM) equipment can interfere
with the operation of this Xerox device. If external radiation from ISM equipment interferes
with this device, contact your Xerox representative for assistance.

• This is a class A product. In a domestic environment, this product can cause radio frequency
interference, in which case the user can be required to take adequate measures.

• To ensure compliance with European Union regulations, use shielded interface cables.

EEuurrooppeeaann UUnniioonn LLoott 44 IImmaaggiinngg EEqquuiippmmeenntt AAggrreeeemmeenntt
EEnnvviirroonnmmeennttaall IInnffoorrmmaattiioonn
Environmental Information Providing Environmental Solutions and Reducing Cost
The following information has been developed to assist users and has been issued in relation to the
European Union (EU) Energy-Related Products Directive, specifically the Lot 4 study on Imaging
Equipment. The Lot 4 study on Imaging Equipment requires manufacturers to improve environmental
performance of in-scope products and supports the EU action plan on energy efficiency.
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In-scope products are Household and Office equipment that meet the following criteria:

• Standard monochrome format products with a maximum speed less than 66 A4 images per
minute

• Standard color-format products with a maximum speed less than 51 A4 images per minute

Environmental Benefits of Duplex Printing
Most Xerox products have duplex printing capability, also known as 2-sided printing. Two-sided
printing enables you to print on both sides of the paper automatically, and therefore helps to reduce
the use of valuable assets by reducing your paper consumption. The Lot 4 Imaging Equipment
agreement requires that on models greater than or equal to 40-ppm color or greater than or equal to
45-ppm monochrome, the duplex function has been auto-enabled during the setup and driver
installation. Some Xerox models below these speed bands can be enabled with 2-sided printing
settings defaulted on at the time of installation. Continuous use of the duplex function reduces the
environmental impact of your work. However, if you require 1-sided printing, you can change the print
settings in the print driver.

Paper Types
This product can be used to print on both recycled paper and virgin paper, approved to an
environmental stewardship scheme, which complies with EN12281 or a similar quality standard.
Lighter weight paper of 60 g/m², which contains less raw material and thus saves assets per print, can
be used in certain applications. You are encouraged to verify if lighter weight paper is suitable for
your printing needs.

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development
and purchase of energy-efficient models, which help to reduce the
environmental impact. Details on the ENERGY STAR program and models
qualified to ENERGY STAR can be found at the following website: www.
energystar.gov.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between the United
States, European Union, Japanese governments, and the office equipment industry. This
image-equipment program promotes energy-efficient copiers, printers, fax, multifunction
printers, personal computers, and monitors. Reducing product energy consumption helps
to combat smog, acid rain, and long-term changes to the climate by decreasing the
emissions that result from generating electricity.

For more information on energy or other related topics, go to www.xerox.com/environment or www.
xerox.com/environment_europe.

Power Consumption and Activation Time
The amount of electricity that a device consumes depends on the way the device is used. This device
is designed and configured to enable you to reduce your electricity usage.

To reduce energy consumption, your device is configured to use Energy Saver modes. After the last
print, the device transitions to Ready mode. In Ready mode, the device can print again immediately.
If the device is not used for a specified period, the device transitions to Sleep mode. To reduce power
consumption, only essential functions remain active in Sleep mode. The device takes longer to
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produce the first print after it exits Sleep Mode, than it takes to print in Ready mode. This delay is the
result of the printer that wakes up and is typical of most imaging devices on the market.

To save power, you can configure Energy Saver modes. The following options are available:

• Job Activated: The device wakes when it detects activity. To set the delay before the device enters
Sleep Mode, enter the number of minutes.

• Sleep and wake up at scheduled times: The device wakes and sleeps according to a schedule
that you specify.

• Auto Power Off: To allow the device to power off after a period of time in Sleep Mode, select Auto
Power Off. To set the delay before the printer powers off from the Sleep Mode setting, enter the
number of hours.

To change the Energy Saver mode settings, refer to the System Administrator Guide at www.xerox.
com/office/ALC81XXdocs. For further assistance, contact your System Administrator.

To learn more about Xerox participation in sustainability initiatives, go to: www.xerox.com/
environment or www.xerox.com/environment_europe.

Note:

• Energy Saver cannot be deactivated.

• Changing the default Energy Saver activation times can result in an overall higher energy
consumption of the device. Before you set a long activation time for Energy Saver modes,
consider the increase in device power consumption.

Default Energy Saver Settings
This device is ENERGY STAR®-qualified under the ENERGY STAR Program Requirements for Imaging
Equipment. The transition time from Ready mode to Sleep mode can be set from 0–60 or 0–120
minutes, depending on printer model. The default value is set to 0 minutes. The maximum transition
time from Ready mode to Sleep mode can take up to 120 minutes, depending on printer model.

To change the Energy Saver settings, contact your System Administrator, or refer to the System
Administrator Guide at: www.xerox.com/office/ALC81XXdocs

EEuurraassiiaann EEccoonnoommiicc CCoommmmuunniittyy CCeerrttiiffiiccaattiioonn

Russia, Belarus, and Kazakhstan are working to establish a common customs union,
the Eurasian Economic Community, or EurAsEC. The Eurasian Economic Community
members anticipate sharing a common regulatory scheme and common EurAsEC
certification mark, the EAC Mark.

RReegguullaattoorryy IInnffoorrmmaattiioonn ffoorr 22..44--GGHHzz aanndd 55--GGHHzz WWiirreelleessss NNeettwwoorrkk
AAddaapptteerrss
This product contains a 2.4-GHz and 5-GHz Wireless LAN radio transmitter module that complies with
the requirements specified in FCC Part 15, Industry Canada RSS-210, and European Council Directive
2014/53/EU. Radio Frequency (RF) output power of this device does not exceed 20 dBm in either
frequency band.

Operation of this device is subject to the following two conditions:
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1. This device may not cause harmful interference.

2. This device must accept any interference received, including interference that can cause an
undesired operation.

Changes or modifications to this device not approved by the Xerox Corporation can void the user’s
authority to operate this equipment.

GGeerrmmaannyy

GGeerrmmaannyy -- BBlluuee AAnnggeell

RAL, the German Institute for Quality Assurance and Labeling, has awarded this
device the Blue Angel Environmental Label. This label distinguishes it as a device that
satisfies Blue Angel criteria for environmental acceptability in terms of device design,
manufacture, and operation. For more information, go to: www.blauer-engel.de.

BBlleennddsscchhuuttzz
Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt
nicht im unmittelbaren Gesichtsfeld platziert werden.

IImmppoorrtteeuurr
Xerox GmbH

Hellersbergstraße 2-4

41460 Neuss

Deutschland

TTuurrkkeeyy RRooHHSS RReegguullaattiioonn
In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.”

“EEE yönetmeliğine uygundur.”
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Copy Regulations

UUnniitteedd SSttaatteess
Congress, by statute, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fine or imprisonment can be imposed on those guilty of making such
reproductions.

1. Obligations or Securities of the United States Government, such as:

• Certificates of Indebtedness.

• National Bank Currency.

• Coupons from Bonds.

• Federal Reserve Bank Notes.

• Silver Certificates.

• Gold Certificates.

• United States Bonds.

• Treasury Notes.

• Federal Reserve Notes.

• Fractional Notes.

• Certificates of Deposit.

• Paper Money.

• Bonds and Obligations of certain agencies of the government, such as FHA and so on.

• Bonds. United States Savings Bonds can be photographed only for publicity purposes for the
campaign of the sale of such bonds.

• Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a
canceled revenue stamp, this can be done provided the reproduction of the document is
performed for lawful purposes.

• Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps can be
photographed, provided the reproduction is in black and white and is less than 75% or more
than 150% of the linear dimensions of the original document.

• Postal Money Orders.

• Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States.

• Stamps and other representatives of value, of whatever denomination, which have been or
can be issued under any Act of Congress.

• Adjusted Compensation Certificates for Veterans of the World Wars.

2. Obligations or Securities of any Foreign Government, Bank, or Corporation.

3. Copyrighted materials, unless permission of the copyright owner has been obtained or the
reproduction falls within the fair use or library reproduction rights provisions of the copyright law.
Further information of these provisions can be obtained from the Copyright Office, Library of
Congress, Washington, D.C. 20559. Ask for Circular R21.
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4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates can be
photographed.

5. Passports. Foreign Passports can be photographed.

6. Immigration papers.

7. Draft Registration Cards.

8. Selective Service Induction papers that bear any of the following Registrant information:

• Earnings or Income.

• Court Record.

• Physical or mental condition.

• Dependency status.

• Previous military service.

• Exception: United States military discharge certificates can be photographed.

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of
the various Federal Departments, such as FBI, Treasury, and so on, unless a photograph is ordered
by the head of such department or bureau.

Reproducing the following items is prohibited in certain states:

• Automobile Licenses

• Driver Licenses

• Automobile Certificates of Title

The preceding list is not all-inclusive, and no liability is assumed for its completeness or accuracy. If
there is doubt, consult your attorney.

For more information about these provisions, contact the Copyright Office, Library of Congress,
Washington, D.C. 20559. Ask for Circular R21.

CCaannaaddaa
Parliament, by stature, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such
reproductions.

• Current bank notes or current paper money

• Obligations or securities of a government or bank

• Exchequer bill paper or revenue paper

• The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or
of a court of law

• Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely
cause same to purport to have been printed by the Queens Printer for Canada, or the equivalent
printer for a province)

• Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of
a province, the government of a state other than Canada or a department, board, Commission, or
agency established by the Government of Canada or of a province or of a government of a state
other than Canada
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• Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or
of a province or by the government of a state other than Canada

• Documents, registers, or records kept by public officials charged with the duty of making or issuing
certified copies thereof, where the copy falsely purports to be a certified copy thereof

• Copyrighted material or trademarks of any manner or kind without the consent of the copyright
or trademark owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is
assumed for its completeness or accuracy. In case of doubt, consult your solicitor.

OOtthheerr CCoouunnttrriieess
Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be
imposed on those found guilty of making such reproductions.

• Currency notes

• Bank notes and checks

• Bank and government bonds and securities

• Passports and identification cards

• Copyright material or trademarks without the consent of the owner

• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of
doubt, contact your legal counsel.
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Fax Regulations

UUnniitteedd SSttaatteess

FFaaxx SSeenndd HHeeaaddeerr RReeqquuiirreemmeennttss
The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer
or other electronic device, including a fax machine, to send any message unless such message clearly
contains in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business or other entity, or
other individual sending the message and the telephone number of the sending machine or such
business, other entity, or individual. The telephone number provided may not be a 900 number or any
other number for which charges exceed local or long-distance transmission charges.

For instructions on programming the Fax Send Header information, refer to the section of the System
Administrator Guide on Setting Transmission Defaults.

DDaattaa CCoouupplleerr IInnffoorrmmaattiioonn
This equipment complies with Part 68 of the FCC rules and the requirements adopted by the
Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label
that contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If
requested, this number must be provided to the Telephone Company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug are provided with this product. The product connects to a
compatible modular jack that is also compliant. Refer to installation instructions for details.

You can connect the printer safely to the following standard modular jack: USOC RJ-11C using the
compliant telephone line cord with modular plugs provided with the installation kit. Refer to the
installation instructions for details.

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be
connected to a telephone line. Excessive RENs on a telephone line can result in the devices not ringing
in response to an incoming call. In most but not all areas, the sum of RENs does not exceed five (5.0).
To be certain of the number of devices that can be connected to a line, as determined by the RENs,
contact the local Telephone Company. For products approved after July 23, 2001, the REN is part of
the product identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the
REN without a decimal point, for example, 03 is a REN of 0.3. For earlier products, the REN is shown
separately on the label.

To order the correct service from the local Telephone Company, you could also have to quote the
codes in the following list:

• Facility Interface Code (FIC) = 02LS2

• Service Order Code (SOC) = 9.0Y

Caution: Ask your local Telephone Company for the modular jack type installed on your line.
Connecting this printer to an unauthorized jack can damage the telephone company
equipment. You, not Xerox, assume all responsibility and liability for any damage caused by the
connection of this printer to an unauthorized jack.
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If this Xerox® equipment causes harm to the telephone network, the Telephone Company could
discontinue the service temporarily to the telephone line to which the printer is connected. If advance
notice is not practical, the Telephone Company notifies you of the disconnection as soon as possible.
If the Telephone Company interrupts your service, they can advise you of your right to file a
complaint with the FCC if you believe that it is necessary.

The Telephone Company can change its facilities, equipment, operations, or procedures which can
affect the operation of the equipment. If the Telephone Company changes something that affects
the operation of the equipment, they should notify you so that you can make the necessary
modifications to maintain uninterrupted service.

If you experience trouble with this Xerox® equipment, contact the appropriate service center for
repair or warranty information. Contact information is contained in the Device app on the printer and
in the Troubleshooting section of the User Guide. If the equipment is causing harm to the telephone
network, the Telephone Company can request that you disconnect the equipment until the problem is
resolved.

Only a Xerox Service Representative or an authorized Xerox Service provider is authorized to make
repairs to the printer. The printer repair applies at any time during or after the service warranty
period. If an unauthorized repair is performed, the remainder of the warranty period is null and void.

This equipment cannot be used on party lines. Connection to a party line service is subject to state
tariffs. Contact the state public utility commission, public service commission, or corporation
commission for information.

Your office could have specially wired alarm equipment connected to the telephone line. Make sure
that the installation of this Xerox® equipment does not disable your alarm equipment.

If you have questions about what can disable alarm equipment, consult your Telephone Company or
a qualified Xerox installer.

CCaannaaddaa
This product meets the applicable Innovation, Science, and Economic Development Canada technical
specifications.

A representative designated by the supplier coordinates repairs to the certified equipment. Repairs or
alterations made by the user to this device, or device malfunctions, can cause the
telecommunications company to request that you disconnect the equipment.

For user protection, make sure that the printer is grounded properly. The electrical ground connections
of the power utility, telephone lines, and internal metallic water pipe systems, if present, must be
connected together. This precaution can be vital in rural areas.

Caution: Do not attempt to make such connections yourself. Contact the appropriate electric
inspection authority, or electrician, to make the ground connection.

The Ringer Equivalence Number (REN) indicates the maximum number of devices allowed to be
connected to a telephone interface. The termination of an interface can consist of any combination
of devices, subject only to the requirement that the sum of the RENs of all the devices not exceed five.
For the Canadian REN value, refer to the label on the equipment.

CCaannaaddaa CCSS--0033 IIssssuuee 99
This product has been tested to and is compliant with CS–03 issue 9.
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EEuurrooppeeaann UUnniioonn

RRaaddiioo EEqquuiippmmeenntt aanndd TTeelleeccoommmmuunniiccaattiioonnss TTeerrmmiinnaall EEqquuiippmmeenntt
DDiirreeccttiivvee
This device has been designed to work with the national public switched telephone networks and
compatible PBX devices of the following countries:

Pan-European Analog PSTN and Compatible PBX Certifications

Austria Greece Netherlands

Belgium Hungary Norway

Bulgaria Iceland Poland

Cyprus Ireland Portugal

Czech Republic Italy Romania

Denmark Latvia Slovakia

Estonia Liechtenstein Slovenia

Finland Lithuania Spain

France Luxembourg Sweden

Germany Malta United Kingdom

If you have problems with your product, contact your local Xerox representative. This product can be
configured to be compatible with other country networks. Before reconnecting the device to a
network in another country, contact your Xerox representative for assistance.

Note:

• Although this product can use either loop disconnect (pulse) or DTMF tone signaling, Xerox
recommends that you use DTMF signaling. DTMF signaling provides reliable and faster call
setup.

• Modification of this product, or connection to external control software or control
apparatus not authorized by Xerox, invalidates its certification.
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NNeeww ZZeeaallaanndd
1. The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has

accepted that the item complies with minimum conditions for connection to its network. The
permit indicates no endorsement of the product by Telecom, does not provide any sort of
warranty, and does not imply that any Telepermitted product is compatible with all Telecom
network services. Above all, the permit provides no assurance that any item works correctly in all
respects with another item of Telepermitted equipment of a different make or model.

The equipment may not be capable of correct operation at the higher data speeds designated.
Data speeds of 33.6kbps and 56kbps connections are likely to be restricted to lower bit rates when
connected to some PSTN implementations. Telecom accepts no responsibility for difficulties that
arise in such circumstances.

2. Immediately disconnect this equipment if it becomes physically damaged, then arrange for its
disposal or repair.

3. This modem shall not be used in any manner which could constitute a nuisance to other Telecom
customers.

4. This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There
is no guarantee that Telecom lines shall continue to support pulse dialing.

5. Use of pulse dialing, when this equipment is connected to the same line as other equipment, can
give rise to the bell tinkle or noise and cause a false-answer condition. If you encounter such
problems, do not contact the Telecom Faults Service.

6. DTMF tones dialing is the preferred method because it is faster than pulse decadic dialing and is
readily available on almost all New Zealand telephone exchanges.

WARNING: No 111 or other calls can be made from this device during a mains power
failure.

7. This equipment may not provide for the effective hand-over of a call to another device connected
to the same line.

8. Some parameters required for compliance with Telecom Telepermit requirements depend on the
equipment or computer associated with this device. The associated equipment shall be set to
operate within the following limits for compliance with Telecom Specifications:

For repeat calls to the same number:

• There shall be no more than 10 call attempts to the same number within any 30minute period
for any single manual call initiation.

• The equipment can go on-hook for not less than 30 seconds between the end of one call
attempt and the beginning of the next call attempt.

For automatic calls to different numbers:

The equipment shall be set to ensure that automatic calls to different numbers are spaced such
that there is no less than 5 seconds between the end of one call attempt and the beginning of the
next call attempt.

9. For correct operation, the total RNs of all devices connected to a single line at any time should not
exceed five.

SSoouutthh AAffrriiccaa
This modem must be used in conjunction with an approved surge-protection device.
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Material Safety Data Sheets
For Material Safety Data information regarding your printer, go to:

• North America: www.xerox.com/msdsna

• European Union: www.xerox.com/msds

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts.
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All Countries
If you are managing the disposal of your Xerox product, note that the printer may contain lead,
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental
considerations. The presence of these materials is fully consistent with global regulations applicable
at the time that the product was placed on the market. For recycling and disposal information,
contact your local authorities. Perchlorate Material: This product may contain one or more
Perchlorate-containing devices, such as batteries. Special handling may apply. For more information,
go to www.dtsc.ca.gov/hazardouswaste/perchlorate.
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North America
Xerox operates an equipment take-back and reuse or recycle program. Contact your Xerox
representative at 1-800-ASK-XEROX to determine if your Xerox product is part of the program. For
more information about Xerox environmental programs, visit www.xerox.com/environment, or for
recycling and disposal information, contact your local authorities.
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European Union
Some equipment is used in both a domestic or household application and in a professional or
business application.

DDoommeessttiicc//HHoouusseehhoolldd EEnnvviirroonnmmeenntt
Application of this symbol on your equipment is confirmation that you should not
dispose of the equipment in the normal household waste stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to
disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to
designated collection facilities free of charge. Please contact your local disposal authority for
information.

In some member states, when you purchase new equipment, your local retailer may be required to
take back your old equipment free of charge. Please ask your retailer for information.

PPrrooffeessssiioonnaall//BBuussiinneessss EEnnvviirroonnmmeenntt
Application of this symbol on your equipment is confirmation that you must dispose of
this equipment in compliance with agreed national procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to
disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back
information.
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CCoolllleeccttiioonn aanndd DDiissppoossaall ooff EEqquuiippmmeenntt aanndd BBaatttteerriieess

These symbols on the products and/or accompanying documents mean that
used electrical and electronic products and batteries should not be mixed with
general household waste.

For proper treatment, recovery, and recycling of old products and used batteries,
please take them to applicable collection points, in accordance with your national
legislation and the Directive 2002/96/EC and 2006/66/EC.

By disposing of these products and batteries correctly, you will help to save valuable
resources and prevent any potential negative effects on human health and the
environment which could otherwise arise from inappropriate waste handling.

For more information about collection and recycling of old products and batteries,
please contact your local municipality, your waste disposal service or the point of sale
where you purchased the items.

Penalties may be applicable for incorrect disposal of this waste, in accordance with
national legislation.

BBuussiinneessss UUsseerrss iinn tthhee EEuurrooppeeaann UUnniioonn
If you wish to discard electrical and electronic equipment, contact your dealer or supplier for further
information.

DDiissppoossaall OOuuttssiiddee ooff tthhee EEuurrooppeeaann UUnniioonn
These symbols are only valid in the European Union. If you wish to discard these items, contact your
local authorities or dealer and ask for the correct method of disposal.

BBaatttteerryy SSyymmbbooll

This wheeled bin symbol may be used in combination with a chemical
symbol. Use of this symbol establishes compliance with the requirements set
out by the Directive.

BBaatttteerryy RReemmoovvaall
Batteries should only be replaced by a manufacturer-approved service facility.

Xerox® AltaLink® C81XX Series Color Multifunction Printer
User Guide

389

Recycling and Disposal



Other Countries
Contact your local waste management authority to request disposal guidance.
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Product Symbols
Symbol Description

Warning:

Indicates a hazard that can result in serious injury or death if not avoided.

Hot Surface:

Hot surface on or in the printer. To avoid personal injury, use caution.

Warning:

Moving parts. To avoid personal injury, use caution.

Caution:

Indicates a mandatory action to take to avoid damage to the property.

Do not touch the part or area of the printer.

Do not touch this part of the printer.

Do not touch the part or area of the printer.

Do not expose the drum cartridges to direct sunlight.

Do not burn the item.

Do not burn the toner cartridges.

Do not burn the drum cartridges.
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Symbol Description

Do not burn the toner waste cartridge.

Pinch Hazard:

To avoid personal injury, use caution in this area.

Pinch Hazard:

To avoid personal injury, use caution in this area.

Do not remove the paper forcefully.

Hot Surface:

Before handling, wait for the time indicated.

On

Off

Standby

Do not use paper attached with staples or any form of binding clip.

Do not use folded, creased, curled, or wrinkled paper.

Do not load or use inkjet paper.

Do not reload paper that is used or printed previously.
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Symbol Description

Do not use postcards.

Do not use envelopes.

Do not copy money.

Add paper or media.

Paper jam

Lock

Unlock

Paper clip

Cooling

Elapsed time

Supply paper

1-Sided original document

Hole-punched paper
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Symbol Description

Transparency

Load letterhead face up.

Load letterhead face down.

Load labels face down.

USB:

Universal Serial Bus

LAN:

Local Area Network

Telephone Line

Weight

Services Home button

This item can be recycled.
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Feature Description Copy Email Fax
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Fax
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net Fax

Work-
flow
Scan-
ning/
Scan To

ID Card
Copy

Output Color
Use Output Color to control the
color rendering of the output
image or print.

• • • • •

2-Sided Copying
and 2-Sided
Scanning

You can use the 2-sided options
to set the device to scan one or
both sides of an original
document. For Copy jobs, you
can specify 1-sided or 2-sided
output.

• • • • • •

Paper Supply
Use Paper Supply to specify the
size, type and color of the
paper required, or the paper
tray to use. If Auto is selected,
the printer chooses the paper
tray based on the original
document size and the selected
settings.

• •

Collation
You can collate multiple-page
copy jobs automatically. For
example, when you are making
three 1-sided copies of a
six-page document, the copies
are printed in this order:

1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6; 1,
2, 3, 4, 5, 6.

•

Finishing
If finishing options are
available, use this option to

•
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choose the finishing options
required for your printed
output.

Reduce / Enlarge
You can reduce the image to as
little as 25% of the original
size or enlarge it to as much as
400%. When you resize an
image, to maintain the original
proportions, select
Proportional %. To adjust the
width and length of the image
by different percentages, select
Independent %.

• •

Original Type
The printer optimizes the
image quality of the copies
based on the type of images in
the original document and how
the original document was
created.

• • • • • • •

Contrast
You can use the Contrast
feature to adjust the variation
between light and dark areas of
the image.

• • • • • •

Lighten / Darken
Use the Lighten/Darken slider
to make the output image or
print lighter or darker.

• • • • • • •
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Sharpness
Use this option to sharpen the
output image or print. For best
results, sharpen text images
and soften photos.

• • • • •

Saturation
Saturation allows you to adjust
the color strength and the
amount of gray in the color.

Note: This feature is
not available when
Output Color is set to
Black and White or
Grayscale.

• • • •

Color Presets
You can adjust the color of the
copy using preset color effects.
For example, you can adjust
colors to be brighter or cooler.

•

Color Balance
If you have a color original
image, you can adjust the
balance of the printing colors
between cyan, magenta,
yellow, and black before you
print your copy.

•

Original
Orientation You can use the Original

Orientation option to specify
the layout of the original
images that you scan. The
printer uses the information to

• • • • •
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determine whether images
require rotation to produce the
required output.

Image Shift
Image Shift allows you to
modify the location of the
image on the page. You can
shift the printed image along
the X and Y axes of each sheet
of paper.

•

Auto Background
Suppression Use the Auto Background

Suppression setting to reduce
the sensitivity of the printer to
variations in light background
colors.

• • • • • • •

Edge Erase
You can use the Edge Erase
feature to erase content from
the edges of your images. You
can specify the amount to
erase on the right, left, top, and
bottom edges.

• • •

Original Size
To ensure that you scan the
correct area of the documents,
specify the original document
size.

• • • • • •

Book Copying
You can use the Book Copying
feature to copy books,
magazines, or other bound
documents.

•
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Mirror Image
Use Mirror Image to reverse
the image and text on the
page.

•

Negative Image
Negative Image reverses the
light and dark areas in your
document, and prints the
image as if it is a photo
negative. Printing a negative
image is useful for documents
that have a substantial amount
of dark background or light text
and images.

•

Special Pages
Special Pages is used to add
covers and inserts to your job.
You can specify exception
pages to print on different
paper than the main body of
the job. Additionally, you can
program chapter start pages.

•

Annotations
You can add annotations, such
as page numbers and the date,
to your copies.

•

Booklet Creation
The Booklet Creation feature
prints two pages on each side
of the paper. The pages are
reordered so that they are in
numerical order when folded.

• Apps
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Page Layout
You can print the selected
number of pages on one side of
a sheet of paper. Selecting
multiple pages per sheet saves
paper and provides a way to
review the layout of a
document.

•

Sample Job
Sample Job allows you to print
a test copy of a job to inspect
before you print multiple
copies. This feature is useful for
complex or high-volume jobs.
After you print and inspect the
test copy, you can choose to
print or cancel the remaining
copies.

•

Transparency
Separators Use the Transparency

Separators option to add blank
sheets of paper between each
printed transparency. Ensure
that the size and orientation of
the separators is the same as
the transparencies.

•

Build Job
Use the Build Job option for
jobs that include a variety of
original documents that require
different settings, or to scan
multiple-page jobs from the
document glass. The job is
scanned in segments. After all

• • • • • •
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the segments are scanned, the
job is processed and
completed.

Save Current
Settings To use a particular combination

of copy settings for future copy
jobs, you can save the settings
with a name and retrieve the
settings for later use.

•

Retrieve Current
Settings You can retrieve and use any

previously saved copy settings
for current jobs.

•

Quantity
Use this option to enter the
number of required ID card
copies.

•

Preview
Use this option to view a
sample image. You can use
Preview to continue to scan
and add pages to a job.

• •

Resolution
Resolution determines how fine
or grainy graphic images
appear. Image resolution is
measured in dots per inch (dpi).

• • • • •

Remove Blank
Pages Remove Blank Pages configures

the printer to ignore blank
pages.

• •
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From
Use the From option to specify
the originator of the email.

Note: The system
administrator can preset
this option to populate
automatically with your
user account details.

• •

Reply To
Use the Reply To option to
include an email address that
you want the recipient to reply
to. This option is useful if you
want the recipient to reply to
your email address, rather than
to the device.

Note: The system
administrator can preset
this option.

• •

Message
Use the Message option to
enter information to
accompany the email.

• •

Quality/File Size
The Quality/File Size option lets
you choose from three settings
that balance the quality of the
image and the size of the file.
Higher-quality images result in
larger file sizes, which are not
ideal for sharing and
transmitting over the network.

• • •
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File Format
Use the File Format option to
specify the format of the saved
image or to define a searchable
image. You can add a password
to protect the image or choose
to combine multiple images
into a single file.

• • •

If File Already
Exists Use this option to define what

action the device takes when
the file name is used already.

•

File and
Attachment Use this option to specify a

name for the file that contains
the scanned images.

• • •

Acknowledgement
Report You can request to print a

report to confirm that each
recipient has received the
scanned file. The report
contains delivery status
information.

Note: The report
depends on recipient
response time.

•

Update Workflows
Use Update Workflows to
refresh the list of workflows
that appear at the control
panel.

•
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Add File
Destinations Use this option to choose more

destinations to file the scanned
images.

•

Book Faxing
You can use the Book Faxing
feature to scan images from
books, magazines, or other
bound documents for faxing.

•

Reduce/Split
Use the Reduce/Split option to
specify how your faxed
document is printed on the
receiving fax machine. If the
image is too large to fit on the
paper size, you can reduce the
image to fit or split across
multiple pages.

•

Confirmation
Report You can request a report to

confirm if your fax was
received. To receive a
Confirmation Report only if an
error occurred during
transmission, choose Print on
Error Only.

•

Starting Rate
Select the highest starting rate
for transmitting the fax, unless
the destination for the fax you
are sending has special
requirements. Forced (4800
bps) is the recommended

•
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setting for lines that can have
transmission interference.

Cover Sheet
You can use the Cover Sheet
option to add an introduction
page to the beginning of your
fax. You can add a short
comment to the cover sheet,
and To and From details.

•

Send Header Text
It is unlawful to send a
message from a fax machine
without the proper
transmission header text.
Ensure that the name and
telephone number of the
sender, and the date and time
of the transmission are
included on all faxes.

•

Delay Send
You can set a time in the future
for the printer to send your fax
job. You can delay the sending
of your fax job for up to 24
hours.

• •
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Polling
Fax Polling allows you to store
a fax document on the printer
and make the document
available for other fax
machines to poll. You can
retrieve faxes stored on other
fax machines. To use this
feature, it is necessary that
both the polling printer and the
remote printer have the Polling
feature.

•

Mailboxes
Use the Fax Mailboxes option
to store faxes that were
retrieved from a remote fax
machine, or to store faxes for
retrieval by a remote fax
machine. The mailbox number
is required to access a mailbox.
You can set a passcode to
secure confidential documents.

•
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